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Installing Norton Ghost™

This chapter includes the following topics:

■ Preparing for installation

■ Installing Norton Ghost 12.0

■ Setting up your first backup

■ About ensuring the recovery of your computer

■ Creating a custom Symantec Recovery Disk CD

■ Starting Norton Ghost 12.0

■ Configuring Norton Ghost default options

■ Updating Norton Ghost

■ Uninstalling the product

Preparing for installation
Before you install Norton Ghost, make sure that your computer meets the system

requirements.

System requirements

Table 1-1 lists the system requirements for Norton Ghost.
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Table 1-1 Minimum system requirements

Minimum RequirementsComponent

Windows 32-bit or 64-bit operating systems:

■ Windows Vista Home Basic

■ Windows Vista Home Premium

■ Windows Vista Ultimate

■ Windows Vista Business

■ Windows XP Professional/Home (SP2 or later)

■ Windows XP Media Center

Operating system

Memory requirements per key components:

■ Norton Ghost Agent: 256 MB

■ Norton Ghost user interface and Recovery Point Browser: 256 MB

■ Symantec Recovery Disk: 512 MB minimum

Note: If you are installing a multilingual version of the product, you must have a minimum

of 768 MB of RAM to run the Symantec Recovery Disk.

■ Norton Ghost LightsOut Restore feature: 1 GB

RAM

■ Norton Ghost Service: 65.2 MB

■ Recovery Point Browser: 30.6 MB

■ Microsoft .NET Framework 2.0: 280 MB of hard disk space required for 32-bit computers,

and 610 MB for 64-bit computers

■ Recovery points: Sufficient hard disk space on a local hard disk or network server for storing

recovery points

■ Norton Ghost LightsOut Restore feature: 2 GB

Available hard

disk space

The drive can be any speed, but must be bootable from the BIOS.

Norton Ghost uses Gear Software technology. To verify that your CD writer or DVD writer is

compatible, visit http://www.gearsoftware.com/support/recorders/index.cfm. You can look up

information about your writer if you know the name of the manufacturer and model number

of your writer.

CD-ROM or

DVD-ROM drive

The .NET Framework 2.0 is required to run Norton Ghost.

If the .NET Framework is not already installed, then Norton Ghost installs it for you.

Software

■ VMware GSX Server 3.1 and 3.2

■ VMware Server 1.0 (replacement/rename for GSX Server)

■ VMware ESX Server 2.5 and 3.0

■ VMware Infrastructure 3 (replacement/rename for ESX Server)

■ Microsoft Virtual Server 2005 R2

Virtual platforms

(for converted

recovery points)
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Supported file systems and removable media

Norton Ghost supports the following file systems and removable media:

Norton Ghost supports FAT16, FAT16X, FAT32, FAT32X, NTFS, dynamic disks, Linux Ext2,

Linux Ext3, and Linux swap partitions.

Note: You must decrypt encrypted NTFS drives before you attempt to restore them. You cannot

view the files that are in a recovery point for an encrypted NTFS drive.

Supported file

systems

You can save recovery points locally (that is, on the same computer where Norton Ghost is

installed) or to most CD-R, CD-RW, DVD-R(W), and DVD+RW recorders. You can find an updated

list of supported drives on the Symantec Web site.

Norton Ghost also lets you save recovery points to most USB devices, 1394 FireWire devices,

REV, Jaz, Zip drives, and magneto-optical devices.

Removable media

Unavailable features

Norton Ghost 12.0 is packaged to meet various markets. Some features might not

be available, depending on the product you have purchased. However, all features

are documented. You should be aware of which features are included with the

version of the product you have purchased. If a feature is not accessible in the

product user interface, it is likely not included with your version of the product.

Refer to the Symantec Web site for information about features included with your

version of Norton Ghost 12.0.

When you delay licensing

If you choose to delay installation of the product license (for a maximum of 30

days from the date of installation), the following features are unavailable until

you install a valid license:

■ Copy Drive

■ LightsOut Restore

■ Convert to Virtual Disk

All other features are enabled during the 30 day grace period.

If you are using an Evaluation copy of the product, it also expires after 30 days.

However, all features are enabled until the end of the evaluation period, at which

time you must purchase the product or uninstall it. You can purchase a license at

any time (even after the evaluation period expires) without reinstalling the

software.
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Note: If this product came pre-installed from a computer manufacturer, your trial

period could be as long as 90 days. The product licensing or activation page during

install will indicate the duration of your trial period.

See “Activating Norton Ghost later” on page 17.

Installing Norton Ghost 12.0
Before you begin, you should review the requirements and scenarios for installing

Norton Ghost.

See “System requirements” on page 11.

Note: During the installation process, you might be required to restart the

computer. To ensure proper functionality after the computer restarts, log in again

with the same user credentials.

The installation program scans your hardware for the required drivers. If the

program does not find the required drivers on your system, you receive a driver

validation message. If you receive this message, you should test the Symantec

Recovery Disk to verify whether the drivers are required or if the devices on your

system have compatible drivers that are available on the Symantec Recovery Disk.

The driver validation process should not interfere with your ability to install the

product.

For more information about Driver Validation, see About ensuring the recovery

of your computer.

Warning: The Symantec Recovery Disk (SRD) provides the tools that you need to

recover your computer. It is included with your product either on a separate CD,

or on your product CD, depending on the version of the product that you purchased.

You should store the CD in a safe place.

To install Norton Ghost 12.0

1 Insert the Norton Ghost 12.0 product CD into the media drive of the computer.

The installation program should start automatically.

2 If the installation program does not start, on the Windows taskbar, click Start

>Run, type the following command, then click OK.

<drive>:\autorun.exe

where <drive> is the drive letter of your media drive.

Installing Norton Ghost™
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For Windows Vista, if the Run option is not visible, do the following:

■ Right-click the Start button, and click Properties.

■ On the Start Menu tab, click Customize.

■ Scroll down and check Run command.

■ Click OK.

3 In the CD browser panel, click Install NortonGhost.

4 In the Welcome panel, click Next.

5 Read the license agreement, and then click I accept the terms in the license

agreement.

6 Click Next.

7 If you want to change the default location for the Norton Ghost program files,

click Change, locate the folder in which you want to install Norton Ghost,

and then click OK.

8 Click Next.

9 If you want to customize your settings, click Custom, and then click Next to

change your settings.

By default, all options are installed.

10 Click Next.

11 Click Install.

A progress screen shows the status of the installation.

12 If a driver that is used on your computer is not available on the Symantec

Recovery Disk, you receive a notification message that includes the name of

the driver. Write down the name of the driver file, and then clickOK to dismiss

the message.

Drivers are critical in the event that you need to use the Symantec Recovery

Disk to recover your system drive (the drive where your operating system is

installed).

See “About ensuring the recovery of your computer” on page 17.

13 Click Finish to complete the installation.

14 Remove the product CD from the media drive, and then click Yes to exit the

installation wizard and restart the computer.

You must restart your computer before you run Norton Ghost.
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Completing the installation

After you install the product, you are prompted to license or activate your product.

You can then run LiveUpdate to check for product updates, and then configure

your first backup.

Note: If this product came pre-installed from a computer manufacturer, your trial

period could be as long as 90 days. Refer to the Activate later label.

To complete the installation

1 In the Welcome panel, click Next.

If the product was installed by your computer manufacturer, the Welcome

page might appear the first time that you run Norton Ghost.

2 Do one of the following:

■ Click I've already purchased the product and have a product key.

Note: You can find the product key on the back of your product CD jacket.

Do not lose the product key. You must use it when you install Norton

Ghost.

■ Click Activate later to delay the activation of your license for 30 days.

After 30 days, the product will no longer work.

■ If this product is a trial version of Norton Ghost and you want to purchase

a license or product key, click SymantecGlobal Store to connect to the

Symantec Web site.

3 Click Next.

4 Click Run LiveUpdate to check for any product updates since the product

shipped.

5 Click LaunchEasy Setup to open the Easy Setup box when you complete the

install process.
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6 ClickEnableGoogleDesktopFileandFolderRecovery if you want use Google

Desktop to search your recovery points for the files and folders that you want

to recover.

If you select this option, Norton Ghost automatically catalogs each file as it

creates a recovery point. Google Desktop can then use this catalog to search

for files by name. It does not index the content of the files.

Note: This option is available only if Google Desktop already is installed on

your computer. If you plan to install Google Desktop, you can enable search

engine support later.

7 Click Finish.

Activating Norton Ghost later

If you do not activate or license Norton Ghost within 30 days of installing it, the

software stops working. You can activate it after the 30 days have expired.

To activate Norton Ghost at any time after installation

1 On the Help menu, click Unlock Trial Product.

2 Refer to step 2 in the To complete the installation procedure.

Setting up your first backup
Unless you unchecked the Run Easy Setup check box during installation, the Easy

Setup box appears. If you don't run Easy Setup at install time, it appears the first

time you open the Run or Manage Backups window.

When the Easy Setup box opens, you can either accept the default drive and file

and folder backup settings, or you can click on any of the settings to modify them.

If you want the new backup to run immediately, be sure to select Runbackup

now, and then click OK.

About ensuring the recovery of your computer
If Windows fails to start or it does not run normally, you can recover your computer

by using the Symantec Recovery Disk. The drivers that are included on the recovery

disk must match the drivers required to run your computer's network cards and

hard disks.
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To help ensure that you have the drivers that you need to recover your computer,

the installation process runs a driver validation test. The driver validation tool

compares hardware drivers that are contained on the recovery disk with the

drivers that are required to run your computer's network cards and hard disks.

The installation process automatically runs the driver validation test, unless you

cancel it. But you can run a validation test at anytime by running the Symantec

Recovery Disk Wizard.

You should run the driver validation test any time you make changes to the NIC

cards or storage controllers on a computer.

See “If driver validation fails” on page 19.

Note: Wireless network adapter drivers are not supported by the driver validation

tool or by Symantec Recovery Disk.

Testing Symantec Recovery Disk

You should test Symantec Recovery Disk to ensure that the recovery environment

runs properly on your computer.

Note: Depending on which version of the product you have purchased, the SRD

is either included on your product CD, or as a separate CD. You should place the

CD containing the SRD in a safe place. Should you lose the CD, you can create a

new one if you have have a CD burner.

You can use the testing to identify and solve the following types of problems:

■ You cannot boot into the recovery environment.

See “Starting a computer from the CD drive ” on page 171.

■ You do not have the necessary storage drivers to access recovery points on

the computer.

See “You cannot access the local drive where your recovery points are saved

” on page 172.

■ You need information about your system to help you run the recovery

environment.

See “Locating required system information ” on page 161.

See “Troubleshooting the recovery environment ” on page 166.
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To test Symantec Recovery Disk

1 Run the driver validation tool to test whether Symantec Recovery Disk works

with the network cards and storage devices on the computer.

2 Boot your computer using the Symantec Recovery Disk.

See “Starting a computer by using the recovery environment ” on page 132.

3 When you have booted into the recovery environment, do one of the following:

■ If you want to store recovery points on a network, run a mock restore of

a recovery point that is stored on a network to test the network connection.

■ If you want to store recovery points on the computer, run a mock restore

of a recovery point that is stored locally to test the local hard-drive

connection.

If driver validation fails

The driver validation test verifies whether the drivers for all storage devices and

network cards in use by the computer are available in the recovery environment.

If the drivers are available on the recovery disk, you receive a validation message.

If any drivers are missing from the recovery disk, the Driver Validation Results

dialog appears.

Without access to the correct drivers, a device cannot be used while running the

SRD. Therefore, if the recovery points required for recovering your computer are

stored on a network or a local hard drive, you might not have access to them.

You can find the drivers and copy them to a CD or a floppy disk, or you can create

a custom Symantec Recovery Disk CD.

See “Creating a custom Symantec Recovery Disk CD” on page 19.

Creating a custom Symantec Recovery Disk CD
If driver validation fails, or if your Symantec Recovery Disk CD does not work,

you can create a new one that contains your computer's current network and

storage device drivers.

Note: You must have a writeable DVD/CD-RW drive to create a custom Symantec

Recovery Disk.
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To create a custom Symantec Recovery Disk CD

1 Start Norton Ghost.

2 Attach and turn on all storage devices and network devices that you want to

make available.

3 Insert the Symantec Recovery Disk CD into your CD-ROM drive.

4 From the main Norton Ghost window, click File > CreateRecoveryDisk, and

then click Next.

5 If prompted, click Browse, select the drive that contains the Symantec

Recovery Disk CD, click OK, and then click Next.

6 Do one of the following:

■ Click Automatic (Recommended), and then click Next.

■ Click Custom, and then click Next.

Select this option only if you know which drivers to select.

7 Follow the on-screen instructions to complete the wizard.

Starting Norton Ghost 12.0
Norton Ghost is installed in the Windows Program Files folder by default. During

installation, a program icon is installed in the Windows system tray from which

you can open Norton Ghost. You can also open Norton Ghost from the Windows

Start menu.

To use the full version of Norton Ghost, you must activate the software.

See “Activating Norton Ghost later” on page 17.

To start Norton Ghost 12.0

◆ Do one of the following:

■ On the classic Windows taskbar, click Start > Programs > Symantec >

NortonGhost.

■ On the Windows XP or Windows Vista taskbar, click Start >All Programs

> Symantec >NortonGhost.

■ In the Windows system tray, double-click the Norton Ghost tray icon.

■ In the Windows system tray, right-click the Norton Ghost tray icon, and

then click OpenNortonGhost 12.0.

■ In the Windows system tray, double-click the Norton Ghost tray icon.

Installing Norton Ghost™
Starting Norton Ghost 12.0
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Configuring Norton Ghost default options
The Options dialog box includes five tabs that let you configure the following

default settings:

DescriptionTab

Specify a default location where a backup will create and store

recovery points and file and folder backup data. If the location

you choose is on a network, you can enter your user

authentication information.

See “Selecting a default backup destination ” on page 23.

General

Lets you specify a default speed for backup or recovery

processes. Moving the slider closer to Fast increases the speed

at which the program backs up or recovers your computer.

However, choosing a slower speed could improve the

performance of your computer, especially if you are working

on your computer during a backup or recovery.

You can also configure network throttling to limit the effects

of backups on network performance.

Note: During a backup or recovery, you have the option to

override this default setting to fit your needs at the time.

See “Adjusting the effects of a backup on computer

performance” on page 23.

See “Enabling network throttling ” on page 24.

Performance

You can turn the system tray icon on or off and specify

whether to show only error messages when they occur, or to

show both error messages and other information, such as the

completion of a backup.

See “Adjusting default tray icon settings ” on page 25.

Tray Icon

Lets you manage file types and file type categories, which are

used as a method for selecting the types of files you want

included in a file and folder backup.

See “Managing file types ” on page 25.

File Types
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DescriptionTab

If Google Desktop is installed on your computer when you

install Norton Ghost, you have the option of enabling Google

Desktop file and folder recovery. When you enable this feature,

you can search for files (by file name) inside a recovery point

that was created with search engine support enabled.

If Google Desktop is not installed on your computer when you

install Norton Ghost, you have the option of clicking a link to

the Web site where you can download and install Google

Desktop for free.

See “About using a search engine to search recovery points”

on page 155.

Google Desktop

Lets you specify the types of product messages to log (errors,

warnings, and information), where to store the log file, and

set a maximum file size for the log file.

See “Logging Norton Ghost messages” on page 27.

Log File

Lets you specify the types of product messages to log (errors,

warnings, and information) in the Windows event log.

See “Logging Norton Ghost messages” on page 27.

Event Log

If you want a history of actions taken by Norton Ghost, or of

error messages and warnings, you can choose to save them

in a log file on your computer, or to have them emailed to an

address you specify.

See “Enabling email notifications for product (event) messages

” on page 28.

SMTP E-mail

If you have a Network Management System (NMS) application,

you can enable SNMP Traps support to send notifications to

you NMS application.

See “Configuring Norton Ghost to send SNMP traps” on page 72.

SNMP Trap

To configure default options

1 Start Norton Ghost and click Tasks >Options.

2 Select an option you want to modify, make any necessary changes, and then

click OK.
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Selecting a default backup destination

You can specify the default destination for storing recovery points and file and

folder backup data created when you run a backup. This default location is used

if you do not specify a different location when you define a new backup.

To set a default backup destination

1 On the menu bar, click Tasks >Options.

2 Click General.

3 Check Append computer name to backup data files.

This is especially useful if you back up more than one computer to the same

drive. For example, you might back up a laptop and a desktop computer to

the same USB or network drive. By appending the computer name, you can

more easily identify where the backup data is for each computer.

4 Enter a path to a folder where you want to store recovery points and file and

folder backup data, or click Browse to look for a location.

Note: You cannot use an encrypted folder as your backup destination. If you

want to encrypt your backup data to prevent another user from accessing it,

refer to the Advanced options when you define or edit a backup.

5 If you entered the path to a location on a network, enter the user name and

password required to authenticate to the network.

6 Click OK.

Adjusting the effects of a backup on computer performance

If you are working on your computer when a backup is running—especially one

that is creating an independent recovery point—your computer might slow down.

This is because Norton Ghost is using your computer's hard disk and memory

resources to perform the backup.

However, you can actually modify the speed of the backup as a way of minimizing

the impact of Norton Ghost on your computer while you work.

To adjust the default effect of a backup on my computer's performance

1 On the main menu bar, click Tasks >Options.

2 Click Performance.

3 If you want to improve your computer's speed performance, move the slider

bar closer to Slow.
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4 If you want the backup to complete more quickly, move the slider bar closer

to Fast.

5 Click OK.

Note:During a backup or recovery, you'll have the option of overriding this default

setting to fit your needs at that moment.

See “Adjusting the speed of a backup ” on page 69.

Enabling network throttling

Similar to computer performance adjustments, you can also limit the impact of

a backup on network performance.

However, because network performance is affected by many variables, you should

consider the following issues before enabling this feature:

■ Network cards: Is your network wired or wireless? What are the speeds of your

network cards?

■ Network backbone: What is the size of your network pipeline? Does it support

10 MB transfer rates, or 1 GB transfer rates?

■ Network server: How robust is your server hardware? How fast is its' processor?

How much RAM does it have? Is it fast or slow?

■ Backing up: How many computers are scheduled to back up at the same time?

■ Network traffic: Are backups scheduled to run when network traffic is heavy

or light?

Consider using this feature only when you know what your network can handle.

If you schedule your backups at staggered intervals, and if you schedule them

when network traffic is low, you will likley not need to use this feature.

Gather the required information about your network's performance and then

schedule backups accordingly. Then, if necessary, enable this feature and set the

Maximum network throughput to a setting that matches the circumstances.

To enable network throttling

1 On the main menu bar, click Tasks >Options.

2 Click Performance.

3 Check Enable network throttling.
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4 In the Maximum network throttling field, enter the maximum amount (in

KB) of network throughput that Norton Ghost can send per second.

5 Click OK.

Adjusting default tray icon settings

You can turn the system tray icon on or off and specify whether to show only

error messages when they occur, or to show both error messages and other

information, such as the completion of a backup.

To adjust default tray icon settings

1 On the main menu bar, click Tasks >Options.

2 Click Tray Icon and select one of the following:

Displays the Norton Ghost icon in the system

tray.

You must select this option to enable or

disable any of the remaining options.

Show system tray icon

Notifies you when a backup was scheduled

but did not run.

This can happen when your computer was

turned off at the time a backup was

scheduled to run.

Show missed backups

Offers helpful prompts in the form of

questions that can help you keep your data

backed up.

Show system tray questions

Displays messages about the status of

backup operations, such as notifying that a

backup has started, or that your backup

destination is getting full.

Show status messages

Displays error messages when errors occur

so that you can resolve any issues that might

hinder data protection.

Show error messages

3 Click OK.

Managing file types

When you define a file and folder backup, file types are a quick way to include

files you use the most. For example, if you keep music files on your computer, you
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can configure a file and folder backup to include all music files (for example, .mp3,

.wav).

The most common file types and extensions are already defined for you. But you

can define additional file type categories as needed, and then edit them at any

time. For example, if you install a new program that requires the use of two new

file extensions (.pft and .ptp, for example), you can define a new file type and

define the two file extensions for that category. Then when you define a file and

folder backup, you can select the new category. When the backup is run, all files

ending with .pft and .ptp are backed up.

To create a new file type and extensions

1 On the main menu bar, click Tasks >Options.

2 Click File Types.

3 Click the Add a file type (+) button to add a file type category.

4 Type a descriptive name of the new file type category, and then press Enter.

5 Select *.NewExtension in the Extensions for column and click the Edit an

extension (checkmark icon below the Extensions for column) button.

6 Type an asterisk (*) and a period, followed by the extension of the file type

you want to define, and then press Enter.

7 Click OK.

To edit a file type and extensions

1 On the main menu bar, click Tasks >Options.

2 Click File Types.

3 Select a file type from the File types list, and then do one of the following:

■ Click theEditafiletype (checkmark icon below the Extensions for column)

button to edit the name of the selected file type.

■ Select an extension in the Extensions for column and click the Edit an

extension (checkmark icon below the Extensions for column) button to

edit the name of the extension.

■ Click either the Restore default file types list or the Restore default

extension list button to restore all default file types or extensions.

Caution: Any file types and extensions you have set up are removed. Once

removed, you will have to add them again manually.

4 Click OK.
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To delete a file type (and all of its extensions)

1 On the main menu bar, click Tasks >Options.

2 Select a file type in the File types column.

You cannot delete a default file type. You can delete all but one extension of

a default file type, and you can add additional extensions to a default file type.

3 Click the Remove a file type (-) button , and then click OK.

Use this same procedure to remove file extensions from the Extensions list.

Logging Norton Ghost messages

You can specify which product messages (errors, warnings, and information) are

logged as they occur, and where the log file is stored. Product messages can provide

useful information about the status of backups or related events, and can also

provide helpful information when you are troubleshooting.

Two logging methods are available: Norton Ghost logging, and the Windows

application log.

From the Options page, you can configure both methods.

To configure a Norton Ghost log file

1 On the main menu bar, click Tasks >Options.

2 Under Notifications, click Log File.

3 Click the Select the priority and type ofmessages drop-down list and select

the priority level at which a message should be logged.

Send all messages, regardless of priority

levels.

All messages

Send only medium and high priority

messages.

Medium and high priority messages

Send only high priority messages.High priority messages only

Do not send any messages, regardless of

priority levels.

No messages

4 Select one or more of the following options:

■ Errors

■ Warnings

■ Information
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5 In the Log file location field, enter a path to where the log file should be

created and stored.

If you don't know the path, click Browse and select a location.

6 In the Maximum file size field, specify a maximum size (in kilobytes) that the

log file is allowed to grow.

The file is kept within the limit you set by replacing the oldest logged items

in the file with new items as they occur.

7 Click OK.

To configure which product events are written to a Windows event log

1 On the main menu bar, click Tasks >Options.

2 Under Notifications, click Event Log.

3 Click the Select the priority and type ofmessages drop-down list and select

the priority level at which a message should be logged.

Send all messages, regardless of priority

levels.

All messages

Send only medium and high priority

messages.

Medium and high priority messages

Send only high priority messages.High priority messages only

Do not send any messages, regardless of

priority levels.

No messages

4 Select one or more of the following options:

■ Errors

■ Warnings

■ Information

5 Click OK.

Enabling email notifications for product (event) messages

Email notifications can be sent to a specified email address if there are any errors

or warnings that occurred when a backup is run.

Note: If you do not have an SMTP server, this feature is unavailable to you.
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Notifications can also be sent to the system event log and a custom log file located

in the Agent folder of the product installation.

If notifications are not being delivered, check the setup of your SMTP server to

ensure that it is functioning properly.

To enable email notifications

1 On the main menu bar, click Tasks >Options.

2 Under Notifications, click SMTPE-mail.

3 Click the Select the priority and type ofmessages drop-down list and select

the priority level at which an email should be sent.

Send all messages, regardless of priority

levels.

All messages

Send only medium and high priority

messages.

Medium and high priority messages

Send only high priority messages.High priority messages only

Do not send any messages, regardless of

priority levels.

No messages

4 Select one or more of the following options:

■ Errors

■ Warnings

■ Information

5 In the To address text box, type the email address (for example,

admin@domain.com) where notifications are to be sent.

6 If desired, type the email address of the sender in the From address text field.

If you do not specify a From address, the name of the product will be used.

7 In the SMTP server text box, type the path to the SMTP server that will send

the email notification (for example, smtpserver.domain.com).

8 From the SMTP Authentication drop-down box, select the method to use to

authenticate to the SMTP server specified above.

9 Enter your SMTP username and password.

If you are not sure what your username and password are, contact a system

administrator.

10 Click OK.
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Updating Norton Ghost
You can receive software updates that are associated with your version of the

product over your Internet connection. When you run LiveUpdate, you connect

to the Symantec LiveUpdate server and select the product updates that you want

to install.

You run LiveUpdate as soon as you install the product. You should continue to

run LiveUpdate periodically to obtain program updates.

To update Norton Ghost

1 On the Help menu, click LiveUpdate.

2 In the LiveUpdate window, click Start to select the updates.

Follow the on-screen instructions.

3 When the installation is complete, click Close.

Some program updates might require that you restart your computer before

the changes take effect.

Uninstalling the product
When you upgrade Norton Ghost from a previous version of the product, the

install program automatically uninstalls the previous versions. If needed, you can

manually uninstall the product.

To uninstall Norton Ghost 12.0

1 Do one of the following:

■ On the Windows XP/2000 taskbar, click Start > Settings > Control Panel

>Add orRemove Programs.

■ On the Windows Vista taskbar, click Start > Control Panel > Programs

and Features >Uninstall or Change a Program.

2 Select Norton Ghost 12.0, and then click Remove (Uninstall on Windows

Vista).

You can choose to keep your current backup files, history files, and command

files on your computer for future installations of the Norton Ghost product,

rather than uninstalling them.

3 In the confirmation window, click Yes.

You must restart your computer for the changes to take effect.
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Introducing Norton Ghost™

This chapter includes the following topics:

■ About Norton Ghost 12.0

■ What's new in Norton Ghost

■ Key product components

■ How you use Norton Ghost

■ Where to find more information

About Norton Ghost 12.0
Norton Ghost provides advanced backup and recovery for your computer. Protect

your documents, financial records, presentations, photos, music, videos, historical

documents, or any other kinds of data you keep on your computer by making a

backup of your computer's entire hard disk. Or, limit your backup to include only

those files and folders that mean the most to you.

You can schedule backups to capture your changes automatically as you work

from day to day. Or start a backup manually at any time. You can also easily

configure Norton Ghost to run a backup in response to specific events. For example,

a backup can be started when a particular application is started, or when a specified

amount of new data has been added to the drive.

When you experience a problem with your computer, you can restore a file, folder,

or an entire drive, to return your computer to a previous, working state with the

operating system, applications, and data files intact. Or if you accidently delete

a personal file, get it back with a few simple steps.

Using easy-to-follow wizards, set up fast and reliable backups that run while you

continue to work. Or schedule your backups to run after hours when you are no

longer using your computer.
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When disaster strikes, Norton Ghost helps you recover your computer from the

effects of many common problems, including

■ Virus attacks: Damage might be done before a virus is quarantined.

■ Faulty software installations: Some software can negatively affect your

computer's performance, slowing it down to the point that opening programs

or documents can require too much time. But once installed, uninstalling a

product might not recover unintentional damage done during an install.

■ Hard drive failure: Data can become corrupted on your system drive (typically

C), making it impossible to start your operating system

■ Files accidentally deleted or overwritten: Accidental deletion of files is common,

but often costly.

■ Corrupted files: Individual files and folders can become corrupted by viruses,

or when a program used to modify them encounters an error.

What's new in Norton Ghost
Norton Ghost includes many enhancements and new features. Refer to the

following table for information about the latest features and enhancements:

Note: Not all features listed are available in all versions of this product.

DescriptionFeature

An improved user interface simplifies what you need to know and do to successfully

back up or recover files, folders, or your entire computer. And for Norton Ghost experts,

the Advanced page gives you a single view to most product features.

Enhanced ease-of-use

Norton Ghost has been designed and tested to run in the new Windows Vista operating

system, and still supports previous versions of Windows. See Table 1-1 on page 12..

Windows Vista support

Now setting up your first backup is even easier with the enhanced Easy Setup, which

appears either during install (unless you choose to skip it), or automatically the first

time you run Norton Ghost. Specify a few preferences, and Norton Ghost can start

backing up your computer on a regular basis.

Improved Easy Setup

Limit your backup to include a select set of files or folders. File and folder backups are

especially useful if your backup storage space is limited and you make frequent changes

to important documents that you want to back up.

File and folder backup

Need to back up you data quickly? The new One Time Backup feature lets you define

and run a backup at any time without saving the backup job for later use.

One Time backups
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DescriptionFeature

Search for and recover files stored in recovery points using Google Desktop™.

Also supports Symantec Backup Exec Retrieve.

Desktop search engine

support

Convert recovery points to one of two virtual disk formats for use in a virtual

environment.

Convert a recovery point

to virtual disk format

Restore a computer from a remote location, regardless of the state of the computer,

provided that its file system is intact.

LightsOut Restore

You can now easily edit your existing backup schedules without having to click through

multiple dialogs or complete the entire backup wizard again.

Simplified schedule editor

Because recovery points and file and folder backup data require storage space, Norton

Ghost gives you the freedom of where and how to handle the amount of disk space used

for storing backup data. Norton Ghost offers simple tools for managing your backup

data, and can even manage it for you automatically.

Manage backup data

The home page offers the backup protection status in a single view. But you can also

use the new Backups Calendar to view past and upcoming scheduled backups to see how

protected your data really is.

Improved backup and

recovery status

Norton Ghost automatically detects when a new storage device is connected to your

computer, and can prompt you to change your default backup destination to the new

drive.

Automatic backup

destination detection

Enhanced browsing of files and folders inside recovery points makes recovery quick and

easy; the new file and folder backup feature also lets you quickly search for and recover

files or folders.

Browse lost or damaged

files and folders

In addition to scheduled and manual backups, Norton Ghost can detect certain events

and run a backup automatically whenever they occur, providing an added level of

protection for your computer.

Event-triggered backups

Manually adjust the effect of a running backup on the performance of your computer

to better match your needs at the moment. This feature is especially useful if you are

working on your computer and don't want the backup process to slow you down.

And if you know the demographics of your network traffic, you can now set network

throttling to prevent network overload.

Performance throttling

If you have a Maxtor OneTouch™ external hard drive, you can back up your computer

with the push of a button. No need to start Norton Ghost.

Maxtor OneTouch™

integration
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DescriptionFeature

When you cannot start Windows, the newly enhanced Symantec Recovery Disk (SRD)

makes recovery easier than ever.

If the Symantec Recovery Disk is missing specific drivers, use the Create Recovery Disk

feature to create a modified Symantec Recovery Disk that includes the exact drivers

needed to successfully boot your computer into the recovery enironment.

Note: If you purchased Norton Ghost pre-installed on a new computer, some features

in the recovery environment may or may not be included, depending on how the computer

manufacturer chose to install it. The recovery environment has likely been pre-installed

on a special partition on your computer.

Modifiable Symantec

Recovery Disk

Key product components
Norton Ghost includes two key components: the program itself, and the Symantec

Recovery Disk.

Table 2-1 Key product components

DescriptionKey Component

The Norton Ghost program lets you define,

schedule, and run backups of your computer.

When you run a backup, recovery points of your

computer are created, which you can then use to

recover your entire computer, or individual drives,

files, and folders. You can also manage recovery

point storage (backup destination), and monitor

the backup status of your computer to make sure

your valuable data is backed up on a regular basis.

Norton Ghost program (user interface)

The Symantec Recovery Disk (SRD) is used to boot

your computer into the recovery environment. If

your computer's operating system fails, use the

SRD to recover your systemdrive (the drive where

your operating system is installed).

Note:Depending on which version of the product

you have purchased, the SRD is either included

on your product CD, or as a separate CD. You

should place the CD containing the SRD in a safe

place. Should you lose the CD, you can create a

new one if you have have a CD burner.

See “About recovering a computer ” on page 131.

Symantec Recovery Disk
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How you use Norton Ghost
While Norton Ghost does the work of backing up your files, folders, or entire

drives, you need to tell Norton Ghost what to backup, when to back it up, and

where to put the backed up data.

Using Norton Ghost includes the following key tasks:

■ Defining a backup

■ Running a backup

■ Recovering files, folders, or entire drives

Refer to the following figure to understand the relationship of these tasks.

Figure 2-1 Working with Norton Ghost
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Where to find more information
You can access the Help system from within the product for information regarding

how to use and troubleshoot the product. You can also access the completeNorton

Ghost User's Guide in PDF format in the \Docs folder on the product CD.

TheTroubleshooting appendix also contains many known issues and workarounds.

In addition to Norton Ghost documentation, check the Symantec Web site and

Knowledge Base at www.symantec.com/techsupp for answers to frequently asked

questions, troubleshooting help, online tutorials, and the latest product

information.

Introducing Norton Ghost™
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Best practices for backing

up

This chapter includes the following topics:

■ Best practices for backing up

■ Additional tips about backups

Best practices for backing up
As you prepare to back up your computer, review this information:

■ Before you back up

■ During a backup

■ When the backup is complete

About backups

When you back up your computer, you choose from two types of backups:

■ drive-based backup: backs up an entire hard drive

■ file and folder backup: backs up only the files and folders you select

Which backup type you choose depends on what you are trying to protect and

how much storage space you have to store backup data (recovery points, and file

and folder backup data).

The following table highlights the key uses of each backup type:
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Use toBackup type

■ Back up and recover your computer (system drive, typically

drive C)

■ Back up and recover a specific hard drive (any secondary

drive, drives other than your system drive)

■ Recover lost or damaged files or folders using recovery

points

Drive-based backup

■ Back up and recover specific files and folders, such as

personal files stored in the My Documents folder

■ Back up and recover files of a specific type, such as music

(.mp3, .wav) or photographs (.jpg, .bmp)

File and folder backup

Before you back up

Consider these best practices before defining and running your first backup:

Your computer must be turned on and Windows must

be running at the time a backup occurs. If not, any

scheduled backups are skipped until the computer is

turned on again. You then are prompted to run the

missed backup.

See “Choosing a backup type” on page 45.

Schedule backups when you know

your computer will be turned on.

You should store recovery points on a hard disk other

than your primary hard disk C. This practice helps

ensure that you can recover your system in the event

that your primary hard disk fails.

See “About selecting a backup destination ” on page 62.

Use a secondary hard disk as your

backup destination.

When you define your backups, schedule them to run

frequently so that you have recovery points that span

at least the last two months.

See “Editing a backup schedule ” on page 70.

See “Defining a drive-based backup ” on page 45.

Run backups on a regular and

frequent basis.
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You should keep your operating system and software

programs separate from your own data. This practice

helps to speed the creation of recovery points and

reduce the amount of information that needs to be

restored. For example, use the C drive to run Windows

and to install and run software programs. Use the D

drive to create, edit, and store personal files and

folders.

For other drive management solutions, go to the

Symantec Web site at the following URL:

www.symantec.com/.

Keep personal data on a separate

drive than the drive on which

Windows and your software

programs are installed.

When you define a backup, you should select the

option to verify the recovery point to ensure that the

recovery point can be used to recover lost data.

See “Choosing a backup type” on page 45.

Verify the recovery point after you

create it to ensure that it is stable.

During a backup

While a backup is running, consider the following best practices:

If you are working at your computer and a backup starts to

run, you might notice that the performance of your

computer slows down. Norton Ghost requires significant

system resources to run a backup. If slowing occurs, you

can reduce the speed of the backup to improve computer

performance until you are finished working.

See “Adjusting the speed of a backup ” on page 69.

Improve your computer's

performance during a backup

When the backup is complete

After a backup completes, consider the following best practices:

Periodically review the contents of your recovery

points to ensure that you back up only your essential

data.

For file and folder backups, click RecoverMyFiles

from either the Home or Tasks pages. Then click

Search to display the latest version of all the files that

are included in your backup.

For drive-based backups, see Opening files and folders

stored in a recovery point.

Review the contents of recovery

points and file and folder backup

data.
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Periodically review the Status page. You can also

review the events log on the Advanced page.

The event log records events when they occur,

backups and any errors that might have occurred

during or after a backup.

If you do not see the Advanced page tab, click View >

ShowAdvanced Page.

See “Verifying that a backup is successful ” on page 60.

Review the Status page to verify

that backups have happened and

to identify any potential problems.

Delete outdated recovery points to make more hard

disk space available.

Also, reduce the number of file versions that are

created by file and folder backups.

See “Managing recovery points” on page 107.

See “Managing file and folder backup data” on page 113.

Manage storage space by

eliminating old backup data.

Check the Status page on a regular basis to ensure

that each drive has a defined backup.

Review the level of protection that

is provided for each of your

computer's drives.

Store backup copies of your recovery points in a safe

place. For example you can store them elsewhere on

a network, or you can store them on CDs, DVDs, or

tapes for long-term, off-site storage.

See “Making copies of recovery points ” on page 109.

Maintain backup copies of your

recovery points.

Additional tips about backups
Consider the following tips when you run a defined backup:

■ Norton Ghost does not need to be running for a scheduled backup to start.

After you define a backup, you can close Norton Ghost.

■ The computer that is being backed up must be turned on and Windows must

be started.

■ All defined backups are saved automatically so that you can edit them or run

them later.

■ Do not run a disk defragmentation program during a backup. Doing so will

significantly increase the time that it takes to create the recovery point and

might cause unexpected system resource issues.

■ If you have two or more drives that are dependent on each other, you should

include both drives in the same backup. This provides the safest protection.

Best practices for backing up
Additional tips about backups
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■ Include multiple drives in the same defined backup to reduce the total number

of backups that must be run. Doing so minimizes interruptions while you work.

■ Use the Progress and Performance feature to reduce the impact of a backup

on your computer's performance. For example, if a scheduled backup starts

while you are in the middle of a presentation, you can slow down the backup

to give more processing resources back to your presentation program.

■ The power management features on a computer can conflict with Norton Ghost

during a backup.

For example, your computer might be configured to go into hibernation mode

after a period of inactivity. You should consider turning off the power

management features during a scheduled backup.

■ If a backup is interrupted, consider running it again.

■ If you experience problems while creating a backup, you may need to reboot

the computer.
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Backing up your data

This chapter includes the following topics:

■ About backing up your data

■ About backing up dual-boot computers

■ Choosing a backup type

■ Defining a drive-based backup

■ Defining a file and folder backup

■ After defining your backup

■ Running an existing backup immediately

■ Verifying that a backup is successful

■ Enabling event-triggered backups

■ About selecting a backup destination

■ About setting a compression level for drive-based backups

■ Setting advanced options for drive-based backups

■ Adjusting the speed of a backup

■ Editing a backup schedule

■ Editing backup settings

■ Turning off a backup job

■ Adding users who can back up your computer

■ Stopping a backup or recovery task
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■ Deleting backup jobs

■ Rescanning a computer’s hard disk

■ Configuring Norton Ghost to send SNMP traps

■ Using the Advanced page

About backing up your data
To back up your computer or your individual files and folders, you do the following

steps:

■ Define a backup

■ Run the backup

When you define a backup, you make the following decisions:

■ What to back up (files and folders, or an entire drive)

■ Where to store the backup data (backup destination)

■ When to run the backup (automatically or manually)

■ What compression levels to specify for recovery points, and whether to enable

security settings (encryption and password protection).

■ Which of the many other options you want to use. You can customize each

backup according to your backup needs.

About backing up dual-boot computers
You can back up dual-boot computers, even if you have drives (partitions) that

are hidden in the operating system from which you run Norton Ghost.

When you run a drive backup, the entire contents of each drive is captured in a

recovery point. When you restore a drive, the recovered drive is bootable.

Note: In order for your computer to boot the same from a restored system as it

did from the original configuration, you must back up, and then restore, every

drive that includes operating system boot information.

You should not create incremental backups of shared data drives if Norton Ghost

is installed on both operating systems and they are both set to manage the shared

drive.
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You might encounter issues if you try to use the Norton Ghost LightsOut Restore

feature on dual-boot systems. It is not supported.

Choosing a backup type
There are two types of backups available:

■ Drive-based backup: Backs up an entire hard drive

■ File and folder backup: Backs up only the files and folders that you select

You can use the following guidelines to determine which type of backup to choose:

Use this backup type to do the following:

■ Back up and recover your computer's system drive

(typically, the C drive, which includes your operating

system).

■ Back up and recover a specific hard drive, such as a

secondary drive (which is a drive other than the system

drive on which your operating system is installed).

■ Recover lost or damaged files or folders from a specific

point in time.

Drive-based backup

Use this backup type to do the following:

■ Back up and recover specific files and folders, for

example personal files that are stored in the My

Documents folder.

■ Back up and recover files of a specific type, for example

music (.mp3 or .wav) or photographs (.jpg or .bmp).

■ Recover a specific version of a file from a specific point

in time.

File and folder backup

See “Before you back up” on page 38.

Defining a drive-based backup
A drive-based backup takes a snapshot of your entire hard drive, capturing every

bit of information that is stored on it for later retrieval. All of your files, folders,

desktop settings, programs, and your operating system are captured into a recovery

point. You can then use that recovery point to restore individual files or folders

or your entire computer.

For optimum protection, you should define a drive-based backup and run it on a

regular basis.
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By default, scheduled independent recovery points or recovery point set names

are appended with 001.v2i, 002.v2i, and so forth. Recovery point set names are

appended with _i001.iv2i, _i002.iv2i, and so forth. For example, if your base

recovery point is called C_Drive001.v2i, the first incremental recovery point is

called C_Drive001_i001.iv2i.

To define a drive-based backup

1 On the Home page, click Run orManage Backups.

2 In the Run or Manage Backups window, click DefineNew.

If you have not yet defined a backup, the Easy Setup dialog appears instead.

3 Click Back upmy computer, and then click Next.

4 Select one or more drives to back up, and then click Next.

Press and hold Ctrl to select multiple drives.

If you do not see a drive that you expected to see, check ShowHiddenDrives.

5 Do one of the following:

■ If you selected a drive that has already been included in a defined backup,

click Next, and then skip to step 8.

■ Click Adddrives to an existing backup, click the Select the backup

drop-down list and select an existing backup, and then click Next.

■ Click Define a newbackup to define a new backup, and then click Next.

6 Select the type of recovery point that you want the backup to create.

Schedule a base recovery point with additional recovery

points that contain only incremental changes that were made

to your computer since the previous recovery point.

Incremental recovery points are created faster than the base

recovery point. They also use less storage space than an

independent recovery point.

Note: You can only have one recovery point set defined for

each drive. The Recovery Point Set option is not available if

you have already assigned a selected drive to an existing

backup and specified Recovery Point Set as the recovery

point type. This option also is unavailable if you select an

unmounted drive that cannot be part of a recovery point set.

Recovery point set

(recommended)

Creates a complete, independent copy of the drives that you

select. This backup type typically requires more storage

space, especially if you run the backup multiple times.

Independent recovery

point
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7 Click Next.

8 On the Backup Destination page, select from the following options:

Browse to the location in which you want to

store the recovery points.

If Norton Ghost detects that this location

does not have enough available space, it

alerts you. You should choose another

location that has more space.

Folder field

If you want to rename the recovery point,

clickRename, and then type a new file name.

Default file names include the name of the

computer followed by the drive letter.

Rename button

If you want to save the recovery point on a

network share, type the user name and

password for network access.

See “About network credentials” on page 53.

Network Credentials

9 Click Next.

Note: You cannot use an encrypted folder as your backup destination. You

can choose to encrypt your backup data to prevent another user from

accessing it.

10 On the Options page, select from the following options:

Type a name for your backup.Name

Select one of the following compression

levels for the recovery point.:

■ None

■ Standard

■ Medium

■ High

See “About setting a compression level for

drive-based backups” on page 65.

The results can vary depending on the types

of files that are saved in the drive.

Compression
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Select this option to automatically test

whether a recovery point or set of files is

valid or corrupt.

Verify recovery point after creation

Select this option to limit the number of

recovery point sets that can be saved for this

backup. You can limit the number of recovery

point sets to reduce the risk of filling up the

hard drive with recovery points. Each new

recovery point set replaces the oldest set on

your backup destination drive.

This option is not available if you selected

Independent recovery point as your recovery

point type.

Limit the number of recovery point sets

saved for this backup

Select this option to let a search engine, such

as Google Desktop, index all of the file names

that are contained in each recovery point.

By indexing the file names, you can then use

your search engine to locate files you want

to restore.

See “About using a search engine to search

recovery points” on page 155.

Enable search engine support

Check this option to include indexing support

for operating system and temporary files

when a recovery point is created on the client

computer.

Include system and temporary files

Type a description for the recovery point.

The description can be anything that helps

you further identify the recovery point's

contents.

Description text box

In the Advanced Options dialog box, select

any of the following options, and then click

OK.

■ Divide into smaller files to simplify

archiving

■ Disable SmartSector Copying

■ Ignore bad sectors during copy

■ Use password

■ Use AES Encryption

See “Setting advanced options for

drive-based backups” on page 66.

Advanced
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11 Click Next.

12 If appropriate, in the drop-down lists, select the command file (.exe, .cmd,

.bat) that you want to run during a particular stage in the recovery point

creation process, and then specify the amount of time (in seconds) that you

want the command to run before it is stopped.

If you added the command file to the CommandFiles folder, you may need to

click Back, and then Next to see the files in each stage’s drop-down list.

See “Run command files during a backup ” on page 53.

13 Click Next.

14 Do one of the following:

■ If you chose a recovery point set as your recovery point type in step 6,

skip to the next step.

■ If you chose an independent recovery point as your recovery point type,

click the Automatically create a recoverypoint drop-down list, and then

select one of the following options:

Runs the backup only when you run it yourself,

manually.

No Schedule

Runs the backup at the time and on the days

of the week that you specify.

When you select this option, the Select the days

of the week to protect box appears.

Weekly

Runs the backup at the time and on the days

of the week that you specify.

When you select this option, the Select the days

of the month to protect box appears.

Monthly

Runs the backup one time on the date and at

the time you specify.

When you select this option, the Create a single

recovery point box appears.

Only run once

15 Click Schedule if you want the backup to run automatically, according to a

schedule.

If you only want to run the backup when you start it manually, uncheck

Schedule and skip to step 17.

16 Enter a start time and select the days of the week when the backup should

run.
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17 Click the Start a new recovery point set drop-down list, and then select how

frequently a new recovery point set should be started.

For example, if you select Monthly, a new base recover point is created the

first time the backup runs during each new month.

18 For advanced scheduling options, such as setting up event triggers that start

the backup in response to specific events, click Advanced and configure any

of the following options:

Do one or more of the following:

■ ClickSchedule, and then select the days and a start time for when

the backup should run.

■ CheckRunmore thanonceperday if you frequently modify data

that you want to protect.

Also, specify the maximum time that should occur between

backups and the number of times per day that the backup should

run.

■ Click theAutomaticallyoptimize drop-down list, and then select

how often optimization should occur to help manage the disk

space that is used by your backup destination.

■ Click the Startanewrecoverypointset drop-down list and select

how frequently a new recovery point set should be started.

Click Custom to customize the option you select.

Schedule

(Backup Time)

Select the type of events that should automatically start the backup.

See “Enabling event-triggered backups ” on page 61.

Event Triggers

(General)

19 Click OK, and then click Next.

20 If you want to run the new backup immediately, click Runbackup now.

This option is not available if you configured an independent recovery point

with the option to run it only once.

21 Click Finish.

Running a One Time Backup

The One Time Backup feature lets you quickly define and run a backup that creates

an independent recovery point. You use the One Time Backup Wizard to define

the backup. The backup runs when you complete the Wizard. The backup definition

is not saved for future use. You can use the independent recovery point later.

This feature is useful when you need to back up your computer or a particular

drive quickly before a significant event. For example, you can run a one-time
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backup before you install new software. Or, you can run it when you learn about

a new computer security threat.

To run a one time backup

1 On the Tasks page, click One TimeBackup.

2 Click Next.

3 Select one or more drives to back up and click Next.

Note: Press and hold Ctrl to select multiple drives.

4 Click Next.

5 In the Backup Destination dialog box, select from the following options:

Browse to the location in which you want to

store the recovery points.

If Norton Ghost detects that this location

does not have enough available space, it

alerts you. You should choose another

location that has more space.

Folder field

If you want to rename the recovery point,

clickRename, and then type a new file name.

Default file names include the name of the

computer followed by the drive letter.

Rename button

If you want to save the recovery point on a

network share, type the user name and

password for network access.

See “About network credentials” on page 53.

Network Credentials

6 Click Next.

7 On the Options page, select from the following options:
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Compression Select one of the following compression

levels for the recovery point:

■ None

■ Standard

■ Medium

■ High

The results can vary depending on the types

of files that are saved in the drive.

Select this option to automatically test

whether a recovery point or set of files is

valid or corrupt.

Verify recovery point after creation

Type a description for the recovery point.

The description can be anything that helps

you further identify the recovery point's

contents.

Description text box

In the Advanced Options dialog box, select

any of the following options, and then click

OK.

■ Use password

■ Use Encryption

■ Divide into smaller files to simplify

archiving

■ Ignore bad sectors during copy

■ Disable SmartSector Copying

See “Setting advanced options for

drive-based backups” on page 66.

Advanced

8 Click Next.

9 If appropriate, in the drop-down lists, select the command file (.exe, .cmd,

.bat) that you want to run during a particular stage in the recovery point

creation process, and then specify the amount of time (in seconds) that you

want the command to run before it is stopped.

If you added the command file to the CommandFiles folder, you may need to

click Back, and then Next to see the files in each stage’s drop-down list.

See “Run command files during a backup ” on page 53.

10 Click Next.

11 Click Finish to run the backup.
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Files excluded from drive-based backups

The following files are intentionally excluded from drive-based backups:

■ hiberfil.sys

■ pagefile.sys

These files contain temporary data that can take up a large amount of disk space.

They are not needed, and there is no negative impact to your computer system

after a complete system recovery.

These files do appear in recovery points, but they are placeholders. They contain

no data.

About network credentials

If you connect to a computer on a network, you must provide the user name and

password for network access, even if you previously authenticated to the network.

The Norton Ghost service runs on the local system account.

When you enter network credentials, the following rules apply:

■ If the computer you want to connect to is on a domain, provide the domain

name, user name, and password. For example:

domain\username

■ If you connect to a computer in a workgroup, provide the remote computer

name and user name. For example:

remote_computer_name\username

■ If you have mapped a drive, you might be required to supply the user name

and password again because the service runs in a different context and cannot

recognize the mapped drive.

By going to the Tasks menu and selecting Options, you can set a default location,

including network credentials. Then when you create future backup jobs, the

dialog will default to the location you specified. Another option would be to create

a specific "backup" user account. Then configure the Norton Ghost service to use

this account.

Run command files during a backup

You can use command files (.exe, .cmd, .bat) during a backup. You can use command

files to integrate Norton Ghost with other backup routines that you might be

running on the computer. You can also use command files to integrate with other

applications that use a drive on the computer.
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Note: You cannot run command files that include a graphical user interface, such

as notepad.exe. Running such command files will cause the backup job to fail.

You can run a command file during any of the following stages during the creation

of a recovery point:

■ Before data capture

■ After data capture

■ After recovery point creation

You can also specify the amount of time that a command file should be allowed

to run.

You can specify the location of command files if you want them to be located in

a place other than the default location. You can also specify a location on a per-job

basis, as well as specify a location that can be shared among several computers.

If you specify a network location, you must provide network credentials.

See “About network credentials” on page 53.

The most common use for running command files is to stop and restart

non-VSS-aware databases that you want to back up.

To use a Visual Basic script file (.VBS) during a backup, you can create a batch file

(.BAT) to run the script. For example, you can create a batch file called STOP.BAT

that contains the following syntax:

Cscript script_filename.vbs

Make sure that Cscript precedes the file name of the Visual Basic script.

Warning: The command files cannot depend on any user interaction or have a

visible user interface. You should test all command files independently of Norton

Ghost before you use them during a backup.

When the backup begins, the command file is run during the specified stage. If

an error occurs while a command file is running or the command file does not

finish in the time you specified (regardless of the stage), the backup is stopped,

the command file is terminated (if necessary), and the error information is logged

and displayed.

Table 4-1 describes the stages of recovery point creation.
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Table 4-1 Recovery point creation stages

DescriptionStage

This stage occurs after a backup has started and

before a recovery point is created. You can run a

command during this stage to prepare for the

recovery point creation process. For example, you

can close any open applications that are using the

drive.

Note: If you use this option, be sure the command

file has an error recovery mechanism built into

it. If the computer has one or more services that

must be stopped at this stage (such as stopping a

non-VSS aware database or a resource intensive

application), and the command file does not

contain any form of error recovery, one or more

of the stopped services may not be restarted. An

error in the command file can cause the recovery

point creation process to stop immediately. No

other command files will run.

See “How you use Norton Ghost” on page 35.

Before data capture

This stage occurs after a snapshot is created.

Running a command during this stage is typically

a safe point for allowing services to resume

normal activity on the drive while continuing the

recovery point creation.

Because the snapshot takes only a few seconds to

create, the database is in the backup state

momentarily. A minimal number of log files are

created.

After data capture

This stage occurs after the recovery point is

created. You can run a command during this stage

to act on the recovery point itself. For example,

you can copy it to an offline location.

After recovery point creation

Defining a file and folder backup
When you define and run a file and folder backup, copies are made of each of the

files and folders that you have chosen to back up. They are converted into a

compressed format, and then stored in a sub-folder at the location you specify,

which by default is the same backup destination that is used for storing recovery

points.
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To define a file and folder backup

1 On the Home page, click Run orManage Backups.

2 In the Run or Manage Backups window, click DefineNew.

If you have not yet defined a backup, the Easy Setup dialog appears.

3 Select Back up selected files and folders, and then click Next.

4 Select the files and folders you want to include in your backup, and then click

Next.

Selecting file types lets Norton Ghost find and include files that match the

files you want backed up. If a file type is not included in the predefined list,

click AddFile Type. You can also manually select folders or individual files.

Note: On all versions of Windows, except for Windows Vista, the My

Documents folder contains two subfolders by default: My Pictures and My

Music. These folders contain only the shortcuts to folders at another location

and not the actual files. This might lead you to think that by including My

Documents and all subfolders in your backup, your picture and music files

will get backed up.

If you intend to back up your pictures and music files, be sure to include the

actual folders where your files are stored. On Windows Vista, these folders

exist at the same level as Documents (formerly, My Documents).

5 In the Name box, type a name for your new backup.

6 In the Description (optional) box, type a description for the new backup.

7 Click Browse to locate a folder for storing your backup data or accept the

default location.

Note: You cannot use an encrypted folder as your backup destination. If you

want to encrypt your backup data to prevent another user from accessing it,

refer to the next step.

8 To modify advanced options, click Advanced. Do any of the following:

■ Click Use password, and then type a password.

Use standard characters, not extended characters or symbols. You must

type this password before you restore a backup or view its contents.

■ For an additional level of security, click Use encryption to encrypt your

file data.
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■ In the Exclude group box, uncheck any of the folders you want to include

in your backup.

The folders listed are typically not used for storing personal files or folders.

These folders are backed up when you define and run a drive-based backup

of your system drive (typically C).

9 Click OK, and then click Next.

10 Click Schedule if you want the backup to run automatically, according to a

schedule.

If you want to run the backup only when you start it manually, uncheck

Schedule.

11 Enter a start time and select the days of the week when the backup should

run.

12 For advanced scheduling options, such as setting up event triggers that start

the backup in response to specific events, click Advanced and configure any

of the following options:

Do one or more of the following:

■ Click Schedule, and then select the

days and a start time for when the

backup should run.

■ Check Runmore than once per day if

you frequently modify data that you

want to protect.

Also, specify the maximum time that

should occur between backups and the

number of times per day that the

backup should run.

Schedule (Backup Time)

Select the type of events that should

automatically start the backup.

See “Enabling event-triggered backups ”

on page 61.

Event Triggers (General)

13 Click Next to review the backup options you have selected.
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14 To review the total number and size of files to be included in the backup, click

Preview.

Note: Depending on the amount of data you have identified for file and folder

backup, the preview process could take several minutes.

15 If you want to run the new backup immediately, click Runbackup now, and

then click Finish.

Folders excluded by default from file and folder backups

The following folders and their contents are excluded automatically from file and

folder backups:

■ Windows folder

■ Program Files folder

■ Temporary folder

■ Temporary Internet Files folder

These folders are typically not used for storing personal files or folders. However,

they are backed up when you define and run a drive-based backup of your system

drive (typically C).

See “Defining a file and folder backup ” on page 55.

You can include these folders when you define a file and folder backup.

After defining your backup
All backups you define are automatically saved so that you can edit or run them

later.

After you define a backup and schedule it to run, you can close Norton Ghost. The

program does not need to be running for a backup to start.

However, your computer must be turned on and Windows must be running at the

time a backup occurs. If not, any scheduled backups are skipped until the computer

is turned on again. You then are prompted to run the missed backup.

Running an existing backup immediately
This is particularly useful when you are about to install a new product and want

to make sure you have a current recovery point in the event that something goes
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wrong with the installation. It can also help you to ensure that you have a backup

of your work after you have modified a large number of files and you don't want

to wait for a regularly scheduled backup.

You can run an existing backup at any time.

Note: If necessary, you can run a quick backup of a particular drive without using

a defined backup.

See “Running a One Time Backup” on page 50..

Norton Ghost can be configured to run a backup automatically when an event

occurs on your computer, such as installing a new software program.

See “Enabling event-triggered backups ” on page 61.

When you run a backup, you should close any partitioning software that is running,

such as Norton PartitionMagic. Also, you should not run any disk defragmenting

software during a backup.

You can also schedule backups to run automatically, according to a schedule.

See “Editing a backup schedule ” on page 70.

To run an existing backup immediately from the system tray

1 On the Windows desktop, right-click the Norton Ghost system tray icon.

2 Click RunBackupNow.

3 Click a backup job to start the backup.

If the menus displays No Jobs, you must start Norton Ghost and define a

backup.

To run an existing backup immediately from within Norton Ghost

1 On the Home page, click Run orManage Backups.

2 Select a backup from the list, and then click RunNow.

Run a backup with options

If you want to quickly run an existing drive-based backup, but you want the backup

to create an alternate type of recovery point, use the Run Backup With Options

feature.

This is a unique option in that if you run an existing backup job, the recovery

point created is dictated by the type of recovery point that was created the last

time the backup job was run. Use this option to create an alternate recovery point

type.

59Backing up your data
Running an existing backup immediately



Note: Using this option does not change the settings of the defined backup. To do

that, you must open the backup and modify its settings manually.

See “Editing a backup schedule ” on page 70.

See “Editing backup settings” on page 70.

To run a backup with options

1 On the Home page, click Run orManage Backups.

2 In the Run or Manage Backups window, select the drive-based backup job

that you want to run.

3 Click Tasks > RunBackupWithOptions.

4 Select one of the following options:

Note: Depending on the current state of the backup, one or more options

might be disabled. For example, if you have not yet run the backup, you cannot

select the first option, Incremental recovery point of recent changes, because

the base recovery point has not yet been created.

Select this option if the backup already

has a base recovery point created and you

want to simply capture changes made to

the drive since the last backup.

Incremental recovery point of recent

changes

Select this option if you want to start a

completely new recovery point set. When

you select this option, a base recovery

point is created.

New recovery point set

Select this option to create an

independent recovery point, which is a

complete snap shot of your entire drive.

To specify an alternate backup location,

click Browse.

Independent recovery point

5 ClickOK to run the backup job and create the recovery point type you selected.

Verifying that a backup is successful
After a backup completes, you can validate the success of the backup from the

Status page to ensure you have a way to recover lost or damaged data.
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The Status page contains a scrolling calendar that is aligned with each drive on

your computer. The calendar lets you quickly identify when a backup ran, and

what type of backup it was. It also identifies upcoming, scheduled backups.

See “Monitoring backup protection from the Status page ” on page 91.

Note:When you define a drive-based backup, you should select the option to verify

the recovery point after it is created.

Depending on the amount of data being backed up, this can significantly increase

the time it takes to complete the backup. However, it can ensure that you have a

valid recovery point when the backup finishes.

See “Verifying a recovery point after creation ” on page 68.

To verify the success of a backup

1 On the Status page, review the Backups calendar, and verify that the backup

appears on the date that you ran it.

2 Move your mouse over a backup icon to review the status of the backup.

Enabling event-triggered backups
Norton Ghost can detect certain events and run a backup when they occur.

For example, to protect your computer when you install new software, Norton

Ghost can run a backup when it detects that new software is being installed. If a

problem occurs that harms your computer, you can use this recovery point to

restore your computer to its previous state.

You can configure Norton Ghost to automatically run a backup when the following

events occur:

■ A specified application is started

■ Any application is installed

■ Any user logs on to the computer

■ Any user logs off of Windows

■ The data added to a drive exceeds a specified number of megabytes

This option is unavailable for file and folder backups.

■ The Maxtor OneTouch™ external hard drive button is pushed
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Note:This feature only appears if you have a Maxtor OneTouch drive installed,

and you are running a Windows XP 32-bit platform.

To enable event-triggered backups

1 On the Home or Tasks page, click Run orManage Backups.

2 Select the backup you want to edit, and then click Change Schedule.

3 Click General under Event Triggers.

4 Select the events you want detected, and then click OK.

About selecting a backup destination
You should review the following information before deciding where to store

recovery points and file and folder backup data.

Note: If you choose to use CDs or DVDs as your backup destination (not

recommended), you cannot back up to a sub-folder on the disk. Backup data must

be created at the root of CDs and DVDs.

Table 4-2 contains information that you need to consider when selecting a backup

destination.
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Table 4-2 Selecting a backup destination

Information to considerBackup destination

The benefits of this option are as follows:

■ Fast backup and recovery

■ Can schedule unattended backups

■ Inexpensive because drive space can be overwritten

repeatedly

■ Off-site storage is possible

■ Reserves hard drive space for other uses

Although you can save the recovery point to the same drive

that you are backing up, it is not recommended for the

following reasons:

■ As the number or size of recovery points grows, you will

have less disk space available for regular use.

■ The recovery point is included in subsequent recovery

points of the drive, which increases the size of those

recovery points.

■ If the computer suffers a catastrophic failure, you may

not be able to recover the recovery point you need, even

if you save it to a different drive on the same hard disk.

Local hard drive, USB drive,

or FireWire drive

(recommended)

If your computer is connected to a network, you can save

your recovery points and file and folder backup data to a

network folder.

Backing up to a network folder typically requires that you

authenticate to the computer that is hosting the folder. If

the computer is part of a network domain, you must provide

the domain name, user name, and password. For example,

domain\username.

If you are connecting to a computer in a workgroup, you

should provide the remote computer name and user name.

For example: remote_computer_name\username.

Network file
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Table 4-2 Selecting a backup destination (continued)

Information to considerBackup destination

When you save backup data to removable media, it is

automatically split into the correct sizes if the backup spans

more than one media.

If more than one drive is being backed up, the recovery

points for each drive are stored independently on the media,

even if there is space to store recovery points from multiple

drives on the same media.

The scheduling of backups is not available when this option

is used.

Note: Using CD-RWs or DVD-RWs as your recovery point

storage location is not the best option because you will be

required to swap disks during the process.

CD-RW/DVD-RW

Table 4-3 describes the advantages and disadvantages of different types of backup

destinations.

Table 4-3 Advantages and disadvantages of backup destinations

DisadvantagesAdvantagesBackup destination

■ Uses valuable drive space

■ Vulnerable to loss if the

hard drive fails

■ Fast backup and recovery

■ Can schedule unattended

backups

■ Inexpensive because

drive space can be

overwritten repeatedly

Hard drive

(recommended)

■ Must have supported NIC

drivers to restore from

the recovery environment

■ Must understand and

assign the appropriate

rights for users who will

run backups and restore

data

■ Fast backup and recovery

■ Can schedule unattended

backups

■ Inexpensive because

drive space can be

overwritten repeatedly

■ Protection from local

hard drive failure

■ Off-site storage (through

existing network backup

strategies)

Network drive

(recommended)
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Table 4-3 Advantages and disadvantages of backup destinations (continued)

DisadvantagesAdvantagesBackup destination

■ Protection from hard

drive failure

■ Ideal for off-site storage

■ Reserves hard drive space

for other uses

Removable media (local)

About setting a compression level for drive-based
backups

During the creation of a recovery point, compression results may vary, depending

on the types of files saved to the drive you are backing up.

Table 4-4 describes the available compression levels.

Table 4-4 Compression levels

DescriptionCompression level

Use this option if storage space is not an issue. However, if

the backup is being saved to a busy network drive, high

compression may be faster than no compression because

there is less data to write across the network.

None

This option uses low compression for a 40 percent average

data compression ratio on recovery points. This setting is

the default.

Standard (recommended)

This option uses medium compression for a 45 precent

average data compression ratio on recovery points.

Medium

This option uses high compression for a 50 percent average

data compression ratio on recovery points. This setting is

usually the slowest method.

When a high compression recovery point is created, CPU

usage might be higher than normal. Other processes on the

computer might also be slower. To compensate, you can

adjust the operation speed of Norton Ghost. This might

improve the performance of other resource-intensive

applications that you are running at the same time.

High
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Setting advanced options for drive-based backups
When you define a drive-based backup, you can set the following advanced options:

You can split the recovery point into smaller files and

specify the maximum size (in MB) for each file.

For example, if you plan to copy a recovery point to ZIP disks

from your backup destination, specify a file size of 100 MB

or less, according to the size of each ZIP disk.

Divide into smaller files to

simplify archiving

SmartSector technology speeds up the copying process by

only copying the hard-disk sectors that contain data.

However, in some cases, you might want to copy all sectors

in their original layout, whether or not they contain data.

This option lets you copy used and unused hard-disk sectors.

This option increases processing time and usually results

in a larger recovery point.

Disable SmartSector Copying

This option lets you run a backup even if there are bad

sectors on the hard disk. Although most drives do not have

bad sectors, the potential for problems increases during the

lifetime of the hard disk.

Ignore bad sectors during

copy

This option sets a password on the recovery point when it

is created. Passwords can include standard characters, not

extended characters or symbols. (Use characters with an

ASCII value of 128 or lower.)

A user must type this password before restoring a backup

or viewing the contents of the recovery point.

Use password

You can encrypt your recovery point data to add another

level of protection to your recovery points.

You can choose from the following encryption levels:

■ Low (8+ character password)

■ Medium (16+ character password)

■ High (32+ character password).

Use AES encryption

Editing advanced backup options

After you define a backup, you can go back at any time and edit the advanced

options you chose when you first defined the backup.
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To edit advanced backup options

1 On the Home or Tasks page, click Run orManage Backups.

Select the backup you want to edit, and then click Edit Settings.

2 Click Next twice.

3 Click Advanced.

4 In the Advanced Options dialog box, make your changes, and then click OK.

5 Click Next three times, and then click Finish.

About recovery point encryption

You can enhance the security of your data by using the Advanced Encryption

Standard (AES) to encrypt recovery points that you create or archive. You should

use encryption if you store recovery points on a network and want to protect them

from unauthorized access and use.

You can also encrypt recovery points that were created with earlier versions of

Symantec LiveState Recovery or Norton Ghost. However, encrypting those files

will make them readable with the current product only.

You can view the encryption strength of a recovery point at any time by viewing

the properties of the file from the Recovery Point Browser.

Encryption strengths are available in 128-bit, 192-bit, or 256-bit. While higher

bit strengths require longer passwords, the result is greater security for your data.

Table 4-5 explains the bit strength and required password length.

Table 4-5 Password length

Password lengthBit strength

8 characters or longer128 (Standard)

16 characters or longer192 (Medium)

32 characters or longer256 (High)

You must provide the correct password before you can access or restore an

encrypted recovery point.
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Warning: Store the password in a secure place. Passwords are case-sensitive. When

you access or restore a password encrypted recovery point, Norton Ghost prompts

you for the case-sensitive password. If you do not type the correct password or

you forget the password, you cannot open the recovery point.

Symantec Technical Support has no method for opening an encrypted recovery

point.

Besides bit strength, the make-up of the password can improve the security of

your data.

For better security, passwords should use the following general rules:

■ Avoid using consecutive, repeating characters (for example, BBB or 88).

■ Avoid using common words that you would find in a dictionary.

■ Use at least one number.

■ Use both uppercase and lowercase alpha characters.

■ Use at least one special character such as ({}[],.<>;:’"?/|\`~!@#$%^&*()_-+=).

■ Change the password after a set period of time.

Verifying a recovery point after creation

If you selected the Verify recovery point after creation option on the Options page

of the Define Backup Wizard, the recovery point is checked to see that all of the

files that make up the recovery point are available for you to open. Internal data

structures in the recovery point are matched with the data that is available. Also,

the recovery point can be uncompressed to create the expected amount of data

(if you selected a compression level at the time of creation).

Note: The time required to create a recovery point is doubled when you use the

Verify recover point after creation option.

To verify the integrity of a recovery point

1 On the Tools page, click RunRecovery Point Browser.

2 Select a recovery point, and then click Open.

3 In the tree panel of the Recovery Point Browser, select the recovery point.

For example: C_Drive001.v2i.
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4 On the File menu, click Verify Recovery Point.

If the Verify Recovery Point option is unavailable, you must first dismount

the recovery point. Right-click the recovery point and click Dismount

Recovery Point.

5 When the validation is complete, click OK.

If you prefer, you can have recovery points automatically verified for integrity

at the time they are created.

See “Setting advanced options for drive-based backups” on page 66.

Viewing the progress of a backup

You can view the progress of a backup while it runs to determine how much time

remains until the backup completes.

To view the progress of a backup

◆ While a backup is running, on the View menu, click Progress and

Performance.

Adjusting the speed of a backup
Depending on the speed of your computer, how much RAM you have installed,

and the number of programs you are running during a backup, your computer

could become sluggish.

You can manually adjust the effect of a backup on the performance of your

computer to match your needs at the moment. This feature is useful if you are

working on your computer and don't want the backup process to slow you down.

To adjust the performance of a backup

1 While a backup is running, on the View menu, click Progress and

Performance.

2 Do one of the following:

■ If you want to increase the speed of your computer by reducing the speed

of the backup, drag the slider toward Slow.

■ If you want the backup to complete as quickly as possible and you are not

doing extensive work on your computer, drag the slider toward Fast.

3 When you are finished, click Hide to dismiss the Progress and Performance

dialog box.
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Editing a backup schedule
You can edit any of the schedule properties for a defined backup to adjust the date

and time.

To edit a backup schedule

1 On the Home page, click Run orManage Backups.

2 Select a backup to edit.

3 Click Change Schedule.

4 Make changes to the schedule, and then click OK.

Editing backup settings
You can modify the settings of an existing backup. The Edit Settings feature gives

you access to several of the key pages of the Define Backup Wizard. You can modify

every setting except the option to change the recovery point type.

To edit backup settings

1 On the Home or Tasks pages, click Run orManage Backups.

2 Select a backup to edit.

3 Click Edit Settings.

4 Make changes to the backup.

See “Defining a drive-based backup ” on page 45.

See “Defining a file and folder backup ” on page 55..

Turning off a backup job
You can turn off a backup and re-enable it later. When you turn off a backup, it

will not run according to its defined schedule, if it has one. When a backup is

turned off, triggered events will not run it, nor can you run it manually.

You can also delete a defined backup (not recovery points).

See “Deleting backup jobs ” on page 72.
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To turn off a backup job

1 On the Home page, click Run orManage Backups.

2 Select the backup that you want to turn off.

3 Click Tasks >Disable Backup.

Repeat this procedure to re-enable the backup. The Disable Backup menu

item changes to Enable Backup when you disable the selected backup.

Adding users who can back up your computer
You can use the Norton Ghost Security Configuration Tool to give additional users

and groups rights to access your copy of Norton Ghost. Default rights are given

to those who function in the role of Administrator and to the person who installed

Norton Ghost.

To add users who can back up a computer

1 On the Windows taskbar, click Start >Programs>Symantec>NortonGhost

> Security Configuration Tool.

On Windows Vista, click Start >All Programs > Symantec > Security

Configuration Tool.

2 Click Add.

3 In the Enter the object names to select box, type the names of the users or

groups you want to add.

4 Click OK.

5 To delete users or groups, select a user or group, and then click Remove.

6 Click OK to apply your changes and close the Security Configuration Tool.

Stopping a backup or recovery task
You can stop a backup or a recovery task that has already started.

To stop a backup or recovery task

◆ Do one of the following:

■ On the View menu, clickProgressandPerformance, and then clickCancel

Operation.

■ On the Windows system tray, right-click the Norton Ghost tray icon, and

then click Cancel Current Operation.
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Deleting backup jobs
You can delete backup jobs when they are no longer needed.

Deleting a backup job does not delete the recovery points or file and folder backup

data from the storage location. Only the backup job is deleted.

If you want to delete backup data (recovery points and file and folder backup data),

refer to the following topics:

See “Managing recovery points” on page 107.

To delete backup jobs

1 On the Home page, click Run orManage Backups.

2 Select one or more backups, and then click Remove.

3 Click Yes.

Rescanning a computer’s hard disk
Use Refresh to update the drive information that is displayed in various views of

the product. This feature is useful when hard disk configurations have changed

but the changes do not immediately appear in Norton Ghost. For example, adding

hard disk space or creating a partition.

When you use Refresh, Norton Ghost scans all attached hard disks for any

configuration changes. It also updates information on removable media, CD-ROM

or DVD-ROM drives, basic drives, file systems, and hard drive letters.

To rescan a computer’s hard disks

◆ On the View menu, click Refresh.

The Status Bar at the bottom of the product's window indicates when the

scanning is taking place.

Configuring Norton Ghost to send SNMP traps
You must install and configure the Windows SNMP service on your computer in

order for SNMP traps to work in Norton Ghost.

By default, Norton Ghost is not enabled to send traps to Network Management

System (NMS) applications. You can configure Norton Ghost to send SNMP traps

for different priority and notification types.
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To configure Norton Ghost to send SNMP traps

1 On the Tasks menu, click Options.

2 Under Notifications, click SNMPTrap.

3 Click the Select the priority and type ofmessages drop-down list and select

the priority level at which traps should be generated.

Send all messages, regardless of priority

levels.

All messages

Send only medium and high priority

messages.

Medium and high priority messages

Send only high priority messages.High priority messages only

Do not send any messages, regardless of

priority levels.

No messages

4 Select one or more of the following options:

■ Errors

■ Warnings

■ Information

5 Select the version of SNMP traps to be sent (Version 1 or Version 2), and then

click OK.

About the Norton Ghost management information base

The Norton Ghost management information base (MIB) is an enterprise MIB. It

contains the Norton Ghost SNMP trap definitions. All Network Management

System (NMS) applications have options to load a MIB. You can use any of these

options to load the Norton Ghost MIB. If you do not load the MIB, the NMS

application will still receive and display the traps, but the traps will not be

displayed in informative text. The .MIB file, named BESR_MIB.MIB, is located in

the Support folder on the Norton Ghost 12.0 product CD.

Using the Advanced page
The Advanced page offers experienced Norton Ghost users a single view of the

most common product features. If you have a good understanding of Norton Ghost,

you might prefer to perform most tasks from the Advanced view.

73Backing up your data
Using the Advanced page



Note: When refering to the documentation while using the Advanced page, the

first one or two steps do not apply because they indicate where to access each

feature from the other pages of the product interface. From that point on, follow

the remaining steps of each procedure.

The Advanced page can be hidden from view if you do not plan to use it.

To hide the Advanced page

1 Start Norton Ghost.

2 On the View menu, click ShowAdvanced Page.

To show the Advanced page

1 Start Norton Ghost.

2 On the View menu, click ShowAdvanced Page.
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Backing up remote

computers from your

computer

This chapter includes the following topics:

■ About backing up other computers from your computer

■ Adding computers to the Computer List

■ Deploying the agent

■ Using the Norton Ghost 12.0 Agent

■ Managing the agent through Windows Services

■ Best practices for using services

■ Controlling access to Norton Ghost

About backing up other computers from your
computer

Norton Ghost lets you connect to, and back up a second computer on your home

or office network. You can manage as many computers as needed, but you can

only manage one computer at a time.
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Note:You must purchase a separate license for each computer you want to manage.

You can deploy the agent without a license for a 30-day evaluation. After that

time, you must purchase and install the license to continue managing the remote

computer. You can purchase additional licenses at the Symantec Global Store.

Visit:

http://shop.symantecstore.com

First, you add a computer's name or IP address to the Computer List. Then, you

deploy the Norton Ghost Agent to the remote computer. Once the agent is installed,

the computer automatically restarts. After the computer restarts, you can then

connect to the computer. When you do, the Norton Ghost product interface changes

to reflect the status of the remote computer. At any time, you can switch back to

manage your own, local computer.

Adding computers to the Computer List
Before you can back up drives on a remote computer, you must first add the

computer to the Computer List. You can then quickly switch between your local

computer and any other computer on the list.

To add computers to the Computer List

1 On the Norton Ghost menu bar, click Computers > Add.

2 Do one of the following:

■ Type the name of the computer

■ Type the IP address of the computer

If you are in a workgroup environment instead of a domain you must

manually specify the computer name for the computer you want to manage

by browsing to it by using the Browse button.

3 If you don't know the name of the computer, or its IP address, click Browse

and search for the computer you want to add, and then click OK.

4 Click OK to add the computer to the Computer List.

To add a local computer

1 On the Norton Ghost menu bar, click Computers > Add Local Computer.

2 Click OK.
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To remove a computer from the Computer List

1 On the Norton Ghost menu bar, click Computers > Edit List.

2 Select the remote computer that you want to remove, click the minus sign

(-), and then click OK.

Note: Removing a computer from the Computer List does not uninstall the

agent from the computer. You must run the Windows Uninstall program.

See “Uninstalling the product” on page 30.

Deploying the agent
You can deploy the Norton Ghost 12.0 Agent to the computers that are on the

Computer List by using the Agent Deployment feature. After you install the agent,

you can create backup jobs directly from Norton Ghost.

Note: Because of increased security with Windows Vista, you cannot deploy the

Norton Ghost 12.0 Agent to Windows Vista without making security configuration

changes. The same issue occurs when you attempt to deploy the agent from

Windows Vista to another computer. You can manually install the agent on the

target computer using the product CD.

See “Uninstalling the product” on page 30.

Note: If you deselected the Agent Deployment option during installation, this

feature is not available. You can run the installation again, and select the Modify

option to add this feature back in.

You can install the agent to a computer that has less than 256 MB of RAM.

However, Symantec Recovery Disk requires at least 512 MB of RAM for restoring

the computer. Your computer must meet the minimum memory requirement to

run the Recover My Computer wizard or the Recovery Point Browser from the

recovery environment.

Note: If you are installing a multilingual version of the product, you must have a

minimum of 768 MB of RAM to run the Symantec Recovery Disk.

If your computers are set up in a workgroup environment, you should prepare

your local computer before you deploy an agent.
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To prepare a computer in a workgroup environment to deploy the agent

1 On the Windows taskbar, right-click Start, and then click Explore .

2 On the Tools menu, click FolderOptions >View.

3 On the View tab, scroll to the end of the list and verify that the Use simple

file sharing check box is unchecked, and then click OK.

4 On the Windows taskbar, click Start > Settings > Control Panel > Windows

Firewall.

5 On the Exceptions tab, check File and Printer Sharing, and then click OK.

Note: You should close any open applications before you continue with the agent

installation. If the Reboot check box is selected, the computer will automatically

restart at the end of the installation wizard.

To deploy the Norton Ghost Agent

1 On the Norton Ghost menu bar, click Computers > select a computer from

the menu.

You must have administrator rights on the computer to which you are

installing the agent.

2 Click DeployAgent.

3 In the Deploy Norton Ghost 12.0 Agent dialog box, specify the administrator

user name (or a user name that has administrator rights) and the password.

In a workgroup environment, you must specify the remote computer name.

You cannot use an IP address, even if you have successfully connected to the

computer by using an IP address.

For example, type RemoteComputerName\UserName

4 If you want to restart the computer when the agent installation is finished,

click Rebootwhen finished.

Note: The computer cannot be backed up until the computer is restarted.

However, be sure to warn the user of the impending reboot so that they can

save their work.

5 Click OK.
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To manually install the agent

1 Insert the Norton Ghost 12.0 product CD into the media drive of the computer.

The installation program should start automatically.

2 If the installation program does not start, on the Windows taskbar, click Start

>Run, type the following command, then click OK.

<drive>:\autorun.exe

where <drive> is the drive letter of your media drive.

For Windows Vista, if the Run option is not visible, do the following:

■ Right-click the Start button, and click Properties.

■ On the Start Menu tab, click Customize.

■ Scroll down and check Run command.

■ Click OK.

3 In the CD browser panel, click Install NortonGhost.

4 In the Welcome panel, click Next.

5 Read the license agreement, click Iacceptthetermsinthelicenseagreement,

and then click Next.

6 If you want to change the default location for the program files, clickChange,

locate the folder in which you want to install the agent, and then click OK.

7 Click Next.

8 Click Custom, and then click Next.

9 Click Norton GhostService, and then click This featurewill be installed on

local hard drive.

This feature is the agent.

10 Set all other features to This featurewill not be installed.

11 Click Next, and then click Install.

Using the Norton Ghost 12.0 Agent
The Norton Ghost 12.0 Agent is the unseen “engine” that does the actual backing

up and restoring of data on a remote computer. Because the Norton Ghost 12.0

Agent functions as a service, it does not have a graphical interface.

See “Managing the agent through Windows Services” on page 80.

See “Controlling access to Norton Ghost ” on page 85.
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The Norton Ghost 12.0 Agent does, however, have a tray icon available from the

Windows system tray to provide feedback of current conditions and to perform

common tasks. For example, you can view backup jobs created for the computer,

reconnect the Norton Ghost 12.0 Agent, or cancel a task that is currently running.

You can install the agent manually by visiting each computer you want to protect

and install the agent from the product CD. A more efficient method, however, is

to use the Norton Ghost 12.0Deploy Agent feature to remotely install the agent

on a computer in the domain whose data you want to protect.

To use the Norton Ghost 12.0 Agent

◆ On the Windows system tray, do one of the following:

■ Right-click the Norton Ghost 12.0 tray icon, and then click Reconnect to

restart the service automatically.

You cannot run a backup until the service is running.

■ If Norton Ghost is installed on the computer, double-click the Norton

Ghost tray icon to start the program.

If only the agent is installed, double-clicking the tray icon only displays

an About dialog box.

■ If the computer has Norton Ghost installed, right-click the Norton Ghost

12.0 tray icon to display a menu of common Norton Ghost 12.0 Agent

tasks.

Managing the agent through Windows Services
The Norton Ghost 12.0 Agent is a Windows service that runs in the background.

It provides the following:

■ locally running scheduled backup jobs, even when there are no users, or an

unprivileged user, logged on to the computer

■ Allows administrators to remotely back up computers throughout an enterprise

from Norton Ghost 12.0 running on another computer.

See “Using the Norton Ghost 12.0 Agent ” on page 79.

To use the features of Norton Ghost 12.0, the Norton Ghost 12.0 Agent must be

started and properly configured. You can use the Windows Services tool to manage

and troubleshoot the agent.

Note: To manage the Norton Ghost 12.0 Agent, you must be logged on as a local

administrator.
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You can manage the Norton Ghost 12.0 Agent in the following ways:

■ Start, stop, or disable the Norton Ghost 12.0 Agent on local and remote

computers.

See “Starting or stopping the agent service” on page 82.

■ Configure the user name and password that is used by the Norton Ghost 12.0

Agent.

See “Controlling access to Norton Ghost ” on page 85.

■ Set up recovery actions to take place if the Norton Ghost 12.0 Agent fails to

start.

For example, you can restart the Norton Ghost 12.0 Agent automatically or

restart the computer.

See “Setting up recovery actions when the agent does not start” on page 83.

Best practices for using services
Table 5-1 describes some best practices for using services.

Table 5-1 Best practices for using services

DescriptionBest practice

The Events tab in the Advanced view can help you

to track down the source of a problem,

particularly when it is associated with the Norton

Ghost 12.0 Agent. You should view the most

recent log entries in the Events tab for more

information about the potential causes of the

problem.

Check the Events tab first before using

Services.

The Norton Ghost 12.0 Agent is configured to

start automatically when Norton Ghost starts.

You can view the status information to verify that

the Norton Ghost 12.0 Agent has started. The

Status area in the Task pane displays a Ready

status message when the agent starts.

You can also test that the Norton Ghost 12.0

Agent is starting automatically by looking in

Services. You can check the status and restart the

service if necessary. If the Startup type is set to

automatic, you should restart the agent.

See “Starting or stopping the agent service”

on page 82.

Verify that the Norton Ghost 12.0

Agent starts without user intervention.
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Table 5-1 Best practices for using services (continued)

DescriptionBest practice

Changing the default Norton Ghost 12.0 Agent

properties can prevent Norton Ghost 12.0 from

running correctly. You should use caution when

changing the default Startup type and Log On

settings of the Norton Ghost Agent. It is

configured to start and log on automatically when

you start Norton Ghost 12.0 .

Use caution when changing default

settings for the Norton Ghost 12.0

Agent.

Opening Services

There are several methods you can use to open Services to manage the Norton

Ghost 12.0 Agent.

To open Services

1 Do one of the following:

■ On the Windows Vista taskbar, click Start > Control Panel > Classic View

>Administrative Tools, and then double-click Services.

■ On the Windows taskbar, click Start > Settings > Control Panel >

Administrative Tools > Services.

■ On the Windows XP taskbar, click Start > Control Panel > Performance

andMaintenance>AdministrativeTools, and then double-clickServices.

■ On the Windows taskbar, click Start >Run.

In the Open text field, type services.msc, and then click OK.

2 Under the Name column, scroll through the list of services until you see

Norton Ghost (the name of the agent).

Its status should be Started.

See “Starting or stopping the agent service” on page 82.

Starting or stopping the agent service

To start, stop, or restart the Norton Ghost 12.0 Agent service, you must be logged

on as an administrator. (If your computer is connected to a network, network

policy settings might prevent you from completing these tasks.)

You might need to start, stop, or restart the Norton Ghost 12.0 Agent service for

the following reasons:
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You should start or restart the agent if Norton Ghost 12.0

is unable to connect to the Norton Ghost 12.0 Agent on a

computer, or you cannot reconnect from Norton Ghost.

Start or Restart

You should restart the agent after you change the user name

or password that you use to log on to the Norton Ghost 12.0

Agent service, or you used the Security Configuration Tool

to give additional users the ability to back up computers.

See “Controlling access to Norton Ghost ” on page 85.

Restart

You can stop the agent if you believe it is causing a problem

on the computer, or you want to temporarily free memory

resources.

If you stop the agent, you also prevent all of your drive-based

backups and file and folder backups from running.

Stop

If you stop the Norton Ghost 12.0 Agent service and then start Norton Ghost, the

agent restarts automatically. The Status changes to Ready.

If you stop the Norton Ghost 12.0 Agent service while Norton Ghost is running,

you receive an error message, and Norton Ghost is disconnected from the agent.

In most cases, you can click Reconnect from the Task pane or from the Tray icon

to restart the Norton Ghost 12.0 Agent.

To start or stop the Norton Ghost 12.0 Agent service

1 On the Windows taskbar, click Start > Run.

2 In the Run window, type services.msc

3 Click OK.

4 In the Services window, in the Name column, click NortonGhost.

5 On the Action menu, select one of the following:

■ Start

■ Stop

■ Restart

Setting up recovery actions when the agent does not start

You can specify the computer’s response if the Norton Ghost 12.0 Agent fails to

start.
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To set up recovery actions when the agent fails to start

1 On the Windows taskbar, click Start > Run.

2 In the Run window, type services.msc

3 Click OK.

4 In the Services window, on the Action menu, click Properties.

5 On the Recovery tab, in the First failure, Second failure, and Subsequent

failures lists, select the action that you want:

Specify the number of minutes before an

attempt to restart the service is made.

Restart the Service

Specify a program to run. You should not

specify any programs or scripts that require

user input.

Run a Program

Click Restart Computer Options, and then

specify how long to wait before restarting

the computer. You can also create a message

that you want to display to remote users

before the computer restarts.

Restart the Computer

6 In the Reset fail count after box, specify the number of days that the Norton

Ghost 12.0 Agent must run successfully before the fail count is reset to zero.

When the fail count is reset to zero, the next failure triggers the action set

for the first recovery attempt.

7 Click OK.

Viewing Norton Ghost 12.0 Agent dependencies

The Norton Ghost 12.0 Agent depends on other required services to run properly.

If a system component is stopped or is not running properly, the dependent

services can be affected.

If the Norton Ghost 12.0 Agent fails to start, check the dependencies to ensure

that they are installed and that their Startup type is not set to Disabled.

Note: To view the Startup type setting for each of the interdependent services,

you must select one service at a time and then clickAction>Properties>General.
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The top list box on the Dependencies tab displays services that are required by

the Norton Ghost 12.0 Agent to run properly. The bottom list box does not have

any services that need the Norton Ghost 12.0 Agent to run properly.

Table 5-2 lists the services that are required by the Norton Ghost 12.0 Agent to

run properly, along with their default startup setting.

Table 5-2 Required services

Startup typeService

AutomaticEvent Log

AutomaticPlug and Play

AutomaticRemote Procedure Call (RPC)

To view Norton Ghost 12.0 Agent dependencies

1 In the Services window, under Name, click NortonGhost.

See “Opening Services ” on page 82.

2 On the Action menu, click Properties.

3 Click the Dependencies tab.

Controlling access to Norton Ghost
You can use the Security Configuration Tool to allow or deny users and groups

the necessary permissions to access the Norton Ghost 12.0 Agent , or to the full

Norton Ghost user interface.

When you use the Security Configuration Tool, any permission that you grant to

the Users group applies to the members within that group.

Note: The agent service can only be run as LocalSystem or by a user who belongs

to the Adminstrator's group.

Table 5-3 describes the permissions that can be allowed or denied for user and

groups who use the Norton Ghost 12.0 Agent.
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Table 5-3 Permission options

DescriptionOption

Gives users or groups complete access to all

Norton Ghost 12.0 functionality as if they are the

administrator. If you do not want users to define,

change, or delete backups, or to manage recovery

point storage, do not give them Full Control.

Full Control

Users or groups can get status information, and

can run a backup job. But they cannot define,

change, or delete any backup jobs, or use any

other function of the product.

Status Only

Users cannot perform any function, or see any

information. They are blocked from any access

to Norton Ghost.

Deny

A deny setting takes precedence over an inherited allow setting. For example, a

user who is a member of two groups is denied permissions if the settings for one

of the groups denies permissions. User-denied permissions override group-allow

permissions.

To add users and groups

1 On the Windows taskbar, click Start >Programs>Symantec>NortonGhost

> Security Configuration Tool.

2 Click Add.

3 In the Select Users or Groups dialog box, click Advanced.

4 If necessary, click Object Types to select the types of objects that you want.

5 If necessary, click Locations to select the location that you want to search.

6 Click FindNow, select users and groups you want, and then click OK.

7 Click OKwhen you are finished.

To change permissions for a user or a group

1 On the Windows taskbar, click Start >Programs>Symantec>NortonGhost

> Security Configuration Tool.

2 In the Permissions for Norton Ghost 12.0 dialog box, select the user or group

whose permissions you want to change, and then do one of the following:

■ To set Full Control permissions, click Allow or Deny for the selected user

or group.
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■ To set Status Only permissions, click Allow or Deny for the selected user

or group.

3 Click OKwhen you are finished.

To remove a user or group

1 On the Windows Start menu, click Programs > Symantec >NortonGhost >

Security Configuration Tool.

2 Select the user or group that you want to remove, and then click Remove.

3 Click OKwhen you are finished.

Running Norton Ghost using different user rights

If the permissions for a user are insufficient for running Norton Ghost, you can

use the Run As feature in Windows to run the product using an account that has

sufficient rights, even if you are not currently logged in with the account.

To perform Run As from Windows XP/2003

1 On the Windows taskbar, click Start > ProgramFiles > Symantec >Norton

Ghost.

2 Right-click NortonGhost, and then click .

3 Click The following user to log onto with another account.

4 In the User Name and Password boxes, type the account name and password

that you want to use.

5 Click OK.

To perform Run As from Windows 2000 Professional

1 On the Windows taskbar, click Start > ProgramFiles > Symantec >Norton

Ghost.

2 Press Shift and right-click .

3 Click RunAs.

4 Click Run theprogramas the followinguser to log on with another account.

5 Do one of the following:

■ In the User name, Password, and Domain boxes, type the account name,

password, and the domain that you want to use.

■ If you want to use the Administrator account on the computer, in the

Domain box, type the name of the computer.
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If you want to run Norton Ghost as a domain administrator, in the Domain

box, type the name of the domain.

6 Click OK.

To perform Run As from Windows Vista

1 On the Windows taskbar, click Start>AllPrograms>NortonGhost>Norton

Ghost.

2 Click Yes when prompted to add the required privileges.

3 Enter the password for an administrator account, and then click OK.
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Monitoring the status of

your backups

This chapter includes the following topics:

■ About monitoring backups

■ Monitoring backup protection from the Home page

■ Monitoring backup protection from the Status page

■ Customize status reporting

■ Viewing drive details

■ Improving the protection level of a drive

About monitoring backups
You should monitor your backups to ensure that you can effectively recover lost

data when you need it.

The Home page provides a general status of your backup protection. The Status

page provides details about which drives are protected, as well as a calendar view

of past and future backups.

Note: In addition to ensuring that you back up each drive, carefully review and

follow best practices for backing up your computer.
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Monitoring backup protection from the Home page
On the Home page, the Backup Status pane provides a summary of the backup

protection status of your computer. For example, if one or more drives are not

included in a defined backup, the background color and status icon changes to

reflect the level of backup protection. The Status Details pane provides

recommendations on which actions you should take.

Table 6-1 describes each of the levels of backup protection that the Home page

displays.

Table 6-1 Backup protection levels

At least one drive-based backup is defined. It

includes all fixed drives and runs on a regular

basis.

This status indicates that all drives, files, and

folders can be fully recovered, if necessary.

Backed up

A backup is defined, but it is not scheduled or

run for a long time. This status can indicate

that the existing recovery points are outdated.

It can also indicate that one or more drives

are not assigned to a defined backup.

A partially protected drive can be recovered,

but if the recovery points are outdated, it

might not contain the latest versions of your

data.

Partially backed up

No defined backup exists and no recovery

points are available from which to recover the

drive.

An unprotected drive cannot be recovered

and is at risk.

At risk

The status is being calculated, or you have

not yet licensed your product.

Either wait a few seconds for the status to

display, or make sure that you have licensed

your copy of the product.

Status unknown
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Table 6-1 Backup protection levels (continued)

The drive that displays this icon is not being

monitored for backup status; or it is being

monitored for errors only, but there are no

errors to report.

Use the Customize status reporting feature

on the Status page to change the status report

setting.

No backup protection

assigned

Monitoring backup protection from the Status page
The Status page lets you monitor the status of your backups. The Status page lists

each drive on your computer and includes a calendar that contains your backup

histories. The calendar lets you quickly identify when a backup ran, and what

type of backup it was. It identifies your upcoming, scheduled backups. It also lists

the file and folder backup history if you have defined one or more file and folder

backups.

Note:You can right-click on any of the calendar icons to access a context-sensitive

menu. These menus offer quick access to related tasks.

Refer to the following table for the meaning of each icon displayed in the Backups

calendar.
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Table 6-2 Backups calendar icons

Icon statesDescriptionIcon

This icon can appear in the following states:

Indicates that the backup ran and that an

independent recovery point was created.

Indicates that the backup is unavailable.

Indicates that the backup did not run as scheduled.

This problem could occur if an error prevents the

backup from running or if you manually cancel a

backup before it completes.

Indicates a drive-based backup scheduled to run at

a future time.

Represents a drive-based backup that

is configured to create a single,

independent recovery point. When this

icon appears in the Backup timeline, it

indicates that a drive-based backup is

scheduled to occur.

This icon can appear in the following states:

Indicates that the backup ran and that an

incremental recovery point was created.

Indicates that the backup is unavailable.

Indicates that the backup did not run as scheduled.

This problem could occur if an error prevents the

backup from running or if you manually cancel a

backup before it completes.

Indicates that the backup is scheduled to run at a

future time.

Represents a drive-based backup that

is configured to create incremental

recovery points. It indicates that a

drive-based backup is scheduled to

occur on the day that it appears in the

backup timeline.
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Table 6-2 Backups calendar icons (continued)

Icon statesDescriptionIcon

This icon can appear in the following states:

Indicates that the backup ran and that file and folder

backup data was created successfully.

Indicates that the backup is not available.

Indicates that the backup did not run as scheduled.

This problem could occur if an error prevents the

backup from running, or if you manually canceled a

backup before it completed.

Indicates that the backup is scheduled to run at a

future time.

Represents a file and folder backup. It

indicates that a file and folder backup

is scheduled to occur on the day that it

appears in the backup timeline.

This icon can appear in the following states:

Indicates that two or more backups have run and the

last backup was created successfully.

Indicates that two or more backups are scheduled

and that at least one is unavailable.

Indicates that two or more backups have and adn the

last one did not succeed. This problem could occur

if an error prevents a backup from running.

Indicates that the backup is scheduled to run at a

future time.

Represents two or more backups are

scheduled to run on the day on which

this icon appears.
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To monitor backup protection from the Status page

1 On the Status page, review the Backups calendar and verify that the backup

appears on the date that you ran it.

2 In the Drives column, select the drive that you want to view.

The status information appears in the bottom half of the Status page.

3 Move your mouse over a backup icon in the calendar to review the status of

the backup.

4 To move around in the calendar, use one of the following methods:

■ Click anywhere in the title bar to navigate quickly to a different point in

time.

■ Use the scroll bar at the bottom of the calendar to scroll backward or

forward in time.

Customize status reporting
You can configure how Norton Ghost reports the status of a particular drive (or

all file and folder backups).

For example, if drive D contains unimportant data and you have chosen not to

include it in a drive-based backup, the status on the Home page continues to report

that your computer is at risk. You can configure Norton Ghost to ignore drive D

so that it does not calculate the status of drive D in the Backup Status panel on

the Home page.

Or, you can specify that only errors, such as missed or failed backups, are to be

figured in to the status report.

Note:The backup status of each drive is reported throughout the product, wherever

the drive is listed. When you customize status reporting for a drive, the status is

reflected anywhere that the drive is listed in Norton Ghost.

You should first determine how important the data is on a particular drive (or the

data you have included in a file and folder backup) before deciding on the level of

status reporting to assign to it.

To customize the status reporting of a drive (or file and folder backups)

1 On the Status page, click a drive (or File and folders) to select it.

2 Click Customize status reporting.
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3 Select one of the following options:

Shows the current status of the selected

drive or file and folder backups on the

Home and Status pages.

Select this option if the data is critical.

Full status reporting

Shows the current status of the selected

drive or file and folder backups only when

errors occur.

Select this option if the data is important,

but you only want the status to report

errors, whenever they occur.

Errors only status reporting

Does not show any status for the selected

drive or file and folder backups.

Select this option if the data is

unimportant and missed or failed backups

do not need to be reported.

No status reporting

4 Click OK.

Viewing drive details
The Advanced page lets you view details about your hard drives.

You can view the following drive details:

Displays the name that you assigned to the backup when you defined

it.

Name

Identifies the type of recovery point the backup creates when it runs.Type

Identifies the storage location of the recovery point, or the location

in which the drive should be backed up.

Destination

Displays the day and time when the backup was last run.Last Run

Displays the day and time of the next scheduled backup.Next Run
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To view drive details

1 On the Advanced page, on the Content Bar, click the Drives tab.

If the Advanced page is not visible on the Primary Navigation Bar, click View

> ShowAdvanced Page.

2 In the Drive column, select a drive.

3 Review the Details section below the Drives table.

Improving the protection level of a drive
When the status of a drive-based backup indicates that it needs attention, you

should take steps to improve the status.

You might need to add a drive to an existing backup, modify the schedule of a

backup, edit the settings of a backup, or define a new backup.

See “Best practices for backing up ” on page 37.
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To improve the protection level of a drive

1 On the Status page, select a drive that requires attention from the Drives

column.

2 In the Status section at the bottom of the page, right-click the backup you

want to modify, and then select one of the following menu items:

Runs the selected backup job immediately.Run Backup Now

Opens the Run When dialog so that you can edit the

backup schedule.

Change Schedule

Opens the Define Backup Wizard, which lets you

modify the backup definition.

This option takes you to the second page of the wizard.

Edit Settings

Opens the Define Backup Wizard from the beginning,

which lets you define a new backup.

This option is useful if a drive in the Drives column is

not yet assigned to a backup. By selecting a drive that

is assigned to an existing backup, you have access to

this short-cut method for starting the Define Backup

Wizard from the Status page.

Define New Backup

Deletes the backup that you have selected.

When you delete a backup, only the backup definition

is deleted. The backup data is not deleted (for example,

the recovery points or the file and folder backup data).

Remove Backup Job

Turns on or turns off the backup that you have

selected.

Disable (Enable) Backup

See “Editing backup settings” on page 70.
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Exploring the contents of a

recovery point

This chapter includes the following topics:

■ About exploring recovery points

■ Exploring a recovery point through Windows Explorer

■ Opening files within a recovery point

■ Using a search engine

■ Unmounting a recovery point drive

■ Viewing the drive properties of a recovery point

About exploring recovery points
You can use Norton Ghost to explore files in a recovery point by assigning it a

drive letter that is visible from Windows Explorer.

You can perform the following tasks on the assigned drive:

■ Run ScanDisk (or CHKDSK)

■ Perform a virus check

■ Copy folders or files to an alternate location

■ View disk information about the drive such as used space and free space

■ You can also run simple, executable programs that exist within the mounted

recovery point.
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You can only run programs from within a mapped recovery point that do not

rely on registry values, COM interfaces, dynamic link libraries (DLLs), or other

similar dependencies.

You can set up a mounted drive as a shared drive. Users on a network can connect

to the shared drive and restore files and folders from the recovery point.

You can mount one or more recovery points at a time. The drives remain mounted

until you unmount them, or you restart the computer. Mounted drives do not take

up extra hard-disk space.

All security on the NTFS volumes remains intact when they are mounted.

You do not need to mount a drive to restore the files or folders within a recovery

point.

Note: Any data that is written to a mounted recovery point is lost when the

recovery point is unmounted. This data includes any data that is being created,

edited, or deleted at the time.

Exploring a recovery point through Windows Explorer

Unmounting a recovery point drive

Viewing the drive properties of a recovery point

Exploring a recovery point throughWindowsExplorer
When you explore a recovery point, Norton Ghost mounts the recovery point as

a drive letter and opens it in Windows Explorer.

For each drive that is included in the recovery point, a new mounted drive letter

is created. For example, if your recovery point contains backups of drives C and

D, two newly mounted drives appear (for example, E and F). The mounted drives

include the original drive labels of the drives that were backed up.

To explore a recovery point through Windows Explorer

1 On the Tools page, click Manage BackupDestination.

2 Select the recovery point or recovery point set that you want to explore, and

then click Explore.

3 If you select a recovery point set that contains more than one recovery point,

in the Range list, select a recovery point, and then click OK.
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Mounting a recovery point from Windows Explorer

You can also manually mount a recovery point as a drive by opening your backup

destination folder in Windows Explorer.

You can use Windows Explorer to search the contents of the recovery point. For

example, if you cannot remember where a particular file was originally stored,

you can use the Explorer search feature to locate the file, just as you would locate

a file on your hard drive.

To mount a recovery point from Windows Explorer

1 In Windows Explorer, navigate to a recovery point.

The recovery point is located in the storage location that you selected when

you defined your backup.

2 Right-click the recovery point, and then click Mount.

3 In the Mount Recovery Point window, under the Drive Label column,select

the drive that you want to mount.

4 In the Drive letter drop-down list, select the letter that you want to associate

with the drive.

5 Click OK.

6 To mount additional drives, repeat steps 1-5.

Opening files within a recovery point
Using the Recovery Point Browser, you can open files within a recovery point.

The file opens in the program that is associated with that file type. You can also

restore files either by saving them using the application associated with them, or

by using the Recover Files button in the Recovery Point Browser.

If the file type is not associated with a program, the Microsoft Open With dialog

box is displayed. You can then select the correct program for opening the file.

Note: You cannot view encrypting file system (EFS) NTFS volumes.

To browse and open files inside of a recovery point

1 On the Tools page, click RunRecovery Point Browser.

2 Navigate to your backup destination folder, select the recovery point file that

you want to browse, and then click Open.

3 In the Recovery Point Browser, in the tree panel on the left, select a drive.
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4 In the right content panel, double-click the folder that contains the file that

you want to view.

5 Right-click the file that you want to view, and then click ViewFile.

The View option is unavailable if you select a program file that has a .exe,

.dll, or .com file extension.

To restore one or more files

1 On the Tools page, click RunRecovery Point Browser.

2 Navigate to your backup destination folder, select the recovery point file you

want to browse, and then click Open.

3 In the Recovery Point Browser, select a drive in the tree panel (on the left).

4 In the content panel (on the right), double-click a folder that contains the file

you want to view.

5 Do one of the following:

■ Right-click the file you want to view and click ViewFile.

The View option is dimmed (unavailable) if you selected a program file

that has a .exe, .dll, or .com file extension.

■ Select one or more files, click Recover Files, and then click Recover to

restore them to their original location.

If prompted, click Yes or Yes toAll to overwrite the existing (original)

files.

Using a search engine
If you have a desktop search engine, such as Google Desktop, you can configure

your backups to create recovery points that are searchable.

Note: If your organization uses Symantec Backup Exec Web Retrieve, it is likely

that your network administrator has already enabled this feature.

You can configure your backups to support one of these search engines. Be sure

to check the Enable search engine support at the time you define the backup.

See “To define a drive-based backup” on page 46..

See “About using a search engine to search recovery points” on page 155..
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Unmounting a recovery point drive
All of your mounted recovery point drives are unmounted when you restart the

computer. You can also unmount the drives without restarting the computer.

To dismount a recovery point in Windows Explorer

1 In Windows Explorer, navigate to the mounted recovery point.

2 Right-click the drive, and then click DismountRecovery Point.

To dismount a recovery point in Recovery Point Browser

1 In the Recovery Point Browser, in the tree view, locate the mounted recovery

point.

2 Right-click the mounted recovery point, and then click DismountRecovery

Point.

Viewing the drive properties of a recovery point
You can view the following drive properties of a recovery point:

A user-assigned comment that is associated with the recovery

point.

Description

The original drive letter that was assigned to the drive.Original drive letter

The cluster size (in bytes) of the FAT, FAT32, or NTFS drive.Cluster size

The file system type used within the drive. For example, FAT,

FAT32, or NTFS.

File system

The selected drive's status as either a primary partition or a

logical partition.

Primary/Logical

The total size (in megabytes) of the drive. This total includes used

space and unused space.

Size

The amount of used space (in megabytes) within the drive.Used space

The amount of unused space (in megabytes) within the drive.Unused space

Indicates if there are any bad sectors on the drive.Contains bad sectors
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To view the drive properties of a recovery point

1 In the Recovery Point Browser, in the tree panel, click the recovery point that

contains the drive that you want to view.

2 Select a drive.

3 Do one of the following:

■ On the File menu, click Properties.

■ Right-click the recovery point, and then click Properties.
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Managing backup

destinations

This chapter includes the following topics:

■ About backup destinations

■ How backup data works

■ Managing recovery points

■ Converting a recovery point to a virtual disk format

■ Managing file and folder backup data

■ Automating management of backup data

■ Moving your backup destination

About backup destinations
A backup destination is the location in which your backup data is stored.

Norton Ghost includes features for managing the size of your backup destinations

so that you can use your computer's valuable disk space for other purposes.

How backup data works
Norton Ghost offers two backup methods:

Use this option to back up an entire drive (for example, your system

drive, which is typically C). You can then restore any file, folder, or

your entire drive.

Drive-based

backup
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Use this option to back up only the files and folders that you select.

You can then restore any file or all of them at any time.

This option typically requires less disk space than drive-based backups.

File and folder

backup

About drive-based backups

When you run a drive-based backup, a snapshot is taken of everything that is

stored on your computer's hard disk. Each snapshot is stored on your computer

as a recovery point. A recovery point is a point in time that is used to restore your

computer back to the way it was when the recovery point was created.

The types of recovery points are as follows:

Creates a complete, independent copy of the drives that you select.

This backup type typically requires more storage space.

Independent

recovery point

(.v2i)

Includes a base recovery point. A base recovery point is a complete

copy of your entire drive, and is similar to an independent recovery

point. The recovery point set also includes recovery points that capture

only the changes that are made to your computer since the creation

of the base recovery point.

Recovery point set

(.iv2i)

Although you can recover files and folders from a drive-based backup, you cannot

select a specific set of files or folders to back up. Your entire hard drive is backed

up.

About file and folder backups

If you want to modify or create a select set of personal documents and folders and

you don't want to use hard disk resources to back up your entire computer, you

can define a file and folder backup. Or, you might want to define a file and folder

backup to capture one or more folders that contain the files that you modify on

a regular basis.

File and folder backups let you select individual files or folders to back up. You

can also specify a file type to back up and let Norton Ghost locate and back up all

files of the type you specified. For example, if you have Microsoft Word documents

stored at several locations on your computer, Norton Ghost locates all Word

documents (files ending with .doc) and includes them in your backup. You can

even modify the list of file types to include types unique to the software you are

using.

Norton Ghost also keeps multiple versions of the same files for you, so that you

can restore the version of a file containing the changes you need to restore. You
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can even set a limit to the number of versions kept so that you can control the

use of disk space.

Managing recovery points
Norton Ghost includes several features that help you manage your backup data.

The key is to prevent backup data from taking up too much hard disk space on

your computer while providing adequate backup protection in the event that you

need to recover your computer, files, or folders.

To manage recovery point storage manually

1 On the Tools page, click Manage BackupDestination.

2 From the Manage Backup Destination window, you can do any of the following

tasks:

See “Cleaning up old recovery points” on page 107.Clean Up

See “Deleting a recovery point set” on page 108.

See “Deleting recovery points within a set” on page 108.

Delete

See “About exploring recovery points ” on page 99.Explore

See “Making copies of recovery points ” on page 109.Copy

See “Moving your backup destination” on page 116.Move

See “Automating management of backup data” on page 115.Settings

Cleaning up old recovery points

Over time, you might end up with recovery points that you no longer need. For

example, you might have several recovery points created months ago that you no

longer need because you have more current ones containing your latest work.

See “Automating management of backup data” on page 115.

The Clean Up feature deletes all but the most current recovery point set, to help

make more space available on your hard disk.

Note: After a recovery point is deleted, you no longer have access to the files or

system recovery from that point in time. You should explore the contents of the

recovery point before you delete it.
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See “Opening files within a recovery point” on page 101.

See “About exploring recovery points ” on page 99.

To clean up old recovery points

1 On the Tools page, click Manage BackupDestination.

2 Click CleanUp.

The recovery point sets that can be safely removed without eliminating your

latest recovery point are selected automatically. You can check or uncheck

the recovery point sets to specify which ones to remove.

3 Click Delete.

4 Click Yes to confirm the deletion.

5 Click OK.

Deleting a recovery point set

If you know that you no longer want a particular recovery point set, you can delete

it at any time.

Note: Once you delete a recovery point, you no longer have access to file or system

recovery for that point in time.

To delete a recovery point set

1 On the Tools page, click Manage BackupDestination.

2 Select the recovery point set that you want to delete, and then click Delete.

3 Click Yes to confirm the deletion.

4 Click OK.

Deleting recovery points within a set

A recovery point set can contain multiple recovery points created over time that

you can delete to reclaim storage space.

The Delete Points option lets you delete all of the recovery points created between

the first recovery point and last recovery point in the set.
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Warning: Be careful about which recovery points you choose to delete. You could

inadvertently lose data. For example, you create a new document, which is captured

in the third recovery point in a recovery point set. You then accidentally delete

the file, which is captured by the fourth recovery point. If you delete the third

recovery point, you permanently lose the version of the file that was backed up.

If you are unsure, you should explore the contents of a recovery point before you

delete it.

See “Opening files within a recovery point” on page 101.

You can manually select which recovery points to remove, if you know which

recovery points that you want to keep within a set.

To delete recovery points within a set

1 On the Tools page, click Manage BackupDestination.

2 Select the recovery point set that you want to delete, and then click Delete.

3 Do one of the following:

■ To automatically delete all but the first and last recovery point in the set,

click Automatic.

■ To manually select which recovery points in the set to delete, clickManual,

and then select the recovery points you want to delete.

■ To delete all the recovery points in the set you selected, click Delete all

recovery points in the set.

4 Click OK.

Making copies of recovery points

You can copy recovery points to another location for added security. For example,

you can copy them to another hard disk, another computer on a network, or on

removable media such as DVDs or CDs. You can then store these copies in a

protected location.

You can also create archive copies of your recovery points to free up disk space.

For example, you can copy recovery points to a CD or DVD, and then manually

delete the original recovery points. You should verify the copies of the recovery

points to ensure that they are on the disk and are valid.

To make copies of recovery points

1 On the Tools page, click Manage BackupDestination.

2 Select a recovery point set or an independent recovery point, and then click

Copy.
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3 Select which recovery point to copy, and then click OK.

4 On the Welcome page of the Copy Recovery Point Wizard, click Next.

5 Select the recovery point that you want to copy.

Recovery point sets appear as single recovery points. CheckViewallrecovery

points to display all incremental recovery points that are included within

the recovery point sets.

6 Click Next.

7 Do one of the following:

■ In the Folder box, type the path to which you want to copy the recovery

point.

■ Click Browse to locate the folder to which you want to copy the recovery

point, and then click OK.

8 Select a level of compression for the copies of the recovery points.

See “About setting a compression level for drive-based backups” on page 65.

9 If you want to verify whether a recovery point is valid once the copy is

complete, check Verify recovery point after creation.

10 Click Advanced, and then select from the following options:

■ Divide into smaller files to simplify archiving

■ Use password

See “Setting advanced options for drive-based backups” on page 66.

11 Click OK.

12 Click Next, review the options that you selected, and then click Finish.

Once the recovery points are safely copied, you can delete them from your

computer.

See “Deleting a recovery point set” on page 108.

Converting a recovery point to a virtual disk format
You can use Norton Ghost 12.0 to convert recovery points of a physical computer

to a VMWare Virtual Disk (.vmdk) or a Microsoft Virtual Disk (.vhd).

Virtual disks created from recovery points are supported by the following

platforms:

■ VMware GSX Server 3.1 and 3.2

■ VMware Server 1.0
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■ VMware ESX Server 2.5 and 3.0

■ VMware Infrastructure 3

■ Microsoft Virtual Server 2005 R2

To convert a recovery point to virtual disk format

1 On the Tools page, click Convert to Virtual Disk, and then click Next.

2 Select the recovery point that you want to convert, and then click Next.

3 If you don't see the recovery point that you want to use, do one of the

following:

■ Click View all recovery points, and then select a recovery point.

■ Click Viewby, and then select one of the following alternatives:

Lets you browse to another location, for example, an external

(USB) drive or removable media to select a recovery point

(.v2i) file.

Select this option, and then do the following:

■ Click Browse, locate and select a recovery point (.v2i file),

and then click Open.

■ If you select a network location, type your network

credentials.

See “About network credentials” on page 53.

■ Click Next.

Filename

Displays a list of all of the drives on your computer and shows

any associated recovery points. You can also select a system

index file (.sv2i).

Select this option, and then do the following:

■ Click Browse, locate and select a recovery point (.sv2i),

and then click Open.

■ If you select a network location, type your network

credentials.

See “About network credentials” on page 53.

■ Click Next.

System

4 Click Virtual disk format, and then select a format.

5 Do one of the following:

■ In the folder in which you want to place the virtual disk image, type the

path.
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■ Click Browse to locate the folder in which you want to place the virtual

disk image.

6 If you select a network location, type your network credentials.

See “About network credentials” on page 53.

7 Click Next.

8 If you select Microsoft Virtual Disk (.vhd) as your virtual disk format, skip

the next step.

9 If you select VMware Virtual Disk (.vmdk), do one of the following options:

■ Check Split into 2GB files if you want to divide the virtual disk file into

smaller files.

For example, you can use this option if you need to copy the virtual disk

to a FAT 32 drive, or if you want to copy the virtual disk files to a DVD but

the size is larger than the DVD allows.

■ Check Store on ESX Server if you want to store the virtual disk file on a

VMware ESX Server, and then provide the following information:

Type the name of the server

or the server's IP address.

Server name or address

Type a valid administrator

name that has sufficient

rights.

Note: The virtual disk files

are transferred to an ESX

Server through a secure

shell (SSH) and secure file

transfer protocol (SFTP).

You might need to change

the settings on the ESX

Server. For more

information, see your ESX

server documentation.

User name

Type a valid password.Password

Type the path to the folder

to which the virtual disk

files should be written.

Upload location
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Type the path to the folder

from which you want to

import the virtual disk files.

Note: The folder that you

select must be different than

the upload location folder.

Import location

Check this option if you

want the temporary files to

be removed once the virtual

disk is created.

Remove intermediate files

10 Click Next, and then review the summary of the choices you made.

If you need to make any changes, click Back.

11 Click Finish.

Managing file and folder backup data
Because drive-based backups capture your entire hard drive, the size of a recovery

point is typically much larger than the data that is captured during the file and

folder backups. However, file and folder backup data can take up significant disk

space if it is not managed. For example, audio files, video files, and photographs

are typically large files.

You must decide how many versions of backup files that you want to keep. This

decision can depend on how frequently you change the content of your files and

how frequently you run the backups.

Viewing how much file and folder backup data is being stored

Start by viewing the total amount of file and folder backup data you are currently

storing.

To view how much file and folder backup data is being stored

1 On the Tools page, click Manage BackupDestination.

2 To select an alternate backup destination, in the Drives drop-down list, select

another drive to use as a backup destination.

3 Near the bottom of the Manage Backup Destination window, view the Space

used for file and folder storage box to see how much storage space is currently

used.
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Limiting the number of file versions to keep

You can manage your file and folder backup data by limiting the number of

versions of backup files that you keep. This can significantly reduce the amount

of disk space required, especially if the files are large, as is often the case with

audio and video files.

To limit the number of file versions to keep

1 On the Tools page, click Manage BackupDestination.

2 Click Settings.

3 CheckLimit fileversionsforfileandfolderbackups, and then type a number

between 1 and 99.

4 You can also check Monitor disk space usage for backup storage, and then

specify a limit to the total amount of disk space that can be used for both

recovery points and file and folder backup data.

See “Automating management of backup data” on page 115.

5 Click OK.

Manually deleting files from your file and folder backup

You can manually delete files that are stored in your backup destination.

To manually delete files from your file and folder backup

1 On the Home or Tasks page, click RecoverMyFiles.

2 Do one of the following:

■ In the Find files to recover box, type the file name of the file that you want

to delete, and then click Search.

■ If you don't know the name of the file, click Search to return a list of all

of the files that have been backed up, and then browse for the file.

3 Click ViewAll Versions to display all versions of each file that exist in the

file and folder backup data.

4 Select one or more files that you want to delete.

5 Right-click, and then click Delete.

Finding versions of a file or folder

You can use Windows Explorer to view information about the available versions

that are included in a file and folder backup.
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You can specify a limit to the number of versions of each file or folder stored in

file and folder backup data.

See “Limiting the number of file versions to keep” on page 114.

To find versions of a file or folder

1 Open Windows Explorer.

2 Navigate to a file that you know is included in a file and folder backup.

3 Right-click the file, and then click ShowVersions.

Automating management of backup data
Norton Ghost can monitor your backup storage space and notify you when it is

getting full. It can also automatically delete old recovery points and older versions

of files from file and folder backups that exceed the threshold. If you do not specify

a threshold, Norton Ghost notifies you when the disk reaches 90percent of its

total capacity.

To automate management of backup data

1 On the Tools page, click Manage BackupDestination.

2 CheckLimit fileversionsforfileandfolderbackups, and then type a number

between 1 and 99.

3 CheckMonitordiskspaceusage forbackupstorage, and then drag the slider

to limit the total amount of disk space that can be used for your recovery

points and your file and folder backup data.

4 Do one of the following:

■ CheckWarnmewhenbackupstorageexceeds threshold if you only want

to be notified when the storage size is exceeded, but you do not want any

action to be taken.

■ Check Automatically optimize storage if you want Norton Ghost to

manage the backup data automatically, without prompting you.

If you select this option, Norton Ghost automatically deletes the old

recovery points and limits file versions to remain within the threshold

that you set.

5 Check Delay changes until next backup if you do not want your changes

applied until the next backup runs.

6 Click OK.
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Moving your backup destination
You can change the backup destination for your recovery points and move your

existing recovery points to a new location. For example, suppose you install a new

external hard drive for storing your backup data. You could then change the

backup destination for one or more backups to the new drive.

When you select a new location, you can also choose to move the existing recovery

points to the new destination. All future recovery points for the backups that you

select are created at the new location.

Note: If you want to move your backup destination to a new internal or external

hard drive, make sure the drive is properly installed or connected before you

proceed.

To move your backup destination

1 On the Tools page, click Manage BackupDestination.

2 In the Manage Backup Destination window, in the Drives drop-down list,

select the drive that contains the backup destination that you want to move.

3 Click Move.

4 In the Move Backup Destination dialog box, do one of the following:

■ In the New backup destination box, type the path to the new backup

destination.

■ ClickBrowse to locate and select a new backup destination, and then click

OK.

5 Select the defined backups that should use the new backup destination.

Deselect the defined backups that you do not want to move.

6 Check Saveasdefault backupdestination if you want to use this destination

as the default backup destination for any new backups that you define in the

future.

7 Click OK.

8 To move existing recovery points to the new backup destination, check Move

recovery points, and then do one of the following:

■ Check Move the latest recovery points for each backup and delete the

rest.

■ Check Move all recovery points to the newdestination.
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9 If you have file and folder backup data that you want to move to the new

backup destination, click Move file backup data.

The Move File Backup Data option is not available no file and folder backup

data is found at the original backup destination.

10 Click OK.
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Recovering files, folders, or

entire drives

This chapter includes the following topics:

■ About recovering lost data

■ Recovering files and folders by using file and folder backup data

■ Recovering files and folders by using a recovery point

■ Recovering a secondary drive

■ About LightsOut Restore

About recovering lost data
Norton Ghost can restore lost files, folders, or entire drives by using recovery

points or file and folder backup data.

You must have either a recovery point or file and folder backup data to recover

lost files and folders. You must have a recovery point to recover an entire drive.

To recover recent changes that were made to a lost file or folder, your backup

data must be at least as current as the changes that were made to the lost file or

folder.

Recovering files and folders by using file and folder
backup data

If you defined a file and folder backup and need to recover files, you can recover

them from a recent file and folder backup.
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Norton Ghost includes a search tool to help you locate the files that you want to

recover.

To recover files and folders by using file and folder backup data

1 On the Home or Tasks page, click RecoverMyFiles.

2 In the left pane of the Recover My Files window, select File andFolder as the

search method.

3 Do one of the following:

■ In the Find files to recover search box, type the whole name or partial

name of a file or folder that you want to restore, and then click Search.

For example, type recipe to return any file or folder that includes the word

recipe in its name, for example My Recipes.doc, Recipes.xls, Recipes for

Success.mp3, and so forth.

■ Click Advanced Search, type your search criteria, and then click Search.

To return to the standard search text box, click Basic search.

4 In the search results list box, select the files that you want to restore by using

one of the following methods:

Click the file once.To select a single file

Press Ctrl+A.To select all files

Click the top file, press and holdShift, and

then click the last file in the group.

To select a group of files that are next to

each other

Press and hold Ctrl while you select the

files that you want.

To select a group of files that are not next

to each other

5 Click Recover Files.

6 In the Recover My Files dialog box, do one of the following:

■ Click Original folders to restore your files to the same folder where they

existed when they were backed up.

If you want to replace the original files, check Overwrite existing files. If

you do not check this option, a number is added to the file name The

original file is untouched.

Caution: The Overwrite existing files option replaces your original files

(or the files of the same names that are currently stored at that location)

with the files that you are restoring.
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■ Click Recovered Files folder on the desktop to restore your files to a

Recovered Files folder on your Windows desktop.

Norton Ghost creates this folder during the restore.

■ ClickAlternatefolder and type the path to the location in which you want

to restore your files.

7 Click Recover.

8 If you are prompted to replace the existing file, click Yes if you are certain

that the file that you are recovering is the file that you want.

9 Click OK.

Recovering files and folders by using a recovery point
You can also restore files or folders using recovery points, provided you have

defined and run a drive-based backup.

To restore files and folders using a recovery point

1 On the Home or Tasks page, click RecoverMyFiles

2 In the left pane of the Recover My Files window, select Recovery Point as

the search method.

3 If you want to use a different recovery point than the one selected for you in

the Recovery Point box, click Change.

Note: If Norton Ghost cannot locate any recovery points, the Select Recovery

Point dialog box opens automatically.

In the Select Recovery Point dialog box, click Viewby and select one of the

following options:

Displays all of the discovered recovery points in the order in

which they were created.

If no recovery points were discovered, the table will appear empty.

You should then choose one of the remaining View by options.

Date
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Lets you browse to another location, for example, an external

(USB) drive or removable media to select a recovery point (.v2i)

file.

Select this option, and then do the following:

■ ClickBrowse, locate and select a recovery point (.v2i file), and

then click Open.

■ If you select a network location, type your network

credentials.

See “About network credentials” on page 53.

■ Click Finish.

Filename

Displays a list of all of the drives on your computer and shows

any associated recovery points. You can also select a system index

file (.sv2i).

Select this option, and then do the following:

■ Click Browse, locate and select a recovery point (.sv2i), and

then click Open.

■ If you select a network location, type your network

credentials.

See “About network credentials” on page 53.

■ Check each recovery point that you want to recover.

If necessary, add, change, or remove recovery points from

the list.

■ Click Finish.

System

4 In the Find files to recover box, type the whole name or partial name of a file

or folder that you want to restore, and then click Search.

For example, type recipe to return any file or folder that includes the word

recipe in its name, such as My Recipes.doc, Recipes.xls, Recipes for

Success.mp3, and so forth.

5 In the Files to restore list, select the files that you want to restore by using

one of the following methods:

Click the file once.To select a single file

Press Ctrl+A.To select all files

Click the top file, press and holdShift, and

then click the last file in the group.

To select a group of files that are next to

each other

Press and hold Ctrl while you select the

files that you want.

To select a group of files that are not next

to each other
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6 Click Recover Files.

7 In the Recover My Files dialog box, do one of the following:

■ Click Original folders to have your files restored in the original folder

where they existed when they were backed up.

If you want to replace the original files, check Overwrite existing files. If

you do not check this option, a number is added to the filename, leaving

the original file untouched.

Caution: Checking Overwrite existing files replaces your original files (or

the files of the same names that are currently stored at that location) with

the files you are restoring.

■ Click Recovered Files folder on the desktop to have your files restored

to a new folder that is created on your Windows desktop called Recovered

Files.

■ ClickAlternate folder and specify the path to an alternate location where

you want your files restored.

8 Click Recover.

9 If you are prompted to replace the existing file, click Yes if you are certain

that the file that you are recovering is the file that you want.

10 Click OK.

Opening files and folders stored in a recovery point

If you are not sure which files you want to restore, you can locate, open and view

their contents using the Recovery Point Browser. From there, you can also restore

files and folders using the Recovery Point Browser.

See “Opening files within a recovery point” on page 101.

If you cannot find the files or folders you want

If you cannot find the files or folders that you want to restore by browsing through

a recovery point, you can use the Norton Ghost Explore feature. This feature

assigns a drive letter to a recovery point (mounts the recovery point) as if it were

a working drive. You can then use the Windows Explorer search feature to search

for the files. You can drag and drop files to restore them.

See “About exploring recovery points ” on page 99.
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Recovering a secondary drive
If you lose data on a secondary drive, you can use an existing recovery point for

that drive to restore the data. A secondary drive is a drive other than the drive on

which your operating system is installed.

Note: You can recover your system drive (typically, drive C).

For example, if your computer has a D drive and the data has been lost, you can

restore the D drive back to an earlier date and time.

See “About recovering a computer ” on page 131.

To recover a drive, you must have a recovery point that includes the drive that

you want to recover. If you are not sure, review the Status page to determine what

recovery points are available.

See “Monitoring backup protection from the Status page ” on page 91.

Note: Before you proceed, close any applications and files that are open on the

drive that you want to restore.

Warning: When you recover a drive, all of the data on the drive to which you are

restoring the recovery point is replaced by the data in the recovery point. Any

changes that you made to the data on a drive after the date of the recovery point

you use to recover it are lost. For example, if you created a new file on the drive

after you created the recovery point, the new file is not recovered.

To recover a drive

1 On the Tasks page, click RecoverMyComputer.

2 Select a recovery point, and then click RecoverNow.

3 Click OK.

4 Click Yes.

To customize the recovery of a drive

1 On the Tasks page, click RecoverMyComputer.

2 Select a recovery point, and then click RecoverNow.

3 Click Custom to start the Recover Drive Wizard.

4 Click Next.
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5 Do one of the following:

■ To use the recovery point that is selected, click Next.

■ Click Browse to select a different recovery point, and then click Next.

If you need to access recovery points on a network that requires user

authentication, enter your user name and password, and then click Next.

6 Select the drive that you want to restore, and then click Next.

If the drive does not have enough space available to restore a recovery point,

press Shift and then select multiple, contiguous destinations that exist on

the same hard disk.

7 If the recovery point is password-protected, in the Password box, type the

password and then click OK.

8 Select from the following restore options:

Verifies whether a recovery point is valid or corrupt it

is restored.

This option can significantly increase the time required

for the recovery to complete.

Verify recovery point before

restore

Checks the restored drive for errors after the recovery

point is restored.

Check for file system errors

Automatically expands the drive to occupy the target

drive's remaining unallocated space.

Resize restored drive

Makes the restored drive the active partition (for

example, the drive from which the computer starts).

You should select this option if you are restoring the

drive on which your operating system is installed.

Set drive active (for booting

OS)
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Restores the original, physical disk signature of the

hard drive.

Disk signatures are included in Windows Server 2003,

Windows 2000 Advanced Server, and Windows NT

Server 4.0 Enterprise Edition (SP3 and later). Disk

signatures are required to use the hard drive.

Select this option if either of the following situations

are true:

■ Your computer's drive letters are atypical (for

example, assigned letters other than C, D, E, and so

forth).

■ You are restoring a recovery point to a blank hard

drive.

Restore original disk

signature

Sets the partition type as follows:

■ Primary partition: Because hard disks are limited

to four primary partitions, select this type if the

drive will have four or less partitions.

■ Logical partition: Select this type if you need more

than four partitions. You can have up to three

primary partitions, plus any number of logical

partitions, up to the maximum size of your hard

disk.

Partition type

Lets you assign a drive letter to the partition.Drive letter

The options that are available depend on the restore destination that you

have selected.

9 Click Next to review your selections.

10 Click Finish.

11 Click Yes.

If the wizard cannot lock the drive to perform the recovery in Windows

(typically, because the drive is in use by a program), make sure the drive is

not in use by closing any files or applications that might be using it, and then

click Retry.

If the Retry option fails, click Ignore to tell Windows to attempt to force a

lock on the drive. If Ignore failes, you might be prompted to insert the

Symantec Recovery Disk and manually start the recovery environment so

that you can complete the recovery. When the recovery is finished, the

computer restarts automatically.
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About LightsOut Restore
Norton Ghost 12.0 LightsOut Restore lets administrators restore a computer from

a remote location. It works regardless of the state of the computer provided that

its file system is intact.

For example, suppose you are on vacation in the Bahamas and a computer on your

network in Los Angeles goes down. You can connect to the computer from your

remote location by using your server's remote connection capabilities. You can

remotely access the Symantec Recovery Disk to start the computer in the recovery

environment. You can then use the recovery environment to restore files or an

entire system partition.

LightsOut Restore installs a customized version of the Symantec recovery

environment directly to the file system on the system partition. It then places a

Symantec recovery environment boot option in the Windows boot menu. Whenever

the Symantec recovery environment boot menu option is selected, the computer

boots directly into the Symantec recovery environment by using the files that are

installed on the system partition.

LightsOut Restore uses Symantec pcAnywhere technology, the Windows boot

menu, and hardware devices such as RILO and DRAC to let an administrator

remotely control a system during the boot process.

By default, when the recovery environment boots as part of LightsOut Restore, it

automatically starts a pcAnywhere thin host. You can then use Symantec

pcAnywhere from your remote location to connect to the thin host.

After you configure LightsOut Restore and add the boot menu option, you can use

a hardware device to remotely connect to the system. After you connect, you can

power on or reboot the system into the recovery environment.

Setting up and using LightsOut Restore

This section presents an overview of setting up and using LightsOut Restore.

Note: You must install a fully licensed version of Norton Ghost 12.0 before you

use the LightsOut feature to perform a restore operation. LightsOut Restore is

not included in the evaluation version.

■ Install a licensed version of Symantec pcAnywhere on a central computer that

you use for management (for example, a helpdesk computer).

■ Ensure that all of your servers can be managed remotely through a hardware

device such as RILO or DRAC.
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■ Install Norton Ghost on the servers that you want to protect, and then define

and run backups to create recovery points.

■ Run the LightsOut Restore Wizard to install the Symantec recovery

environment to the local file system.

The wizard also creates an entry in the Windows boot menu that can be used

to boot to the recovery environment.

Note: LightsOut Restore works only on the primary operating system. It does

not work on multiple-boot computers (for example, computer that boot multiple

operating systems from the same partition). LightsOut Restore is accessible

only from the boot menu. If the file system becomes corrupt and you cannot

access the boot menu, you must boot the computer from the CD.

Note: The LightsOut Restore feature requires at least 1 gigabyte of memory

to run.

■ When you need to recover and file or system from a remote location, use the

RILO or DRAC device to connect to the remote server, and power on the system

or restart it.

■ As the remote server starts, open the boot menu, and then select the Symantec

recovery environment.

The remote server boots into the Symantec recovery environment and the

connection through RILO or DRAC is lost. A pcAnywhere thin host

automatically starts.

■ Use Symantec pcAnywhere to connect to the pcAnywhere thin host that is

waiting on the remote server.

■ Through pcAnywhere, use the recovery environment to restore individual

files, or entire drives.

Configuring LightsOut Restore

You must run the LightsOut Restore Wizard on the computer that you want to

protect. The LightsOut Restore Wizard installs the Symantec recovery environment

to the local file system. The wizard also creates an entry in the Windows boot

menu that you use to boot into the recovery environment.
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To configure LightsOut Restore

1 Start Norton Ghost, and then click File > LightsOut Setup.

If the product is not licensed, the LightsOut Setup menu item is not available.

You must install a license file.

See “Activating Norton Ghost later” on page 17.

2 Insert your Symantec Recovery Disk CD into your CD-ROM drive, and then

click Next.

3 If necessary, specify the path to the CD-ROM drive in which you placed the

Symantec Recovery CD, and then click Next.

4 Review the list of drivers to be included, and add additional drivers or remove

the drivers you do not need, and then click Next.

5 On the Options page, do the following:

■ In the Time to display boot menu box, specify (in seconds) how long the

boot menu should display.

The default is 10 seconds.

■ If you do not want networking to start automatically when restoring the

computer through LightsOut Restore, uncheck EnableNetworking.

■ If you do not want the pcAnywhere thin host to start automatically when

restoring the computer through LightsOut Restore, uncheck Enable

pcAnywhere.

■ Select the type of IP address you want to use, and then click Next.

6 If you are shown a list of network and storage drivers that are not supported

in the Symantec recovery environment, do the following:

■ Select the box next to the network driver that you would like to copy from

your current Windows installation to the Symantec recovery environment.

■ Review the list of missing storage drivers, and then click Next.

■ Browse to the locations of your missing storage and network driver files.

Note: The location that you specify should contain the fully extracted

installation package for the driver. If you have more than one missing

storage driver, you must rerun the LightsOut Restore Wizard for each

missing driver. The drivers that you select should be compatible with

Windows Vista.
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The files are copied from the Symantec Recovery Disk. After the files are

copied, you receive a message that indicates that LightsOut Restore

successfully installed.

7 If you want to ensure that you can use the LightsOut feature when you need

it, check the Test installed LightsOut Restore check box.

While doing so requires a reboot of your computer, it could be worth the extra

effort in the event that you need to utilize LightOut Restore from a remote

location.

8 Click Finish.

Editing or rerunning the LightsOut Restore setup

You can run the LightsOut Restore Wizard again if you need to edit the

configuration settings, or if you need to rebuild an existing, modified Symantec

Recovery Disk.

To edit or rerun the LightsOut Restore setup

1 Start Norton Ghost, and then click File > LightsOut Setup.

2 Step through the wizard panels to make your changes.

3 When you are finished, click Finish.

4 Do one of the following:

■ Click Yes to recopy all of the files.

■ Click No.

Troubleshooting LightsOut Restore

For information about known issues and workarounds, review the readme, and

see “Troubleshooting LightsOut Restore” on page 196..
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Recovering a computer

This chapter includes the following topics:

■ About recovering a computer

■ Starting a computer by using the recovery environment

■ Preparing to recover a computer

■ Recovering a computer

■ Restoring multiple drives by using a system index file

■ Recovering files and folders from the recovery environment

■ Using the networking tools in the recovery environment

■ Viewing properties of recovery points and drives

■ About the Support Utilities

About recovering a computer
If Windows fails to start or does not run normally, you can recover your computer

using the Symantec Recovery Disk and an available recovery point.

Note: If you can start Windows and the drive that you want to restore is a secondary

drive (which is any drive other than your system drive, or the drive where your

operating system is installed), you can restore the drive within Windows.

The Symantec Recovery Disk lets you run a recovery environment that provides

temporary access to Norton Ghost recovery features. For example, you can access

the Recover My Computer Wizard to restart the computer into its previous, usable

state.
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Note: If you purchased Norton Ghost from your computer manufacturer, some

features in the recovery environment might not be available. For example, if the

manufacturer installed the recovery environment on your computer's hard disk.

Your manufacturer might also assign a keyboard key for the purpose of starting

the recovery environment.

When you restart your computer, watch for instructions on your computer monitor,

or refer to your manufacturer's instructions.

Starting a computer by using the recovery
environment

The Symantec Recovery Disk lets you start a computer that can no longer run the

Windows operating system. The Symantec Recovery Disk is included with Norton

Ghost. When you boot your computer using the SRD CD, a simplified version of

Windows starts that runs a recovery environment. In the recovery environment,

you can access the recovery features of Norton Ghost.

Note: Depending on which version of the product you have purchased, the SRD

is either included on your product CD, or as a separate CD. You should place the

CD containing the SRD in a safe place. Should you lose the CD, you can create a

new one if you have a CD burner. See If driver validation fails in theNortonGhost™

User's Guide.

Note: The recovery environment requires a minimum of 512 MB of RAM to run.

If your computer's video card is configured to share your computer's RAM, you

might need more than 512 MB of RAM.

Also, if you are installing a multilingual version of the product, you must have a

minimum of 768 MB of RAM to run the Symantec Recovery Disk.
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To start your computer by using the Symantec Recovery Disk

1 If you store your recovery points on a USB device, attach the device now (for

example, and external hard drive).

Note:You should attach the device before you restart the computer. Otherwise,

the recovery environment might not detect it.

2 Insert the Norton Ghost CD into the media drive of the computer.

If Norton Ghost was installed by your computer manufacturer, the recovery

environment already could be installed on your computer's hard drive. Either

watch your computer monitor after the computer restarts for on-screen

instructions, or refer to your manufacturer's documentation.

3 Restart the computer.

If you cannot start the computer from the CD, you might need to change the

startup settings on your computer.

See “Configuring your computer to boot from a CD” on page 133.

4 As soon as you see the prompt “Press any key to boot from CD”, press a key

to start the recovery environment.

Note: You must watch for this prompt. It can come and go quickly. If you miss

the prompt, you must restart your computer again.

5 Read the license agreement, and then click Accept.

If you decline, you cannot start the recovery environment, and your computer

will restart.

Configuring your computer to boot from a CD

To run Symantec Recovery Disk, you must be able to start your computer using

a CD.

To configure your computer to boot from a CD

1 Turn on your computer.

2 As the computer starts, watch the bottom of the screen for a prompt that tells

you how to access the BIOS setup.

Generally, you need to press the Delete key or a function key to start your

computer's BIOS setup program.
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3 In the BIOS setup window, select Boot Sequence, and then press Enter.

4 Follow the on-screen instructions to make the CD or DVD device be the first

bootable device in the list.

5 Put your SRD CD into the CD drive, and then restart your computer.

Note: Depending on which version of the product you have purchased, the

SRD is either included on your product CD, or as a separate CD. You should

place the CD containing the SRD in a safe place. Should you lose the CD, you

can create a new one if you have have a CD burner.

6 Save the changes and exit the BIOS setup to restart the computer with the

new settings.

7 Press any key to start the recovery environment (Symantec Recovery Disk).

When you start your computer with the SRD CD in the drive, you will see a

prompt telling you to “Press any key to boot from CD”. If you do not press a

key within five seconds, your computer will attempt to start from the next

bootable device listed in the BIOS.

Note: Watch carefully as the computer starts. If you miss the prompt, the

computer will need to be restarted again.

Preparing to recover a computer
Before you start the recovery process, you should scan your computer for viruses.

You can run this scan using some versions of the Symantec Recovery Disk. You

can also scan your hard disk to check it for corrupted data or surface damage.

See “Scanning for viruses” on page 134.

See “Checking your hard disk for errors” on page 136.

Scanning for viruses

If you suspect that your computer was damaged by a virus or other threat, you

should run a virus scan before you restore your computer.
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To scan for viruses

1 On the Analyze panel, click Scan for Viruses.

2 Select one of the following:

Select this option to use the definitions

that are included on the Symantec

Recovery Disk CD.

Use the virus definitions currently

available

Select this option if you downloaded the

latest virus definitions to a disk.

Use Update Locator virus definitions

folder

See “Locating the latest virus definitions” on page 135.

Locating the latest virus definitions

The Symantec Recovery Disk CD includes virus definitions. However, to help

protect your computer from the latest threats, you should use the latest virus

definitions that are available. The Update Locator locates the latest virus

definitions that are available from Symantec. You must run the Update Locator

on a working computer that has Internet access. You can save the virus definitions

to a disk and then use them on the troubled computer.

Note: Depending on which version of the product you have purchased, the SRD

is either included on your product CD, or as a separate CD. You should place the

CD containing the SRD in a safe place. Should you lose the CD, you can create a

new one if you have a CD burner. See If driver validation fails in theNortonGhost™

User's Guide.

To locate the latest virus definitions

1 Insert the Symantec Recovery Disk CD into the media drive of the computer.

The installation program should start automatically.

2 If the installation program does not start, on the Windows taskbar, click Start

>Run, type the following command, then click OK.

<drive>:\autorun.exe

where <drive> is the drive letter of your media drive.

For Windows Vista, if the Run option is not visible, do the following:

■ Right-click the Start button, and click Properties.

■ On the Start Menu tab, click Customize.
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■ Scroll down and check Run command.

■ Click OK.

3 Click RunUpdate Locator.

4 Click Find and retrieve virus definitions.

If more recent virus definitions are not found, you can still scan for viruses

on your damaged computer by using the virus definitions that are on the

Symantec Recovery Disk CD. However, the computer might not be protected

from new viruses or threats.

5 When prompted, click OK.

6 Do one of the following:

■ Insert a floppy disk into the floppy disk drive.

■ Insert a blank, writable CD or DVD into the computer's CD or DVD

recordable drive.

7 Locate the newly created Update Locator Virus Definitions folder on your

computer's desktop and copy it to the blank disk.

Checking your hard disk for errors

If you suspect that your hard disk is damaged, you can examine it for errors.

To check your hard disk for errors

1 In the Analyze panel, click CheckHardDisks for Errors.

2 Select the drive that you want to check.

3 Select any of the following options.

Fixes errors on the selected disk. When

this option is not selected, errors are

displayed but are not fixed.

Automatically fix file system errors

Locates bad sectors and recovers readable

information.

Find and correct bad sectors

4 Click Start.

Recovering a computer
You can restore your computer within the recovery environment. If you have a

recovery point for the hard drives that you want to recover, you can fully recover
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your computer or other hard drive back to the state it was in when the recovery

point was created.

To recover your computer

1 Start the computer by using the Symantec Recovery Disk.

See “Starting a computer by using the recovery environment ” on page 132.

2 On the Home panel, click RecoverMyComputer.

Note: If your recovery points are stored on a CD or DVD and you only have

one CD/DVD drive, you can eject the Symantec Recovery Disk CD now. Insert

the CD or DVD that contains your recovery points.

3 On the Welcome page of the wizard, click Next.

If the Symantec Recovery Disk cannot locate any recovery points, you are

prompted to locate one.

Click Viewby, and then select one of the following options:

Displays all of the discovered recovery points in the order in

which they were created.

If no recovery points were discovered, the table will appear empty.

You should then choose one of the remaining View by options.

Date

Lets you browse to another location, for example, an external

(USB) drive or removable media to select a recovery point (.v2i)

file.

Select this option, and then do the following:

■ ClickBrowse, locate and select a recovery point (.v2i file), and

then click Open.

■ If you select a network location, type your network

credentials.

■ Click Finish.

Filename

137Recovering a computer
Recovering a computer



Displays a list of all of the drives on your computer and shows

any associated recovery points. You can also select a system index

file (.sv2i).

Select this option, and then do the following:

■ Click Browse, locate and select a recovery point (.sv2i), and

then click Open.

■ If you select a network location, type your network

credentials.

■ Check each recovery point that you want to recover.

If necessary, add, change, or remove recovery points from

the list.

■ Click Finish.

System

4 Select the drive that you want to recover.

If you are recovering your computer, select the drive on which Windows is

installed. On most computer systems, this drive is the C drive. In the recovery

environment, the drive letters and labels might not match what appears in

Windows. You might need to identify the correct drive based on its label, the

name assigned to it, or by browsing the files and folders in the recovery point.

See “Recovering files and folders from the recovery environment ” on page 141.

5 If you need to delete a drive to make space available to restore your recovery

point, click DeleteDrive.

When you click Delete Drive, the drive is only marked for deletion. The actual

deletion of the drive takes place after you click Finish in the wizard.

If you change your mind before you click Finish, go back to the Target Drive

page of the wizard, and then click UndoDelete.

6 Click Next, and then select the options that you want to perform during the

recovery process, as follows:

Verifies whether a recovery point is valid or corrupt it

is restored.

This option can significantly increase the time required

for the recovery to complete.

Verify recovery point before

restore

Checks the restored drive for errors after the recovery

point is restored.

Check for file system errors

after recovery

Automatically expands the drive to occupy the target

drive's remaining unallocated space.

Resize restored drive
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Sets the partition type as follows:

■ Primary partition: Because hard disks are limited

to four primary partitions, select this type if the

drive will have four or less partitions.

■ Logical partition: Select this type if you need more

than four partitions. You can have up to three

primary partitions, plus any number of logical

partitions, up to the maximum size of your hard

disk.

Partition type

Makes the restored drive the active partition (for

example, the drive from which the computer starts).

You should select this option if you are restoring the

drive on which your operating system is installed.

Set drive active (for booting

OS)

Restores the original, physical disk signature of the

hard drive.

Disk signatures are included in Windows Server 2003,

Windows 2000 Advanced Server, and Windows NT

Server 4.0 Enterprise Edition (SP3 and later). Disk

signatures are required to use the hard drive.

Select this option if either of the following situations

are true:

■ Your computer's drive letters are atypical (for

example, assigned letters other than C, D, E, and so

forth).

■ You are restoring a recovery point to a blank hard

drive.

Restore original disk

signature
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Restores the master boot record. The master boot

record is contained in the first sector of a physical hard

disk. The MBR consists of a master boot program and

a partition table that describes the disk partitions. The

master boot program looks at the partition table of the

first physical hard disk to see which primary partition

is active. It then starts the boot program from the boot

sector of the active partition.

This option is recommended only for advanced users

and is available only if you restore a whole drive in the

recovery environment.

Select this option if any of the following situations are

true:

■ You are restoring a recovery point to a new, blank

hard disk.

■ You are restoring a recovery point to the original

drive, but the drive's partitions were modified since

the recovery point was created.

■ You suspect that a virus or some other problem has

corrupted your drive's master boot record.

Restore Master Boot Record

(MBR)

Preserves the token that is used to authenticate a user

or a computer on a domain. This option helps ensure

that a recovered computer is recognized by a network

domain after it is recovered.

Preserve domain trust token

on destination

The options that are available depend on the restore destination that you

selected.

7 Click Next to review the restore options that you selected.

8 CheckRebootwhenfinished if you want the computer to restart automatically

after the recovery process finishes.

9 Click Finish.

10 Click Yes to restore the drive.

Restoringmultiple drives by using a system index file
You can run the Recover My Computer wizard from the Symantec Recovery Disk

to restore a computer that has multiple drives. This type of restore operation uses

a system index file (.sv2i) to reduce the amount of time that is needed to restore

the drives. When a recovery point is created, a system index file is saved with it.
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The system index file contains a list of the most recent recovery points, which

includes the original drive location of each recovery point.

If you have suffered a catastrophic hard drive failure, you can also use Symantec

Recovery Disk to perform a bare metal recovery of a computer.

To restore multiple drives using a system index file

1 Start the computer by using the Symantec Recovery Disk.

See “Starting a computer by using the recovery environment ” on page 132.

Drive letters in the recovery environment might not match those in the

Windows environment.

2 On the Home panel, click RecoverMyComputer.

3 Click Next.

4 Click Viewby, and then select System.

5 Click Browse, locate and select a system file (.sv2i), and then click Open.

The system index file is in the same location as the recovery point location.

6 If you select a network location, type your network credentials.

7 Check each recovery point that you want to recover.

If necessary, add, change, or remove recovery points from the list.

8 Click Finish.

Recovering files and folders from the recovery
environment

You can use the Symantec Recovery Disk to start your computer and to restore

files and folders from within a recovery point.

The recovery environment includes several support utilities that you can run to

troubleshoot networking or hardware issues. For example, you can ping a

computer, renew IP addresses, or get information about a hard-disk partition

table.

To recover files and folders from the recovery environment

1 Start the computer by using the Symantec Recovery Disk.

See “Starting a computer by using the recovery environment ” on page 132.

2 Click Recover, and then click RecoverMyFiles.

3 Do one of the following:
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If the Symantec Recovery Disk cannot locate any recovery points, you are

prompted to locate one. In the Open dialog box, navigate to a recovery

point, select one, and then click Open.

■

■ If the Symantec Recovery Disk finds recovery points, select a recovery

point from the list, and then click OK.

Note: If you have trouble finding the recovery points in a network location,

in the File name box, type the name of the computer and share that holds

your recovery points. For example, \\computer_name\share_name.

If you are still having problems, try entering the computer's IP address.

Using the networking tools in the recovery environment .

4 In the tree view pane of the Recovery Point Browser, double-click the drive

that contains the files or folders that you want to restore to expand it.

5 In the content pane of the Recovery Point Browser, do one of the following

to select the files or folders that you want to restore.

Press Ctrl+A.To select all items

Select the top file, press Shift, and then

select the last file in the list.

To select a group of files that are next to

each other

Press Ctrl as you select the files.To select a group of files that are not next

to each other

6 Click Recover Files.

Where possible, the Recover Items dialog box automatically completes the

Restore to this folder box with the original path from which the files

originated.

If the original location does not include a drive letter you must type the drive

letter at the beginning of the path.

Note: While in the recovery environment, drive letters and labels might not

match what appears in Windows. You might have to identify the correct drive

based on its label, which is the name assigned to it.

7 If the original path is unknown or you want to restore the selected files to a

different location, click Browse to locate the destination.
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8 Click Recover to restore the files.

9 Click OK to finish.

Exploring your computer

You can explore the files and folders on your computer from the recovery

environment by using the Explore My Computer feature.

This feature uses the Recovery Point Browser and functions similarly to Windows

Explorer. You can browse the file structure of any drive that is attached to your

computer from the recovery environment.

To explore your computer

◆ In the Analyze pane, click ExploreMyComputer.

Using the networking tools in the recovery
environment

If you store your recovery points on a network, you need access to the network

to restore your computer or your files and folders from the recovery environment.

Note: Additional computer memory might be required to recover your computer

across a network.

Starting networking services

If you need to start networking services, you can do so manually.

To start networking services

◆ On the Network panel, click StartMyNetworking Services.

To verify the connection to the network, you can map a network drive.

See “Mapping a network drive in the recovery environment ” on page 146.

Using the pcAnywhere thin host for a remote recovery

The Symantec Recovery Disk includes a pcAnywhere thin host, which lets you

remotely access a computer in the recovery environment. The pcAnywhere thin

host contains the minimum settings that are needed to support a single-use remote

control session. The thin host requires an IP address for hosting a remote control

session.
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Note: You cannot deploy a thin host to the recovery environment. The thin host

can only be started from Symantec Recovery Disk to host a remote control session

in the recovery environment. The thin host in Symantec Recovery Disk does not

support file transfers and cannot be used to add drivers for network or storage

devices.

To start the pcAnywhere thin host

After you start the thin host from the Symantec Recovery Disk, it waits for a

connection from a remote computer. You can connect to the thin host to remotely

manage a recovery or to perform other tasks in the recovery environment. You

must use Symantec pcAnywhere to connect to the thin host.

To start the pcAnywhere thin host

◆ On either the Home or Network panels in the recovery environment, click

Start the pcAnywhere ThinHost.

The networking services are started if necessary. The thin host waits for a

connection.

Remotely connecting to the thin host

Symantec pcAnywhere lets you remotely connect to a computer that is running

in the recovery environment. The computer must be running the pcAnywhere

thin host that is included in the Symantec Recovery Disk, and it must be waiting

for a connection. Once connected, the client computer can remotely manage a

recovery or perform other tasks that are supported in the recovery environment.

Note: The client computer cannot transfer files or add additional drivers for

network or storage devices on the computer that is running the thin host.

To remotely connect to the thin host

1 Ensure that the computer to be remotely managed (the host) has started in

the recovery environment and that the pcAnywhere thin host is waiting for

a connection.

2 Obtain the IP address of the thin host computer.
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3 On the client computer, in Symantec pcAnywhere, configure a remote

connection item.

For more information, see the Symantec pcAnywhere User's Guide.

Note: You do not need to choose to automatically login to the host on

connection.

4 When you configure the connection in pcAnywhere, do the following:

■ Select TCP/IP as the connection type.

■ Specify the IP address of the host computer.

■ Choose to automatically login to the host on connection.

If you do not include the login information, you are prompted for it when

you connect to the thin host.

■ Type the following login name:

symantec

■ Type the following password:

recover

The thin host shuts down when there is an attempt to connect by using any

incorrect configuration settings.

To prevent unauthorized users from tampering with your settings or

launching a session without your permission, set a password for your remote

connection item.

This option is available in the Remote Properties window on the Protect Item

tab. The thin host does not support encryption.

5 In pcAnywhere, start the remote control session.

If the connection attempt is unsuccessful, the thin host must be restarted on

the host computer before you make another attempt to connect.

6 Remotely perform the necessary tasks on the host computer.

The remote control session ends when the thin host is closed, when the thin

host computer is restarted, or when the remote control session is ended.

After the host computer starts Windows, the client computer can deploy and

connect a thin host on the computer to verify the success of tasks that were

performed in the recovery environment.

145Recovering a computer
Using the networking tools in the recovery environment



Mapping a network drive in the recovery environment

If you started the networking services after you started the recovery environment,

you must map a network drive. This lets you browse to that drive and select the

recovery point that you want to restore.

If there is no DHCP server or the DHCP server is unavailable, you must provide a

static IP address and a subnet mask address for the computer on which you are

running Symantec Recovery Disk.

See “Configuring network connection settings ” on page 146.

After you provide the static IP address and subnet mask address, you can enter

the recovery environment. However, because there is no way to resolve computer

names, when you run the Recover My Computer Wizard or the Recovery Point

Browser, you can only browse the network by using the IP addresses to locate a

recovery point. You can map a network drive so that you can locate the recovery

points more effectively.

To map a network drive in the recovery environment

1 In the recovery environment main window, click Network, and then click

Map a network drive.

2 Map a network drive by using the UNC path of the computer on which the

recovery point is located.

For example: \\computer_name\share_name or \\IP_address\share_name

Configuring network connection settings

You can access the Network Configuration window to configure basic network

settings while running in the recovery environment.

To configure network connection settings

1 In the recovery environment main window, click Network, and then click

ConfigureNetwork Connection Settings.

2 If you are prompted to start networking services, click Yes.

Getting a static IP address

If you want to restore a recovery point that is located on a network drive or share,

but you are unable to map a drive or browse to the drive/share on the network

(usually caused by the lack of an available DHCP service), you can assign a unique

static IP address to the computer that is running the recovery environment. You

can then map to the network drive or share.
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To get a static IP address

1 In the Network Adapter Configuration box, clickUsethefollowingIPaddress.

2 Specify a unique IP address and subnet mask for the computer that you want

to restore.

Be sure that the subnet mask matches the subnet mask of the network

segment.

3 Click OK.

4 Click Close to return to the recovery environment's main menu.

5 In the Network pane, click Ping aRemote Computer.

6 Type the address of the computer that you want to ping on the network

segment.

7 Click OK.

If you specified a computer name or a computer name and domain as the

address method, make note of the IP address that is returned from the

computer that you pinged.

If communication to the storage computer is operating as expected, you can

use the Map Network Drive utility to map a drive to the recovery point

location.

Getting a static IP address if the ping is unsuccessful

If you ping an address and the address does not respond, you can use the ipconfig

/all command to determine the correct IP address.

To get an IP address if the ping is unsuccessful

1 On the computer that contains the recovery point that you want to restore,

at a DOS prompt, type the following command, and then press Enter.

ipconfig /all

2 Write down the IP address that is displayed.

3 Return to the computer that is running the recovery environment and run

the utility Ping Remote Computer with this IP address.

Viewing properties of recovery points and drives
You can view the properties of recovery points and the drives that are contained

in them.

■ Viewing properties of a recovery point
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■ Viewing the properties of a drive within a recovery point

Viewing properties of a recovery point

You can view various properties of a recovery point by using the Recovery Point

Browser. The following properties are available for viewing:

A user-assigned comment associated with the recovery pointDescription

The total size (in megabytes) of the recovery pointSize

The date and time that the recovery point file was createdCreated

The compression level that is used in the recovery pointCompression

Whether the entire recovery point file is spanned over

several files

Spanned

The password protection status of the selected drivePassword protected

The encryption strength that is used with the recovery pointEncryption

The format of the recovery pointFormat

The name of the computer on which the recovery point was

created

Computer name

If you enabled search engine support for the recovery point,

this property is displayed.

Catalogued

Identifies the application (Norton Ghost) that was used to

create the recovery point.

Created by

To view the properties of a recovery point

1 In the Recovery Point Browser, in the tree panel, select the recovery point

that you want to view.

2 Do one of the following:

■ On the File menu, click Properties.

■ Right-click the recovery point, and then click Properties.

Viewing the properties of a drive within a recovery point

You can view the following properties of a drive within a recovery point:
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A user-assigned comment associated with the recovery

point.

Description

The original drive letter that was assigned to the drive.Original drive letter

The cluster size (in bytes) that is used in a FAT, FAT32, or

NTFS drive.

Cluster size

The file system type that is used within the drive.File system

The selected drive's drive status as either the primary

partition or the logical partition.

Primary/Logical

The total size (in megabytes) of the drive.

This total includes used and unused space.

Size

The amount of used space (in megabytes) within the drive.Used space

The amount of unused space (in megabytes) within the drive.Unused space

Indicates if there are any bad sectors on the drive.Contains bad sectors

To view the properties of a drive within a recovery point

1 In the Recovery Point Browser, in the tree panel, double-click the recovery

point that contains the drive that you want to view.

2 Select a drive.

3 Do one of the following:

■ On the menu bar, click File > Properties.

■ Right-click the recovery point, and then click Properties.

About the Support Utilities
The recovery environment has several support utilities that Symantec Technical

Support might ask you to use to troubleshoot any hardware issues that you

encounter.

You might be required to supply the information that is generated by these utilities

if you call Symantec Technical Support for help resolving problems.

Note: You should only use these tools as directed by Symantec Technical Support.
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Copying a drive

This chapter includes the following topics:

■ About copying a drive

■ Preparing to copy drives

■ Copying one hard drive to another hard drive

About copying a drive
You can use the Copy Drive feature to copy your operating system, applications,

and data from one hard drive to another hard drive.

You can even copy a larger hard drive to a smaller hard drive if the data on the

drive being copied is at least 1/16th smaller in size than the total size of the new

drive.

If the hard drive that you want to copy contains more than one partition, you

must copy the partitions one at a time to the new hard drive.

You can use the Copy Drive feature when you upgrade to a larger hard drive or

when you add a second hard drive. You should not use the Copy Drive feature to

set up a hard drive that will be used in another computer. The drivers that are

used to run the hardware on one computer will likely not match the drivers on a

second computer.

Note: You must install a fully licensed version of Norton Ghost 12.0 before you

can use the Copy Drive feature. This feature is not available in the evaluation

version.
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Preparing to copy drives
Before you can copy drives, you must have the hardware configured correctly.

To prepare to copy drives

1 Do all of the following:

■ Prepare the computer.

■ Get the manufacturer's directions for installing the drive.

■ Shut down the computer, and then disconnect the power cord.

■ Discharge electricity by touching a grounded metal object.

■ Remove the computer cover.

2 Change the jumper settings on the hard drive to make the new hard drive the

slave drive, or connect it as the slave drive if you are using cable select instead

of jumper settings to determine the master and slave drives.

3 Do the following to attach the new hard drive:

■ Connect the cable so that the colored stripe on the edge lines up with the

I/O pins on the motherboard.

The motherboard is marked Pin1 or 1 where the colored stripe should go.

■ Connect the other end of the cable to the back of the hard drive, and match

the striped edge with the I/O pin position on the drive itself.

The I/O pin is usually on the side closest to the power supply.

4 Attach the power connector to the new hard drive.

Make sure that the angled edge of the plastic connector lines up with the

angled edge of the pin socket.

5 Anchor the drive in the bay area according to the manufacturer's instructions.

6 Do the following to change the BIOS settings to recognize the new hard drive:

■ Open the BIOS setup. As the computer starts, watch the computer screen

for instructions on how to open the BIOS setup.

■ Select Auto Detect for both the master and slave drives.

■ Save the BIOS changes, and then exit.

Your computer will restart automatically.
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Copying one hard drive to another hard drive
After you install a new hard drive, you can copy your old hard drive to the new

one. The new hard drive does not need to be formatted.

If the hard drive that you want to copy contains more than one partition, you

must copy each partition, one at a time, to the new hard drive.

If the power or the hardware fails while you copy the data, no data is lost from

the source drive. However, you must restart the copying process.

Note: This feature is not available in the evaluation version of the product.

To copy one hard drive to another hard drive

1 On the Tools page, click CopyMyHardDrive.

2 Complete the steps in the wizard to copy the drive.

The wizard steps you through the process of selecting the right drive to copy,

selecting the destination drive, and selecting the options for copying the data

from one drive to another.

Drive-to-drive copying options

When you copy a drive from one hard drive to another, you can use the

drive-to-drive copying options.

Table 11-1 describes the options for copying from one hard drive to another.

Table 11-1 Drive-to-drive copying options

DescriptionOption

Check the source drive for errors before you copy it. The

source drive is the original drive.

Check source for file system

errors

Check the destination drive for errors after you copy the

drive. The destination drive is the new drive.

Check destination for file

system errors

This option automatically expands the drive to occupy the

destination drive's remaining unallocated space.

Resize drive to fill

unallocated space.
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Table 11-1 Drive-to-drive copying options (continued)

DescriptionOption

Make the destination drive the active partition (the drive

from which the computer starts). Only one drive can be

active at a time. To boot the computer, it must be on the

first physical hard disk, and it must contain an operating

system. When the computer boots, it reads the partition

table of the first physical hard disk to find out which drive

is active. It then boots from that location. If the drive is not

bootable or you are not certain if it is, have a boot disk ready.

You can use the Symantec Recovery Disk.

The Set drive active option is valid for basic disks only (not

dynamic disks).

Set drive active (for booting

OS)

The SmartSector technology from Symantec speeds up the

copying process by only copying the clusters and sectors

that contain data. However, in a high-security environments,

you might want to copy all clusters and sectors in their

original layout, regardless of whether they contain data.

Disable SmartSector copying

This option copies the drive even if there are errors on the

disk.

Ignore bad sectors during

copy

This option copies the master boot record from the source

drive to the destination drive. Select this option if you are

copying the C:\ drive to a new, empty hard drive. You should

not select this option if you want to copy a drive to another

space on the same hard drive as a backup. You should also

not select this option if you want to copy the drive to a hard

drive that has existing partitions that you do not want to

replace.

Copy MBR

Click Primary partition to make the destination (new) drive

a primary partition.

Click Logical partition to make the destination (new) drive

a logical partition inside an extended partition.

Destination partition type

Select the drive letter you want assigned to the partition

from the Drive letter drop-down list

Drive letter
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Using a search engine to

search recovery points

This appendix includes the following topics:

■ About using a search engine to search recovery points

■ Enabling search engine support

■ Recovering files using Google Desktop's Search Desktop feature

About using a search engine to search recovery points
Norton Ghost supports the use of Google Desktop for searching for file names

that are contained in recovery points.

When a backup runs, Norton Ghost generates a catalog of all of the files that are

included in the recovery point. Google Desktop can then use the catalog to generate

an index of the files that are contained in each recovery point.

When you enable search engine support, Norton Ghost creates a catalog of all of

the files that are contained in a recovery point. Search engines like Google Desktop

use the catalog file generate an index. You can then search for files by name.

Google Desktop does not index the content of files. It only indexes the file names.

Enabling search engine support
To use this feature with a search engine, such as Google Desktop, you must do all

of the following:
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You can download and install Google Desktop for free

from the Internet. Visit desktop.google.com.

See “To install Google Desktop” on page 156.

Install a search engine

A Google plug-in for Norton Ghost is required before

you can use Google Search to locate and recover files.

The plug-in is installed for you automatically when

you enable this feature.

See “To enable Google Desktop support” on page 157.

Enable Google Desktop support

When you define a backup job, or edit an existing

backup job, enable search engine support.

The next time the backup is run, it creates a list of all

files contained in the resulting recovery point. A

search engine, such as Google Desktop, can then use

the list to generate its own index, enabling you to

perform searches by file name.

See “To enable search engine support for a backup

job” on page 157.

Enable search engine support when

defining or editing a backup job

Note: Recovery points that already exist when you enable this feature cannot be

indexed. This restriction is because the generated list of files that are required by

search engines for generating searchable indexes are appended to recovery points

as they are created. After you enable this feature, run each of your backups in

order to create a new recovery point that contains the required information for

indexing.

Note: If your backup destination is on a network drive, be sure to add the location

to the Google Desktop preferences.

To install Google Desktop

1 Start Norton Ghost.

2 Click Tasks >Options >GoogleDesktop.

3 Click DownloadGoogleDesktop from theWeb and follow instructions for

installation.

4 Once installed, click OK in the Norton Ghost Options window.

For more information, visit desktop.google.com.
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To enable Google Desktop support

1 Start Norton Ghost.

2 Click Tasks >Options >GoogleDesktop.

3 Check Enable GoogleDesktop File and Folder Recovery.

4 Click OK.

This option is not available if you do not have Google Desktop installed. Install

Google Desktop, and then repeat this procedure.

5 Click OK to install the Google Plugin.

To enable search engine support for a backup job

1 Start Norton Ghost.

2 Do one of the following:

■ Edit an existing backup job and check Enable search engine support for

GoogleDesktop andBackup ExecRetrieve on the Options page of the

wizard.

■ Define a new backup job and check Enable search engine support for

GoogleDesktop andBackup ExecRetrieve on the Options page of the

wizard.

Recovering files using Google Desktop's Search
Desktop feature

If you have correctly set up and enabled support for Google Desktop, you can

search recovery points to located and recover files using Google Desktop.

See “Enabling search engine support” on page 155.

To recover files using Google Desktop

1 Start Google Desktop.

2 Enter the name (or part of the name) of a file you want to recover, and then

click SearchDesktop.

3 Click the search result containing the file you want to recover.

4 When the file opens in the associated application, click File>SaveAs to save

the recovered file.

You can also right-click the search result and click Open to open the recovery

point in the Recovery Point Browser.

See “Opening files within a recovery point” on page 101.
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If a file cannot be found using Google Desktop

If you are certain that your file is included in a recovery point that has search

engine support enabled, but the file is not found, do the following:

■ Right-click the Google Desktop icon in the system tray and click Indexing >

Re-Index.

Re-indexing can take a significant amount of time. Be sure to wait until it

completes before attempting to search again.

■ Right-click the Google Desktop icon in the system tray and click Preferences.

Under Search Types, verify that Web history is checked. This option must be

checked or Google Desktop cannot index the content of your recovery points.

■ Verify that the drive containing your recovery points (backup destination) is

available.

For example, if your backup destination is on a USB drive, be sure that the

drive is plugged in and that the power is turned on. Or, if your backup

destination is on a network, be sure you are connected and logged in with the

correct credentials.

■ Adding v2i to the search string to narrow down the number of search results.

For example, if you are searching for My Tune mp3, add v2i so that the search

string is MyTunemp3 v2i.

Recovery point files use .v2i as their file extension name. Adding it to the

search string eliminates search results that are not found in a recovery point.

■ If your backup destination is on a network drive, be sure to add the location

to the Search These Locations setting in Google Desktop Preferences.
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Troubleshooting Norton

Ghost

This appendix includes the following topics:

■ About troubleshooting Norton Ghost

■ Using event log information to troubleshoot problems

■ Troubleshooting installation

■ Troubleshooting recovery points

■ Troubleshooting scheduled backups

■ Troubleshooting recovery from within Windows

■ Troubleshooting the recovery environment

■ Troubleshooting drives on Windows

■ Troubleshooting error messages

■ General troubleshooting

■ Norton Ghost agent and Windows Services

■ Troubleshooting LightsOut Restore

About troubleshooting Norton Ghost
If you need more information about resolving a problem, check the Symantec

Web site or contact Technical Support.
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You should also read the Readme.txt file on the product CD, which includes

additional troubleshooting information discovered after the product was

completed.

Using event log information to troubleshoot problems
When Norton Ghost performs an action, it records the event (for example, when

a backup job runs). It also records program error messages.

You can use the event log to track down the source of problems or to verify the

successful completion of a backup job.

See “Logging Norton Ghost messages” on page 27.

Log entries provide information about the success or failure of numerous actions

that were taken by Norton Ghost or by a user. It offers a single view of all of the

information and program error messages.

The following information is included in the event log:

Indicates if the event is an error message or other information, such

as the successful completion of a backup job.

Type

Identifies if the message was generated by Norton Ghost or another

program.

Source

Displays the exact date and time that a selected event occurred.Date

Offers additional details about an event that can help you troubleshoot

problems that might have occurred.

Description

Troubleshooting installation
Following are some of the most common installation problems:

■ Locating required system information

See “Locating required system information ” on page 161.

■ Drive letter changes

See “Drive letter changes” on page 161.

■ Installing Microsoft .NET Framework

See “About Microsoft .NET Framework” on page 161.
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Locating required system information

You can get system information directly from Windows. This information can be

used to specify an IP address, drivers, and so forth when you install the Symantec

product or set up the recovery environment.

To locate required system information

1 In the Windows Start menu, click Start > Programs > Accessories > System

Tools > System Information.

2 Use the tree panel area to select the information group you want to view or

print.

Drive letter changes

If the drive letter of the CD drive has changed since you installed the product, you

receive an error message (the MSI file cannot be found) when you run the Repair

or Modify installation option from the Norton Ghost CD. This error typically

occurs if you add or remove external devices to a desktop computer or if you add

or remove internal devices to a laptop.

To avoid this issue, ensure that the drive letter of the CD drive is the same as when

you installed Norton Ghost.

About Microsoft .NET Framework

Microsoft .NET Framework 2.0 is required to run Norton Ghost. If you have an

earlier version of .NET Framework, the Norton Ghost installation upgrades your

version to the required 2.0 version.

Troubleshooting recovery points
The following are some of the most common issues when trying to create recovery

points:

■ Burning recovery points to a CD or DVD

See “Burning recovery points to a CD or DVD” on page 162.

■ Support for CD/DVD burners

See “Support for CD/DVD burners” on page 162.

■ Support for DVD-ROM drives

See “Support for DVD-ROM drives” on page 162.

■ About hiberfil.sys and pagefile.sys files

See “About hiberfile.sys and pagefile.sys files” on page 162.
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Burning recovery points to a CD or DVD

Difficulties while recovery points are being burned to CD might be resolved by

downloading the latest CD or DVD drivers and firmware updates from the

manufacturer of your CD or DVD writer. When you have completed the update,

be sure you turn off the power to the computer (if your CD/DVD burner is internal),

then turn the power back on. This will ensure that the computer recognizes the

drive. If your CD/DVD burner is external, unplug the power source to the burner,

and then plug it back in.

If you create a recovery point of two drives and the first recovery point fills one

and a half CDs, you will be prompted to insert new media before the second drive

is backed up. You should think of the two drives as two separate backup sets. This

process makes it easier to restore recovery points from removable media later.

Support for CD/DVD burners

Norton Ghost uses Gear Software technology. To verify that your CD or DVD

writer is compatible, visit

http://www.gearsoftware.com/support/recorders/index.cfm. You must know the

name of the manufacturer and model number of your writer to verify compatibility.

The supported burners allow variable packet writing, which is required if you

want to write a recovery point to CD or DVD. Most burners that were manufactured

since 1998 support variable packet writing. If your burner is not listed, you should

check your burner's documentation to see if variable packet writing is supported

before you attempt to write recovery points to it.

Support for DVD-ROM drives

Some DVD-ROM drives cannot play DVD+R media. If you plan to store recovery

points on DVD+R media and later restore from a DVD-ROM drive, you should

ensure that the drive is compatible.

The drive compatibility list is available at the following URL:

http://www.dvdplusrw.org/

About hiberfile.sys and pagefile.sys files

The hiberfil.sys and pagefile.sys files are intentionally excluded from backups.

These files contain temporary files that can take up a large amount of disk space.

They are not needed and there is no negative impact on your computer system

after a complete system recovery. Although these files appear in recovery points,

they are only placeholders.
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Troubleshooting scheduled backups
The following are some of the most common issues that occur while scheduling

backups:

■ Recovery points are no longer being created

See “Recovery points are no longer being created” on page 163.

■ Define Backup wizard does not show the correct time settings

See “Define Backup wizard does not show the correct time settings” on page 164.

■ Checking the status of the agent

See “Checking the status of the agent ” on page 164.

■ I want to test the scheduling of my backups

See “Testing the scheduling of your backups” on page 164.

■ I deleted a drive and now I get backup errors

See “Backup errors occur after you deleted a drive” on page 164.

Recovery points are no longer being created

When you define a backup, you can specify the number of recovery points that

you want to save on the hard disk before they are rotated out and deleted. When

you use this option, you must also make sure that you have enough hard disk

space to accommodate the number of recovery points that you specify, plus one

additional recovery point.

If you run out of hard disk space before the number of specified recovery points

is reached, the recurring recovery point process no longer functions, and a current

recovery point is not created.

Note: You can configure Norton Ghost to notify you when a specified amount of

disk space has been used. You can remove the old recovery points by using the

Clean Up feature.

See “Managing recovery points” on page 107.

The solution is to either reduce the number of recurring recovery points that you

create. Or, increase the amount of space necessary to maintain the number of

recovery points that you want to create.

If this does not solve the issue, you should review the events log for more

information.

See “Troubleshooting scheduled backups” on page 163.
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Define Backup wizard does not show the correct time settings

The Define Backup wizard might not show customized time settings (such as a

24-hour clock) or a customized time separator (such as - instead of :). Instead, the

wizard might show the 12-hour clock with the default separator (:).

Note: The time that appears on the Drives tab reflects the time settings for the

computer.

Checking the status of the agent

If you have problems with the agent, you should check its status.

To check the status of the agent

1 On the Windows taskbar, click Start > Run.

2 In the Open text box, type the following command:

services.msc

3 Click OK.

4 In the Name column, click NortonGhost.

The Status column for Norton Ghost should have Started listed.

5 Do one of the following:

■ To stop the service, in the Name column, right-click NortonGhost, and

then click Stop.

■ To start the service, in the Name column, right-click NortonGhost, and

then click Start.

Testing the scheduling of your backups

To test the scheduling of your backups, you can stop the Norton Ghost agent

service in the Microsoft Services console (SERVICES.MSC). Change the date forward

on the computer to a time when a scheduled backup job should occur, and then

restart the Norton Ghost service. If the date is changed while the service is running,

the change is not noticed by the Norton Ghost service.

Backup errors occur after you deleted a drive

When a drive is deleted, Norton Ghost should detect that the drive is no longer

available. It should remove the deleted drive from any defined backups that include

the deleted drive.
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However, if you delete a drive, you should remove the drive from all backups that

are associated with it to avoid any errors.

Troubleshooting recovery from within Windows
The following are suggestions to help you resolve problems during the recovery

of data within Windows:

■ Recovering data from a recovery point that spans multiple media.

See “About using a recovery point that is spanned across multiple CDs or

DVDs” on page 165.

■ Recovering the system drive where the operating system is installed from

within Windows.

See “About recovering a system drive in Windows” on page 165.

■ The drive is no longer found after a failed or cancelled recovery.

See “When a drive cannot be found after a failed or cancelled recovery job”

on page 166.

About using a recovery point that is spanned across multiple CDs or
DVDs

When you restore from a CD/DVD, you are prompted to insert the first CD, followed

by the last CD, the first CD, the last CD, then the first CD again. Then, the restore

process begins and prompts you for the media in sequence. After you restore a

recovery point, you are prompted again to insert the first CD again. For example,

if you have a recovery point that spans across five CDs, you would insert the CDs

in the following order: 1-5-1-5-1-2-3-4-5-1.

About recovering a system drive in Windows

Even though you can start the process of recovering your system drive in windows,

you will be prompted to restart your computer in the recovery environment to

complete the recovery. This is because the system drive cannot be recovered while

it is running. When you run the Recover My Computer wizard from within

Windows, it lets you specify what drive is to be recovered to where, and also select

other related settings. Norton Ghost recalls your choices when the computer is

restarted. This is called a delayed apply.
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Note: If there is no DHCP service available and you have stored your recovery

points to a network drive, a delayed apply will not work because the computer

name cannot be resolved to the IP address.

To resolve this issue, boot directly into the recovery environment and restore the

recovery point from there using a static IP address.

See “About recovering a computer ” on page 131..

When a drive cannot be found after a failed or cancelled recovery job

When you cancel a recovery job in the middle of the recovery process, in most

cases, the destination partition (or drive) is already created (or deleted if it was

pre-existing), but a drive letter has not been assigned to it. Because a drive letter

has not yet been assigned, the drive will not be displayed in either Norton Ghost

or Windows Explorer.

Norton Ghost is designed to keep drive letter assignments intact when you restore

the drive. It does not assign a drive letter if the destination drive did not have a

drive letter to begin with, when you restore a recovery point.

At the time you canceled the recovery, the drive did not yet have the drive letter

assigned to it. As a result, when you successfully restored the entire drive to the

same destination a second time, Norton Ghost detected that the drive did not have

a drive letter assignment, and therefore kept that assignment intact. A drive with

no drive letter will not display in Norton Ghost or Windows Explorer. However,

the data that is contained in the recovery point that you use to recover is

completely restored.

You can fix this display issue by manually assigning a drive letter to the drive by

using a tool such as Microsoft’s Disk Management console.

Troubleshooting the recovery environment
To help you resolve problems while you use the Symantec Recovery Disk (the

recovery environment) or to solve issues while you recover data with Symantec

Recovery Disk, review the following information.

■ See “How Symantec Recovery Disk works” on page 167.

■ See “Starting a computer from the CD drive ” on page 171.

■ See “You cannot access the local drive where your recovery points are saved

” on page 172.

■ See “A warning message indicates that Windows might not run correctly

because of insufficient memory” on page 173.
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■ See “Your recovery point is on CD, but you cannot use the drive because the

Symantec Recovery Disk CD is running the recovery environment” on page 173.

■ See “Finding your network from the recovery environment” on page 174.

■ See “USB devices in the recovery environment” on page 174.

■ See “Using the pcAnywhere thin host for a remote recovery” on page 174.

■ See “Mapping a network drive in the recovery environment” on page 176.

■ See “Getting a static IP address ” on page 177.

■ See “Workgroups and restoring ” on page 178.

■ See “Restoration of a recovery point in a workgroup environment ” on page 179.

■ See “Restoration of a DHCP server ” on page 179.

■ See “Setting the time zone and then exiting the recovery environment”

on page 179.

■ See “Using a SAN” on page 180.

■ See “Using dual-ported fibre channel cards” on page 180.

■ See “Wireless devices” on page 180.

■ See “Viewing your IP address or other configuration information” on page 180.

■ See “Restoring after setting encryption on an NTFS volume” on page 180.

■ See “Using the recovery environment to perform multiple restorations to the

same location” on page 181.

How Symantec Recovery Disk works

Symantec Recovery Disk makes restoring data possible under most computer

disasters, provided you have access to a working recovery point. Occasionally, a

computer failure can leave the operating system intact but still prevent you from

restoring your computer to working order. Or, a computer failure can leave the

operating system inoperative, making a restoration impossible. For these types

of situations, you can restore a recovery point using Symantec Recovery Disk.

Note: Depending on which version of the product you have purchased, the

Symantec Recovery Disk is either included on your product CD, or as a separate

CD. You should place the CD containing the Symantec Recover Disk in a safe place.

Should you lose the CD, you can create a new one, provided you have a CD burner.
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In the recovery environment, you can run, among other tools, the Recover My

Computer Wizard (to restore a drive, including your system drive) or the Recovery

Point Browser (to perform a file-level restore).

When the Recover My Computer Wizard finishes, you can restart the computer

into a previous, usable state.

See “Starting a computer by using the recovery environment ” on page 132.

Using the support utilities

When you are running under the recovery environment, there are several support

utilities available (under the Utilities and Network panels) that you can run to

troubleshoot networking or hardware issues you may encounter. For example,

you can ping a computer, renew IP addresses, or get information about a hard

drive partition table.

Symantec Technical Support may require information generated by these utilities,

if you call Symantec for help resolving problems.

Table B-1 describes the support utilities that are available in the recovery

environment.

Table B-1 Support utilities

DescriptionSupport utilityPanel

Use to load the necessary network

drivers on your computer so you

can access network-stored recovery

points.

Start Networking ServicesNetwork

Use to start pcAnywhere thin host

to establish a remote control

session for use by a remote

computer that connects through

Symantec pcAnywhere. When

selected, starts Networking

services, if necessary.

See “Using the pcAnywhere thin

host for a remote recovery”

on page 174.

Start pcAnywhere thin hostNetwork

Use to map a network drive.

See “Mapping a network drive in

the recovery environment ”

on page 146.

Map Network DriveNetwork
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Table B-1 Support utilities (continued)

DescriptionSupport utilityPanel

Use to configure network addresses

for a network card.

See “Getting a static IP address ”

on page 177.

Configure IP AddressNetwork

Use the IPConfig utility to view

network adapter information. You

can also release or renew IP

addresses with this utility.

You can save the information to a

text file (ipconfig.txt), which can

then be sent to technical support,

if necessary.

Run IPConfig UtilityNetwork

Use to see if the remote computer

(where the recovery point is

located) is available and network

connections to that computer are

intact and functioning.

Ping Remote ComputerNetwork

Use to automatically set the

network interface card (NIC) on the

computer to the highest speed

possible.

If you want to use a recovery point

that is stored on a network, you can

run this utility (while network

services are running) before you

restore data. This setting helps

ensure maximum throughput of the

recovery point data across the

network.

Set Network Card SpeedNetwork

Use to edit the boot.ini directly

from the recovery environment.

See “Editing the boot.ini file”

on page 176.

Edit boot.iniUtilities

169Troubleshooting Norton Ghost
Troubleshooting the recovery environment



Table B-1 Support utilities (continued)

DescriptionSupport utilityPanel

Use this tool under the direction of

Symantec Technical Support to

gather information about various

system operations for

troubleshooting purposes.

Support ToolUtilities

Use to view information about the

hard drive on the computer.

You can save the information to a

text file (smedump.txt), which can

then be sent to technical support,

if necessary.

Display SME Disk InformationUtilities

Use to create a report of the

contents of your hard drive's

partition table. This report can help

you diagnose and fix various disk

partition problems.

You can save the information to a

text file, which can then be sent to

technical support, if necessary.

View Partition InformationUtilities

Use to read and allow manipulation

of the partition table information

in the Master Boot Record and

EPBR Boot Record. This utility is

useful for fixing partition table

errors or boot sector problems.

Note: This utility should only be

used under the guidance of

Symantec Technical Support.

Edit Partition TableUtilities

Use to switch between bootable

primary partitions. This utility is

for users who only occasionally

need to change the active partition.

This utility makes the partition

active and restarts the computer.

Change Active PartitionUtilities
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Table B-1 Support utilities (continued)

DescriptionSupport utilityPanel

Use to save or restore critical

Master Boot Record (MBR)

information in the first sector of a

hard drive. The contents of the first

sector or entire first head of the

hard drive are saved or restored to

a file.

Restore Master Boot RecordUtilities

To use the support utilities

1 In the recovery environment main window, click Utilities or Network.

2 Select the support utility that you want to run.

See “Starting a computer by using the recovery environment ” on page 132.

Starting a computer from the CD drive

To run the recovery environment, you must be able to start your computer from

the Symantec Recovery Disk CD.

Note: Depending on which version of the product you have purchased, the SRD

is either included on your product CD, or as a separate CD. You should place the

CD containing the SRD in a safe place. Should you lose the CD, you can create a

new one if you have have a CD burner.

See “If driver validation fails” on page 19.

To start your computer from the Symantec Recovery Disk CD

1 Turn on your computer.

2 While the computer is starting, watch for a prompt that tells you how to

access the BIOS. Generally, you need to press the Delete key or a function

key.
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3 From the BIOS screen, choose the Boot menu.

Note: The term boot refers to the location where software required to start

a computer is stored. The Symantec Recovery Disk contains a simple version

of the Windows operating system. By changing the boot sequence of your

computer to your CD drive, the computer can then load this version of

Windows. Boot is also used synonymously with start.

4 Change the CD or DVD drive to be the first bootable device in the list.

5 Save the changes and exit the BIOS setup.

When you start your computer with the Symantec Recovery Disk CD in the

drive, you will see a prompt telling you to “press any key to boot from CD”.

If you do not press a key, your computer will attempt to start from the next

bootable device listed in the BIOS. There is only a short delay when the prompt

to press a key is displayed, so you need to watch carefully as the computer

starts.

6 Press a key to start the recovery environment.

You cannot access the local drive where your recovery points are saved

You might need to load the drivers for the storage device in which your recovery

points are saved. Drivers can be loaded once the recovery environment is started.

Note: If you do not have the drivers available from the device manufacturer and

they are not included as part of the recovery environment, you will not be able to

use that drive. Consider running the Create Recovery Disk option to create a

recovery disk that contains all of the required drivers for your computer hardware.

See “If driver validation fails” on page 19.

To load a driver for a local drive from within the recovery environment

1 Start your computer by using the Symantec Recovery Disk CD.

2 Once the recovery environment starts, clickLoadaDriver on the Home panel.

3 Browse to the folder containing the required driver, select the driver, and

then click Open.
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You cannot access or see the USB device where your recovery points
are saved

You must plug in the USB device before you reboot into the recovery environment.

If you did have the device plugged in, you might need to manually assign a drive

letter to the device.

If you still cannot see the USB device, you can manually assign a drive letter to

it.

To assign a drive letter to a USB device in the recovery environment

1 From within the recovery environment, click Analyze.

2 Click Open Command Shell Window.

3 At the command prompt, do the following:

■ Type diskpart, and then press Enter.

■ Type listvol, and then press Enter.

Identify the USB drive in the resulting list.

■ Type select voldrivenumber, where drivenumber is the number assigned

to the USB drive, and then press Enter.

■ Type assign, and then press Enter.

A warning message indicates that Windows might not run correctly
because of insufficient memory

The recovery environment requires a minimum of 512 MB of RAM to run (768

MB if you have installed the multilingual version of the product). If your computer's

video card is configured to share your computer's RAM, you might need more

than 512 MB of RAM to use the recovery environment.

If you are not sure, you can continue. If you have difficulties using the recovery

environment, you might need to upgrade your computer's memory.

Your recovery point is on CD, but you cannot use the drive because
the Symantec Recovery Disk CD is running the recovery environment

When you restore data from a recovery point that is stored on a CD or DVD from

the recovery environment and you only have one CD or DVD drive, you must leave

the Symantec Recovery Disk CD in that drive until after you have clicked Browse

to locate a recovery point. After the Open dialog box has displayed, remove the

Symantec Recovery Disk CD and insert the media that contains the recovery point.
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If you remove the Symantec Recovery Disk CD before you click Browse, the

recovery environment will exit back to the recovery environment main window.

Finding your network from the recovery environment

If you click Browse and cannot see or browse the network from the Open dialog,

try the following procedure.

To find your network from the recovery environment

1 In the File name box, type the name of the computer and drive or share that

holds your recovery points.

For example: \\computer_name\drive_name

2 Press Enter.

3 Select a recovery point, and then click Open.

If you are still unable to see your network after you type the computer name

and drive name, you might need to map a drive and log on as a different user

to see and browse the network.

See “Mapping a network drive in the recovery environment ” on page 146.

USB devices in the recovery environment

To enable a USB device while you are in the recovery environment, you must first

attach the device, and then restart the computer in the recovery environment.

If you can't find your USB device, but you attached it before rebooting into the

recovery environment, see “You cannot access or see the USB device where your

recovery points are saved” on page 173..

Using the pcAnywhere thin host for a remote recovery

Using the Symantec Recovery Disk, you can host a remote control session by

starting pcAnywhere Thin Host. Once started, the thin host waits for a connection

that can be used to remotely manage a recovery or perform other tasks in the

recovery environment.

To connect to the thin host, you must use Symantec pcAnywhere on a remote

computer.

The pcAnywhere Thin Host contains the minimum settings needed to support a

single-use remote control session. The thin host requires an IP address for hosting

a remote control session.

Troubleshooting Norton Ghost
Troubleshooting the recovery environment

174



Note: A thin host cannot be deployed to the recovery environment. The thin host

can only be started from Symantec Recovery Disk to host a remote control session.

The thin host in Symantec Recovery Disk does not support file transfers and

cannot be used to add drivers for network or storage devices.

To start pcAnywhere Thin Host

◆ In the recovery environment main window, click the Home pane, and then

click Start the pcAnywhere ThinHost.

If they haven't been previously started, the Networking services are started.

The thin host establishes a connection.

Connecting remotely to the pcAnywhere Thin Host

Symantec pcAnywhere can be used on a computer to remotely connect to a

computer that has already started the recovery environment and the pcAnywhere

Thin Host. After you are connected, the client computer can remotely manage a

recovery or perform other tasks supported in the recovery environment.

Note: The client computer cannot transfer files or add additional drivers for

network or storage devices on the computer running the thin host.

To connect remotely to the pcAnywhere Thin Host

1 Ensure that the computer to be remotely managed (the host) has been booted

into Symantec Recovery Disk and that pcAnywhere Thin Host has been started

and is waiting.

2 Obtain the IP address of the thin host computer.

3 On the client computer, in Symantec pcAnywhere, use the Remote Setup

Wizard to configure the remote control session.

■ Specify a TCP/IP connection type.

■ Specify the IP address of the host computer.

■ Choose to automatically login to the host on connection.

■ Type the following login name:

symantec

■ Type the following password:

recover

The thin host shuts down when there is an attempt to connect using any

incorrect configuration settings.
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The thin host does not support encryption.

To prevent unauthorized users from tampering with your settings or

launching a session without your permission, set a password for your remote

connection item using the Protect Item properties page in Symantec

pcAnywhere.

4 Start the remote control session.

If the connection attempt is unsuccessful, you have three tries before the

thin host must be restarted on the host computer before making another

attempt to connect.

5 Remotely perform necessary tasks on the host computer.

The remote control session ends when the thin host is closed, the thin host

computer is restarted, or when the remote control session is ended.

After the host computer has started the Windows operating system, the client

computer can deploy and connect a thin host on the computer to verify the

success of tasks that were performed while using the recovery environment.

Mapping a network drive in the recovery environment

The following information applies only if you started networking services when

you started the recovery environment.

If you attempt to boot directly into the recovery environment when there is no

DHCP server (or the DHCP server is down), you are prompted to enter a static IP

address and a subnet mask address for the computer on which you are running

Symantec Recovery Disk.

After you provide the static IP address and subnet mask address, you can access

the recovery environment. However, because there is no way to resolve computer

names, when you run the Recover My Computer Wizard or the Recovery Point

Browser, you can browse the network by using IP addresses to locate a recovery

point. To resolve this issue, you can map a network drive.

See “Mapping a network drive in the recovery environment ” on page 146.

Editing the boot.ini file

If necessary, you can edit the boot.ini file directly from the recovery environment.

Note: You cannot edit the boot.ini file on Windows Vista. This section only refers

to Windows 2000, Windows XP, and Windows Server 2003.
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The boot.ini is a Microsoft initialization file that is found in the root directory of

your primary boot drive (usually the C partition). The file is used by Microsoft

Windows to display a menu of operating systems that are currently installed on

a computer. You can then select which operating system to boot. The boot.ini is

also used to point to the locations of each operating system on the computer.

For more information about editing the boot.ini file on a particular Windows

operating system, see the following Microsoft Knowledge Base article IDs on the

Microsoft Web site:

■ 289022 (for Windows XP)

■ 311578 (for Windows 2000)

To edit the boot.ini file

1 In the recovery environment main window, click Utilities.

2 Click Edit Boot.ini File to open the file in a plain text editor.

3 Make the changes you want and save the file.

Getting a static IP address

If you want to restore a recovery point that is located on a network drive or share,

but you are unable to map a drive or browse to the drive or share on the network

(usually caused by the lack of an available DHCP service), you can assign a unique

static IP address to the computer that is running the recovery environment. You

can then map to the network drive or share.

The Network Configuration dialog is automatically displayed if there is no DHCP

service available when you start the recovery environment. However, if it does

not display, you can open it from the recovery environment.

To display the Network Configuration window

◆ In the recovery environment main window, on the Network pane, click

ConfigureNetwork Connection Settings.

If you are prompted to start networking services, click Yes.

To get a static IP address

1 In the Network Configuration window, click Use the following IP address.

2 In the Network Adapter Configuration dialog box, specify a unique IP address

and subnet mask for the computer that you want to restore.

Be sure that the subnet mask matches the subnet mask of the network

segment.

3 Click OK.
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4 Click Close to return to the recovery environment main menu.

5 In the Network panel, click Ping aRemote Computer.

6 Specify the address of a computer that you want to ping.

For example: 168.212.226.204

7 Click OK.

If communication to the storage computer is operating as expected, you can

use the Map a Network Drive utility to map a drive to the recovery point

location.

To get an IP address if the ping is unsuccessful

1 On the computer that holds the recovery point that you want to restore, at a

DOS prompt, type the following command, and then press Enter:

ipconfig /all

2 Write down the IP address that is displayed.

3 Return to the computer that is running the recovery environment and run

the utility Ping Remote Computer by using this IP address.

To map a network drive

1 In the recovery environment main window, on the Network pane, click Map

a network drive.

2 In the Drive drop-down list, select a drive letter.

3 In the Folder text box, type the IP address of the storage computer and the

drive in which the recovery point is located.

For example: \\IP_address\drive_name\

4 Click Connect using a different user name.

5 In the User name box, type the IP address and user name.

For example: IP_address\user_name

6 In the Password text box, type the password for the user name.

7 Click OK.

You should now have a drive mapped to the recovery point location on the

storage computer.

Workgroups and restoring

To mount computers that are located in other workgroups or domains while

running Symantec Recovery Disk, you must already have WORKGROUP present
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on the network. It must already be authenticated to the domain by mapping the

drive so that the WORKGROUP server is able to share across the network.

Restoration of a recovery point in a workgroup environment

When you use Norton Ghost 12.0 in a workgroup environment (such as a small

office/home office) that is not part of a network domain, you typically do not have

a DHCP, DNS, or WINS service to manage the assignment of dynamic IP addresses.

Instead, you most likely have a static IP address that is assigned to each computer.

Not having a dynamic IP address is not a problem when you want to restore a

recovery point while running the recovery environment.

For example, suppose you have a small office workgroup environment with two

computers. You would make sure that both computers have the same login user

name and password.

When you want to restore computer 1 by using a recovery point that is stored on

computer 2, you do the following:

■ boot into Symantec Recovery Disk on computer 1

■ map a network drive to computer 2

■ browse to the recovery point (or a file within the recovery point if you are

using the Recovery Point Browser)

■ restore as usual

If you use a delayed apply, you are prompted for the user name, password, and

domain name. This behavior occurs because computer 1 is trying to authenticate

to computer 2 where the recovery point is stored. You must provide the workgroup

name for the domain name or the IP address for computer 2.

Restoration of a DHCP server

You cannot restore a DHCP server from a recovery point that is stored on the

network. The recovery environment must get an IP address from the DHCP server.

If the computer you are restoring is the DHCP server from which the recovery

environment is trying to get a dynamic IP address, the task will be unsuccessful.

Specify a static IP address manually.

Setting the time zone and then exiting the recovery environment

When you set the time zone in the main window of the recovery environment, be

sure that you exit the recovery environment properly by clicking Exit in the main

window as well. This ensures that the computer's CMOS clock remains unchanged
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(or is reset to its original time). Do not exit the recovery environment by pressing

the computer's restart button.

Using a SAN

If you use a SAN without a local disk drive and the operating system and the data

partitions run from the SAN over Emulex fibre channel cards, you might not be

able to restore an entire recovery point. You can, however, use the Recovery Point

Browser to restore individual files from the recovery point.

Using dual-ported fibre channel cards

If you use dual-ported fibre channel cards that are connected for redundancy, you

should disconnect one channel before you attempt to restore a recovery point by

using Symantec Recovery Disk.

Wireless devices

The Symantec recovery environment does not support wireless devices. If you

need to recover files, folders, or your computer from recovery points that you

normally access from Windows over a wireless network, you must connect the

storage device that contains your recovery points directly to your computer using

either a network or USB cable.

Viewing your IP address or other configuration information

You can view your IP address or any other configuration information from the

recovery environment.

To view your IP address and other configuration information

1 On the Network page of the Symantec Recover Disk, click Run IP Config

Utility.

2 Click View.

Restoring after setting encryption on an NTFS volume

If you set encryption on an NTFS volume, you cannot restore it until you unencrypt

it. Attempts to restore an encrypted file will result in an Access is Denied error

message.
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Using the recovery environment to perform multiple restorations to
the same location

If you use the Symantec recovery environment to perform multiple restorations

to the same location, you must reboot in between each restore.

Troubleshooting drives on Windows
For more information about basic and dynamic volumes, see the Microsoft Disk

Management Help file (DISKMGMT.CHM).

The default location for the Microsoft help file is as follows:

■ \WINDOWS\HELP

For Windows 2000 Professional or Windows XP Professional.

■ On Windows Vista, access Help and Support for information about disk

management.

Troubleshooting error messages
The troubleshooting error messages that you may see are described in the following

sections:

■ See “Recovery Point Browser error messages” on page 181.

■ See “General error messages ” on page 182.

For more information, go to the following URL and perform a search:

http://www.symantec.com/enterprise/index.jsp

You can review additional information about troubleshooting errors in the

pushlog.txt file or in the product interface when you deploy the agent.

See “Norton Ghost agent and Windows Services ” on page 188.

Recovery Point Browser error messages

Table B-2 provides information about errors that you might encounter while using

the Recovery Point Browser and how to resolve those errors.
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Table B-2 Recovery Point Browser error messages

DescriptionError

Norton Ghost 12.0 was unable to initialize the COM

subsystem. This error can be caused by insufficient

resources or corrupt DLLs. Restart the system, and

try to free system resources.

Cannot initialize COM library

Norton Ghost 12.0 was unable to allocate resources

for the Symantec mount manager. This error is

usually reported when Norton Ghost is partially

installed or some of its COM objects are missing or

incorrectly registered.

To correct this condition, reinstall Norton Ghost

12.0.

Cannot allocate Norton Ghost 12.0

mount manager instance

The Symantec mount manager did not recognize

the drive as a mounted recovery point. This error

is most commonly reported when another process

is attempting to unmount the drive. The error may

also occur if the drive is corrupt.

Close all disk management programs, and try again

to unmount the drive. If the problem persists,

restart the computer to allow Windows to

re-enumerate all mounted drives.

Cannot retrieve drive information

The Symantec mount manager was unable to

unmount the drive.

To resolve the error, make sure there are no open

files on the drive and that the drive is not locked by

another application.

Cannot dismount drive. Please verify

the drive is not locked by another

process

General error messages

Table B-3 provides information about the general error messages that you might

encounter while using Norton Ghost 12.0 and possible solutions.

Table B-3 General error messages

DescriptionError

Cannot create recovery points for job: Recovery point of drive.

For a solution, visit Knowledge Base document ID 2005111019380362.

EC8F17B7
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Table B-3 General error messages (continued)

DescriptionError

Cannot create a virtual volume image.

If the error continues, contact technical support. You might also need

additional log files, for example, .txt files from the Agent folder.

See “Using the support utilities ” on page 168.

E0710007

This error might also display one of the following:

■ Object BasicDisk SME~Computer~BgM896453 was in the saved state but

is not in the current state.

■ Object MediaCommon:Sme~computer ~Pd1~M896453 was in the saved

state but is not in the state.

These error messages could be caused by changes to the serial number. It

could also be caused by the drive information reporting differently.

If the restore was initially set up in Windows, but the computer was restarted

in the recovery environment, try going through the Recover My Computer

Wizard in the recovery environment. There could be a change in the drive

information in Windows 2000 compared to the recovery environment.

If the error continues to occur during the use of the Recover My Computer

Wizard from the recovery environment, you should contact Symantec

Technical Support.

E0B000C

Cannot lock volume “\\volume_name” because it contains the operating

system or it has an active paging file.

Norton Ghost 12.0 can back up operating system partitions and other

partitions that contain page files. This error is usually caused by a driver

conflict with another application that might have control of the partition.

Check for other applications that might have a lock on the drive and

temporarily turn off any suspected conflicting drivers, and then run Norton

Ghost 12.0 again to create the recovery point.

E0BB001B

If the error occurs when attempting to restore a drive (partition), delete the

existing drive first.

For a solution, visit Knowledge Base article ID 2004087365529862.

If the error occurs when attempting to back up the drive, contact Symantec

Technical Support.

E0BB0097
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Table B-3 General error messages (continued)

DescriptionError

The saved initial state for applying changes does not match the current

system state.

You should try restoring by using Symantec Recovery Disk.

■ This error can also be caused by fibre channel devices.

Disconnect the devices to confirm whether they are causing the problem.

■ This error can also be caused by Emulex controllers. Occasionally, there

are phantom volumes or partition table errors that can cause this error.

For a solution, visit Knowledge Base article ID 2004077013504262.

E0BC000A

This error can occur if you do not have the correct rights. However, it could

also be caused by slow bandwidth, dropped packets, or other network-related

issues.

For a solution, visit Knowledge Base article ID 2004040324101662.

E7D1001F

Run the Windows chkdsk utility on the source drive before you copy or create

a recovery point. If you cannot run the utility, and you have confirmed that

the recovery point is valid, you can bypass the error by deselecting the option

to Check file system after restore. After the recovery completes, run chkdsk

on the drive to eliminate any file system errors.

E926001F

Insufficient permissions.

For example: System A is running Norton Ghost 12.0. System B is running

the Norton Ghost 12.0 Agent service, and system C contains the drive in

which the recovery points are stored.

The user who logs onto system A must have at least local administrator rights

on system B to create a recovery point. The user also needs rights to the

location in which the recovery point is being stored and needs domain user

rights to save to the network.

In a domain, you should create one user with Domain Admins and

Administrator rights. Use this account to log in to system A. On system B,

the Norton Ghost 12.0 Agent service should be logging in with the same

account. Determining when this error occurs can help identify where

permissions are not set correctly.

In a workgroup, you should create duplicate accounts (using the same user

name and password) on each computer. Make sure that each account has

local administrator rights. Log on with this account when managing other

agents in the workgroup.

EA390019
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Table B-3 General error messages (continued)

DescriptionError

If you are using Veritas DLA, you might encounter this error which indicates

that the internal structure of the v2i file is invalid or unsupported.

Despite this error, the recovery point on the disk is still valid. To correct this

issue, you can use a regular CD or DVD drive to read the recovery point, or

you can remove Veritas DLA from the computer so that the CD can be properly

read.

This error can also occur for one of the following reasons:

■ The recovery point is damaged or corrupted.

Damage can occur when you create a recovery point over a network and

there is significant packet loss during the creation of the recovery point.

Symantec recommends that you verify recovery points after they are

created to ensure their integrity.

Create a new recovery point to a different location, or create a new

recovery point with a different file name to the same location.

■ The recovery point is fine, but there may be a conflict with spyware

detection software (such as Pest Control or Spybot) that causes the

recovery point to become corrupt or appear to be corrupted.

While using Norton Ghost or the Recovery Point Browser, you should turn

off all spyware detection software.

■ You copied a recovery point from one FireWire drive to another FireWire

drive while connected to a FireWire expansion card that uses a Via chipset

(such as the Kouwell card).

To work around this issue, replace your Via-based FireWire expansion

card with a card that uses a non-Via chipset (such as the Adaptec 4300

Fireconnect, which uses a TI chipset).

EA39070A

This error is usually caused by insufficient rights to the Norton Ghost 12.0

Agent service. A user must have administrator and domain administrator

rights on the sub-share folder. Check that the Norton Ghost 12.0 Agent

services Log On information is correct.

EA390712
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Table B-3 General error messages (continued)

DescriptionError

Cannot read data from drive. An unknown exception has occurred.

This error is reported when you attempt to save a recovery point to a SAN

drive or to removable media, or when you attempt to restore a recovery point

from the recovery environment.

If you are saving a recovery point to a SAN drive, check Disk Management

for missing or old volumes. If you are saving a recovery point to removable

media, insert disks into the drive. If that does not work, disconnect the

removable media drive and remove any attached USB devices.

If you are using Samba shares, be sure you have the basic rights on the Samba.

If you are saving the recovery point to NAS, check the operating system that

is installed. There could be an issue with Linux or with proprietary operating

system NAS devices.

EBAB001A

This error is caused by updated firmware on QLogic drives conflicting with

the QLogic driver on the Norton Ghost 12.0 CD. In other cases, it could also

be caused by any SCSI conflict with particular drivers on the Norton Ghost

12.0 CD.

Try loading the driver manually.

See “You cannot access the local drive where your recovery points are saved

” on page 172.

If the error continues, do the following:

■ Run the recovery environment support utilities Display SME Disk

Information.

■ View Partition Information.

■ Obtain your system information.

■ Contact technical support.

You might also need additional log files.

See “Using the support utilities ” on page 168.

EC8A0001

The error is usually caused by a driver conflict with another application that

has control of the drive. Check for other applications that might have a lock

on the drive. Temporarily turn off any suspected conflicting drivers, and run

Norton Ghost 12.0 again.

EC8F0007

Check that the driver is present and that the Norton Ghost 12.0 Agent service

is started.

EC8F000C

This error occurs when the driver for the storage controller does not load in

Symantec Recovery Disk. Restart the computer by using Symantec Recovery

Disk and press F6 to load the necessary drivers.

EC950001
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Table B-3 General error messages (continued)

DescriptionError

This error might be caused by a conflict with another program.

Contact Symantec Technical Support.

Catastrophic error

This error is an issue with the network interface card (NIC) driver not loading.

If the recovery point you want to restore is located on the network, you should

first try a different NIC card. If that is unsuccessful, you should send the

drivers and a system information file to Symantec Technical Support.

WinBOM error when booting from

recovery environment

This error is an issue with some international servers.

Send the .pqh files to Symantec Technical Support.

The month and year are switched on

some international computers

For more information, go to the following URL and search on the generated error

code:

http://www.symantec.com/enterprise/index.jsp

General troubleshooting
The following suggestions can help you resolve problems that you encounter while

using Norton Ghost 12.0:

■ See “How to break up an existing recovery point file into a spanned file set ”

on page 187.

■ See “How to test the scheduling feature without actually creating a schedule”

on page 188.

How to create recovery points directly to tape

Norton Ghost 12.0 does not write recovery points directly to tape. However, you

can create a recovery point and save it to the network. You can then transfer the

recovery point file to a tape drive or burn it to a CD or DVD. To restore the recovery

point from tape, you must copy the files back to a local or network drive before

restoring.

How to break up an existing recovery point file into a spanned file set

You can use the Copy Recovery Point feature in the Recovery Point Browser.

See “Making copies of recovery points ” on page 109.
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When you copy a recovery point, you can select the option to Divide into smaller

files for archiving. For example, if you plan to copy a recovery point to a CD at a

later time, specify a file size of 700 MB or less.

How to test the scheduling featurewithout actually creating a schedule

To test the scheduling of a backup job, stop the Norton Ghost service in the

Microsoft Services console. Change the date forward on the computer to a time

when you would like the scheduled recovery point to occur, and then restart the

Norton Ghost service. If the date on the computer is changed while the Norton

Ghost service is running, the change will not be noticed by the agent.

Note: If you add a new partition to the hard drive, it may take several seconds

before the new partition appears as a drive in Norton Ghost.

Norton Ghost agent and Windows Services
The Norton Ghost agent runs as a service rather than as a desktop application.

Running the agent as a service allows scheduled backups to run even if no one or

a user with insufficient rights is logged on to the computer.

Because the agent runs as a service, you can use the Services tool in Windows if

you need to start or stop the service, configure the password, or troubleshoot the

agent. If the agent does not start on a computer, you will encounter problems

when you create and restore recovery points.

You can use the Services tool, to manage the agent in the following ways:

See “Starting, stopping, or restarting the agent service ”

on page 190.

Start, stop, or turn off the

agent on local and remote

computers

See “Adding users who can back up your computer ”

on page 71.

Configure the user name and

password that is used by the

agent

For example, you can restart the agent automatically or

restart the computer.

See “Setting up recovery actions when the agent fails to

start” on page 191.

Set up recovery actions to

take place if the agent fails

to start
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Viewing the status of an agent

There are several methods you can use to open Services to view the status of the

agent. Use the method that is most convenient for you.

To view the status of the agent

1 On the Windows taskbar, do one of the following:

■ Click Start > Settings >Control Panel >AdministrativeTools >Services.

In Windows XP, click Start > Control Panel > Performance and

Maintenance >Administrative Tools, and then double-click Services.

In Windows Vista, click Start > Control Panel > Classic View, and then

double-click Administrative Tools.

■ Click Start >Run.

In the Open text field, type services.msc, and then click OK.

In Windows Vista, the Run command is hidden by default. To show the

Run command, do the following:

■ Right-click the Start button, and click Properties.

■ On the Start Menu tab, click Customize.

■ Scroll down and check Run command.

■ Click OK.

See “Starting, stopping, or restarting the agent service ” on page 190.

2 In the Name column, scroll through the list of services until you see Norton

Ghost (the name of the agent).

Its status should be set as Started.

Best practices for using services

The agent service is a critical component for creating recovery points. To minimize

problems with the agent, you should take the following steps:

The event log should be the first place you check when

tracking down the source of a problem, particularly when

it is associated with the agent. Selecting the most recent log

entries often gives you information about what is causing

the problem.

Check the event log first

before using Services.
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When the agent is installed on a computer, it is configured

to start automatically when Norton Ghost starts.

You can test that the agent is starting automatically by

looking in Services, checking the status, and then restarting

the service if necessary. If the Startup type is set to

automatic, you should try starting the agent again.

See “Starting, stopping, or restarting the agent service ”

on page 190.

Verify that the agent is

starting without user

intervention.

Changing the default settings for services might prevent

key services from running correctly. It is especially

important to use caution when changing the Startup Type

and Log On As settings of services that are configured to

start automatically.

Changing the default agent properties can prevent Norton

Ghost from running correctly. You should use caution when

changing the default Startup type and Log On settings of

the agent. It is configured to start and (typically) log on

automatically when you run Norton Ghost.

Use caution when changing

default settings for the agent.

Starting, stopping, or restarting the agent service

To start, stop, or restart the agent service, you must be logged on as an

administrator. If your computer is connected to a network, network policy settings

might also prevent you from completing this task.

Some instances of when you might need to start, stop, or restart the agent service

are as follows:

If Norton Ghost is unable to connect to the agent on a

computer.

Start or Restart

If you have just changed the user name or password that

you use to log on to the agent service, or you used the

Security Configuration Tool to give additional users the

ability to back up computers.

See “Adding users who can back up your computer ”

on page 71.

Restart

If you believe the agent is causing a problem on the

computer or if you want to temporarily free memory

resources. If you have defined a backup, note that stopping

the agent will prevent recovery points from being created

at the scheduled times.

Stop
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See “Viewing the status of an agent” on page 189.

To start, stop, or restart the agent service

1 In the Services window, under Name, click NortonGhost.

2 Do one of the following:

Starts the agentClick Action > Start

Stops the agentClick Action > Stop

Restarts the agentClick Action >Restart

Stopping the agent service prevents you from creating or restoring recovery

points from Norton Ghost.

If you stop the agent service and then start Norton Ghost, the agent restarts

automatically.

If you stop the agent service while Norton Ghost is open, you receive an error

message and Norton Ghost is disconnected from the agent.

Setting up recovery actions when the agent fails to start

You can specify the computer's response if the agent fails to start.

See “Viewing the status of an agent” on page 189.

To set up recovery actions when the agent fails to start

1 In the Services window, under Name, click NortonGhost.

2 Click Action > Properties.

3 Click Recovery.

4 In the First failure, Second failure, and Subsequent failure drop-down lists,

select one of the following actions:

Specify the number of minutes to pass before an

attempt to restart the service is made.

Restart the Service

Specify a program to run. You should not specify any

programs or scripts that require user input.

Run a Program

Specify how long to wait before restarting the

computer. You can also create a message that you want

to display to remote users before the computer restarts.

Restart the Computer
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5 In the Reset fail count after text box, specify the number of days that the

agent must run successfully before the fail count is reset to zero.

When the fail count is reset to zero, the next failure triggers the action set

for the first recovery attempt.

If you want the agent to run correctly for several weeks between failures, you

should specify a large number.

6 Click OK.

Viewing agent dependencies

The agent depends on other required services to run properly. If a system

component is stopped or is not running properly, dependent services can be

affected.

If the agent fails to start, you should check the agent dependencies. Check the

dependencies to ensure they are installed and that their Startup type is not set

to Disabled.

The top list box on the Dependencies tab displays the services that are required

by the agent to run properly. The bottom list box does not have any services that

need the agent to run properly.

The following services are required by the Norton Ghost agent to run properly:

AutomaticEvent Log

AutomaticLogical Disk Manager

AutomaticRemote Procedure Call (RPC)

See “Viewing the status of an agent” on page 189.

To view agent dependencies

1 In the Services window, under Name, click NortonGhost.

2 Click Action > Properties.

3 Click Dependencies.

Troubleshooting issues with deploying the agent

The following errors might appear in the pushlog.txt file or in the product

interface.

■ Attempt to connect to remote computer failed

■ Attempt to copy RemoteCmdSvc.exe to remote computer failed
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■ Attempt to access the remote Service Control Manager failed

■ Attempt to create the RemoteCommand Service on the remote computer failed

■ Attempt to start service on the remote computer failed

■ Attempted connection to RemoteCmdSvc on remote computer failed

■ Attempt to push package to remote computer failed due to an invalid

environment

■ Attempt to copy package failed

■ Attempt to communicate with RemoteCommand Service on remote computer

failed

■ Remote command failed to start

■ Attempt to restart remote computer failed

■ Attempt to delete package failed

■ RPC server unavailable

Attempt to connect to remote computer failed

The product was unable to establish a network connection to the requested

computer. This error is usually reported when the current user does not have

administrative privileges on the remote computer. This error might also occur if

network communication problems exist or if the Windows Firewall is not

configured to allow remote deployment of the agent.

Attempt to copyRemoteCmdSvc.exe to remote computer failed

The product was unable to copy the remote service executable (RemoteCmdSvc.exe)

to its destination on the remote computer. This error is usually reported when

the product cannot find the RemoteCmdSvc.exe source, or it is unable to write to

the destination computer's Admin$\temp directory.

Attempt to access the remote Service Control Manager failed

The product was unable to connect to the Service Control Manager on the remote

computer. This error is usually reported when the current user does not have

administrative privileges on the remote computer. This error might also occur if

network communication problems exist.

Verify that the current user has appropriate administrator privileges on the remote

computer.
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Attempt to create theRemoteCommandService on the remote
computer failed

The product was unable to connect to the RemoteCmdSvc service on the remote

computer. This error is usually reported when the RemoteCmdSvc is already

running on the remote computer.

To correct the problem, either restart the remote computer or manually stop and

remove the RemoteCmdSvc service from the remote computer.

Attempt to start service on the remote computer failed

The product was unable to start the RemoteCmdSvc service on the remote

computer. This error is usually reported when the RemoteCmdSvc is already

running on the remote computer.

To correct the problem, either restart the remote computer or manually stop and

remove the RemoteCmdSvc service from the remote computer.

Attempted connection toRemoteCmdSvcon remote computer
failed

The product was unable to start the RemoteCmdSvc service on the remote

computer. This error is usually reported when the RemoteCmdSvc is already

running on the remote computer.

To correct the problem, either restart the remote computer or manually stop and

remove the RemoteCmdSvc service from the remote computer.

Attempt to push package to remote computer failed due to an
invalid environment

The product was unable to copy the package files to the remote computer. This

error occurs under the following circumstances:

Correct this problem by reinstalling the

product.

Corrupted package files

To correct this problem, restart the remote

computer. Then, try again to do the

operation.

Poor connection to the RemoteCmdSvc

service on the remote computer
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Attempt to copy package failed

The product was unable to copy the package files to the remote computer. This

error is usually reported when the package files are left open on the remote

computer from a previously failed copy.

To correct this problem, restart the computer. Then, try again to deploy the agent.

Attempt to communicate with RemoteCommand Service on
remote computer failed

The product was unable to communicate with the RemoteCmdSvc service.

To correct this problem, restart the remote computer or manually stop and remove

the RemoteCmdSvc service from the remote computer.

Remote command failed to start

The product was unable to run the specified remote command. This error occurs

when the remote installation package encounters an error.

To correct this problem, restart the remote computer, or manually stop and remove

the RemoteCmdSvc service from the remote computer.

Attempt to restart remote computer failed

The product was unable to force the remote computer to restart. This error occurs

when the current user does not have the SE_SHUTDOWN_NAME privilege enabled.

It can also occur when the current user on the remote computer does not have

the SE_REMOTE_SHUTDOWN_NAME privilege enabled.

Attempt to delete package failed

The product was unable to delete all of the package files that it copied to the

remote computer. This error occurs when a file that is running stops responding.

To correct this problem, restart the remote computer.

RPC server unavailable

If a computer name is longer than 14 characters, you must shorten the computer

name when you add it to the Computer List.

If the computer name is no longer unique on the network, you must rename the

computer in Windows Properties.
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Troubleshooting LightsOut Restore
The following are troubleshooting tips for LightsOut Restore:

■ If you cannot see the storage drivers, but you have not encountered a blue

screen error, you can try to resolve the issue by using the Load Driver link

from the Home or Utilities page in the recovery environment.

■ If you receive an error that indicates that Windows could not boot from a

RAMDISK backup, you might not have enough memory available for LightsOut

Restore. The LightsOut Restore feature requires 1 GB of memory to run.

■ If you receive a WinBOM error, verify that you are using the Windows Vista

driver version of the hardware that you are trying to detect. The Windows

2000 drivers are not compatible with the Symantec recovery environment.

■ If you want to create a customized thin host, see the pcAnywhere 11.5

documentation for details. You must have the full version of pcAnywhere 11.5

to create the thin host. After you create the thin host, contact Symantec

Technical Support for assistance in placing the thin host in the LightsOut

Restore Recovery Disk.
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